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Parallels Plesk Panel offers an easy and convenient graphical user interface that 
enables you to start your hosting business quickly and maintain it effortlessly. With 
Panel, you set up your hosting offers, manage customer accounts, and do other tasks 
to run and grow your business. Your customers benefit from using Panel too since it 
gives them a complete set of tools for creating and editing their websites. For serving 
both resellers and customers, the Panel GUI is divided into two parts:  

Á Server Administration Panel.  
In this panel, you set up and maintain your business. Here you create hosting plans 
and customer accounts, manage subscriptions, and so on. For a comprehensive 
overview of operations available to you in the Server Administration Panel, see the 
section Acquainting Yourself with the Panel Interface (on page 7). 

Á Control Panel.  

When someone subscribes to one of your hosting plans, Panel sets up an account 
for the subscriber. Under this account, the customer can add domain names and 
mailboxes, edit website content, and carry out other hosting management routines. 
Customers perform these operations in a separate panel called the Control Panel. 
To learn more about operating in the Control Panel, refer to the section Website 
Management (on page 55). 

So, after logging in to Panel, customers see the Control Panel while resellers see the 
Server Administration Panel. This is for convenience, to separate the administration of 
customer accounts from administration of websites and hosting services. 

However, you will need to go to the Control Panel in the following cases: 

Á To assist customers with performing their tasks. In this case, you log in to the 
Control Panel on a customer's behalf. 

Á To create and manage your own websites. In this case, you create your own 
subscription and log in to the Control Panel using your account. 

The links that let you log in to the Control Panel using your own and your customers' 
accounts are located in the list of subscriptions (Server Administration Panel > Hosting 
Services group of the navigation pane > Subscriptions.) 
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Your Panel Account and Subscriptions 

When you subscribe to a reseller plan, you get a reseller account in Panel. This 
account stores your profile information and is linked to your subscription - the package 
of hosting resources that you lease for reselling and use for your own needs. 

Your account has a unique username and a password that you use to log in to Panel. 
You can change these at any time. The section Managing Your Profile (on page 9) 
explains how to do it. 

To allow you to easily monitor the current state of your resources and services (for 
example, disk space currently consumed by your account and your customers), Panel 
automatically calculates the resource usage and displays it to you on the appropriate 
pages. To learn how to track the usage of your hosting resources and services, refer to 
the section Viewing Your Subscription Properties (on page 10). 

In this chapter: 

Acquainting Yourself with the Panel Interface .................................................... 7 
Managing Your Profile ....................................................................................... 9 
Viewing Your Subscription Properties................................................................ 10 
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Acquainting Yourself with the Panel Interface 

When you log in to Parallels Plesk Panel, you see the Home page with a summary on 
allocated and used resources. 

The top banner area provides the following links: 

Á A link with your name. Click this if you need to update your contact information. Find out 
more about updating contact information in the section Managing Your Profile (on page 9). 

Á Log out. This is where you close your session when you have finished working with the 
Panel. 

Á Help. This provides context-sensitive help with a search function. 

The navigation pane on the left provides access to the following sets of functions: 

Á Home. This is where you start working with the Panel. On this page, you can see the 
following elements.  

Á Overview. This widget contains information about your hosting package and provides 
links to the detailed information about available hosting resources and your 
permissions. The section Viewing Your Subscription Properties (on page 10) provides 
information that helps you understand the Panel resources and learn how to view the 
set of resources that you can use or sell. 

Á My Subscriptions. This is where you see a list of your own websites hosted on the 
Panel server.  

Á Customers. This is where you perform operations on customer accounts. Particularly, you 
can accomplish the following tasks from this page: 

Á Create, modify, suspend, unsuspend, and remove user accounts. 

Á View traffic usage reports. 

Á Domains. This is where you view information about hosted websites and their domain 
names, and go to the Control Panel for managing them. 

Á Subscriptions. This is where you manage customer subscriptions to your services. 
Subscription is a way a customer obtains services and resources provided by a service 
plan. 

Á Service Plans. This is where you manage your service plans. Service plan is a set of 
resources and services provided to hosting service customers by means of subscriptions. 
There are also service plan add-ons that extend the amount of resources and services 
provided with a subscription. 

Á Tools & Utilities. This is where you configure and manage system services, and view 
resource usage statistics. 

Á Profile. This is where you fill in your contact information. Learn more about the contact 
information and other profile settings in the section Managing Your Profile (on page 9). 

Á Change Password. This is where you change your password for logging in to the Server 
Administration Panel.  

Á Interface Preferences. This is where you set interface language and skin. Learn more about 
changing Panel appearance in the section Changing Interface Settings. 
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To see information about a tool or an item on the page, place the mouse pointer over an item 
without clicking it, and a small tooltip box appears with supplementary information regarding 
that item. 

The main working area on the right provides access to the tools available for the section 
currently selected in the navigation pane. Additional operations are accessible from the More 
Actions menus. 

To navigate through Parallels Plesk Panel, you can use a path bar: a chain of links that 
appears in the right part of the screen, below the banner area. 

To return to a previous screen, use the shortcuts in the path bar, or the Up Level icon in the 
upper-right corner of the screen. 

To sort a list by a certain parameter in ascending or descending order, click on the 
parameter's title in the column heading. The order of sorting will be indicated by a small 
triangle displayed next to the parameter's title. 
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Managing Your Profile 

Your account in Panel stores your access credentials and contact information such as e-mail, 
address, and phone number. Depending on how you subscribed to a Panel reseller plan, you 
can choose your username and password yourself or receive them from your hosting 
provider. To change your account password, click the Change Password link in the navigation 
pane. Your username can only be changed by your provider. If you forget your password and 
cannot log in to Panel, click the Forgot Your Password? link on the login page. Then enter your 
username and the e-mail specified in your contact information into the corresponding fields. 
When you fill in this information, Panel will send your password to the specified e-mail 
address. 

If the contact details in your profile require updating, or you want to add or remove some of 
them, click the Profile link in the navigation pane or the link with your name at the top of the 
page and Panel will take you to a page where you can manage the details. 
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Viewing Your Subscription Properties 

The number of hosting resources and services available to you for reselling or to use for your 
own needs is defined by your reseller subscription. A subscription can limit the use of a 
resource to a certain value, for example, allow you to consume 75 GB of disk space. 
Alternatively, it can allow a resource to be used without limits. In addition, the subscription 
defines what services you can use and what server management actions you can perform: 
manage DNS zones, access application catalogs, and so on.  

To view the information about your subscription, click the My resources and permissions overview 
link on the Home page. 

The subsections of this section tell you more about reseller subscription properties: 

Á Panel resources sold in reseller subscriptions: Section Viewing Resources (on page 11). 

Á Permissions and services: Section Viewing Permissions (on page 13). 

Á IP Addresses: Section Viewing IP Addresses (on page 14). 

 

Next in this section: 

Viewing Resources ............................................................................................ 11 
Viewing Permissions ......................................................................................... 13 
Viewing IP Addresses ....................................................................................... 14 
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Viewing Resources 

This section lists Panel resources included in reseller subscriptions. To view the resources 
allotted for your account, go to Home > My resources and permissions overview. 

Overselling policy  

Defines if you can sell more resources than allocated to you with the plan. If overselling is 
allowed, you are governed by actual resource usage instead of initial resource allocation. If 
overselling is prohibited, you can create only the number of service subscriptions limited to 
the total amount of disk space or traffic provided to you with your plan.  

Overselling is a marketing strategy based on the following scheme: a reseller, who was 
allotted, for example, ten gigabytes of disk space, allocates five gigabytes of disk space for 
each of their customers, assuming that none of them will actually use all of their allocated 
disk space.  

Domains 

The total number of subscriptions that you can create for your customers and for your own 
purposes. 

Subdomains 

The total number of subdomains that can be hosted within the subscription. 

Domain aliases 

The total number of additional alternative domain names that can be used for websites within 
the reseller subscription. 

Disk space 

The total amount of disk space that can be used by your own websites and sites of your 
customers. It includes disk space occupied by all files related to your reseller subscription: 
contents of websites, databases, applications, mailboxes, log files and backup files. 

Traffic 

The amount of data that can be transferred from the subscription's websites and FTP/Samba 
shares during a month.  

Additional FTP accounts 

The maximum number of FTP accounts used to access the files and folders hosted with a 
subscription. 

Databases (Unix hosting) 

The total number of databases that can be created on the Panel database servers and used 
by the subscription's websites. 
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MySQL databases and Microsoft SQL Server databases (Windows hosting) 

The maximum number of MySQL and Microsoft SQL Server databases respectively that can 
be created on the database servers registered in the Panel and used by websites hosted 
with the subscription. 

MySQL databases quota and Microsoft SQL databases quota (Windows hosting) 

The maximum total amount of disk space (in megabytes) that the MySQL and Microsoft SQL 
Server databases respectively can occupy. 

Mailboxes 

The total number of mailboxes that can be hosted within the subscription. 

Mailbox size  

The maximum amount of disk space that can be allocated to a mailbox for storing e-mail 
messages and auto-reply attachment files. You will not be able to specify the bigger mailbox 
size in your service plans. 

Mailing lists 

The total number of mailing lists that can be hosted with the subscription. 

Customers 

The maximum number of customer accounts that you can create and serve. 

Web users 

The total number of personal web pages that can be hosted on the websites within 
subscription. This service is mostly used in educational institutions that host non-commercial 
personal pages of their students and staff. These pages usually have addresses like 
http://example.com/~webuser. 

Java applications 

The total number of Java applications or applets that can be hosted on websites within the 
subscription  

Sites published with Presence Builder 

The total number of websites that can be created, published, and then edited with Presence 
Builder. 

Mobile sites 

The total number of websites that can be hosted with the UNITY Mobile online service, which 
optimizes sites for viewing on mobile devices. 
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FrontPage accounts (Windows hosting) 

The maximum number of Microsoft FrontPage accounts that can be used within the 
subscription. 

Shared SSL links (Windows hosting) 

The total number of shared SSL links that can be used within the subscription. 

IIS application pools (Windows hosting) 

The total number of dedicated IIS application pools that can be allocated for websites 
created within the reseller subscription. 

ODBC connections (Windows hosting)  

The total number of ODBC connections that can be used within the subscription. 

ColdFusion DSN connections (Windows hosting) 

The total number of ColdFusion DSN connections that can be used within the subscription. 

Viewing Permissions 

Your permissions either denote the operations available to you as a reseller in the Panel, or 
define which services and privileges can be enabled in the subscriptions of your customers. 
If a particular permission in your reseller subscription is set to Off, then a service subscription 
will not provide the corresponding service or a privilege. A disabled permission also means 
that you are prohibited to perform the designated action in the Control Panel. For example, if 
your subscription does not provide a privilege to use Scheduler (Scheduler management is Off), 
then none of your subscribers will be able to use it, and neither will you. 

Reseller-specific privileges (the ones that do not affect service subscriptions you create for 
your customers) are as follows: 

Á Subscription creation in Server Administration Panel and domain creation in Control Panel. Shows 
whether you can create hosting service subscriptions, add domains, create websites, and 
set up web forwardings. 

Á Ability to use API RPC. Shows whether you can remotely manage Web sites through 
custom applications. The remote API is an interface that can be used for developing 
custom applications integrated with Web sites, which could be used, for instance, for 
automating setup of hosting accounts and provisioning of services for customers 
purchasing hosting services from your site. To learn more, refer to the Parallels Plesk Panel 
11.5: API RPC Protocol Reference. 

Á Access to the Panel. Shows that you can use the Panel graphical user interface. 

Á Customer account creation. Lets you create user accounts and subscriptions for your 
customers in the Panel. 

Á Allow overselling. Lets you set up oversell policy, meaning that you yourself can define if 
overselling is allowed to you or not. 
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Overselling allows you to sell more resources than is allocated with a plan. If overselling 
is allowed, a reseller is governed by actual resource usage instead of initial resource 
allocation. Overselling is a marketing strategy based on the following scheme: a reseller, 
who was allotted, for example, ten gigabytes of disk space, allocates five gigabytes of 
disk space for each of their customers, assuming that none of them will actually use all of 
their allocated disk space.  

Meanings of the other permissions are the same as in the service subscriptions (on page 
24).  

To view the full list of your subscription permissions, go to Home > My resources and 
permissions overview > Permissions tab.  

Viewing IP Addresses 

To view the IP addresses included in your hosting package, go to Tools & Utilities > IP 
Addresses. Your IP addresses are listed and the following supplementary information is given: 

Á An icon in the S (Status) column shows  if your IP address is properly configured on 
the network interface. If your IP address was removed from the network interface by your 

provider, an icon will show . 

Á An icon in the T (Type) column shows  if you were allotted a dedicated IP address, and 

 if the address is shared among other customers of your service provider. A dedicated 
IP address is not used by other users, so you can use it to host either: 

Á A single e-commerce website secured with Secure Sockets Layer encryption.  

or 

Á A number of websites that do not need Secure Sockets Layer encryption. 

Note:  Shared IP addresses should be used for hosting only non e-commerce websites. 

Á The Certificate column shows which SSL certificate (for what domain name) is tied to an 
IP address. 

Á The FTP over SSL column (on Windows-based servers) shows whether it is possible to use 
secure FTP connection (FTP over SSL) on one of the domains hosted on this IP address. 

Á The Hosting column shows a number of websites hosted on an IP address. To view the 
domain names of these websites, click the number in the Hosting column. 

You can perform the following operations on IP addresses: 

Á Change IP allocation type. You can mark your IP addresses as shared or dedicated 
before you use them for hosting websites. This allows the Panel to distinguish between 
them and to not let you use a dedicated IP address for several customers at once. A 
dedicated IP address can be used in subscriptions of a single customer, while a shared 
IP address can be shared among different customers' subscriptions. Note that SSL 
protection with authentic digital certificates and Anonymous FTP services are available 
only to a dedicated hosting account on a dedicated IP address. Shared hosting accounts 
can also have SSL protection, but visitors of such protected sites will receive error 
messages in their browsers. 

Á Assign an SSL certificate to an IP address. This will assign the selected SSL certificate to 
all websites hosted on that IP address. 
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Á Select a default website. Because users can refer to a web resource on your server by 
typing an IP address and there can be several websites hosted on that address, the 
Panel needs to know which of the sites to show in such cases. The Panel automatically 
assigns the first website created on an IP address as the default website; however, you 
can select any other website and make it default. 

ü To change an IP address allocation type (shared, dedicated), assign another 
SSL certificate to an IP address, or select the default website: 

1. Go to Tools & Utilities > IP Addresses, and click the IP address you need. 

2. Make the required changes, and click OK. 

 

 



 

  
 

When you start your hosting reselling business, you should define how you will offer 
your hosting resources and services to customers. Parallels Plesk Panel lets you 
organize your business by means of service plans and subscriptions. 

A service plan is a combination of hosting resources that you sell to your customers. 
For example, a plan can provide customers with the web hosting service, five gigabytes 
of disk space on the server, and ten gigabytes of data transfers each month.  

There are also add-on plans that let you offer additional resources and services to 
subscribers, such as, for example, an additional gigabyte of disk space. 

When customers want to host a website on a Panel-managed server, they subscribe to 
a plan that offers the resources they need. In other words, a subscription is a set of 
resources defined by a plan and available to a certain customer. 

The section Properties of Hosting (Add-on) Plans and Subscriptions provides a complete list 
of Panel server resources and services that you can include in your hosting plans. 

Allocation of Resources and Services 

Service plans define potential services; the Panel does not check if a service or a 
resource that a service plan should provide is actually available, whether in the system 
in general or in your reseller subscription. For example, when creating a plan, you can 
choose to allow subscribers to connect to the server shell over SSH even if your 
subscription does not provide the Management of access to the server over SSH privilege. In 
such a case, the Panel will let you do this and will show no error or warning messages. 

Subscriptions provide actual resources and services that are allocated during the 
creation of each subscription. 
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Relations Between Subscriptions and Service/Add-on Plans 

Normally, a subscription is associated with a service plan, and this association is 
reflected in a list of subscriptions: each subscription name contains the service plan 
name in parentheses at the end. The amount of resources and services provided with a 
subscription can be extended by associating the subscription with add-on plans. A 
subscription can be associated with several add-ons, but each add-on can be added to 
the subscription only once. 

It is also possible to have subscriptions that are not associated with any service plans 
or add-on plans. We call such subscriptions custom subscriptions, and their names are 
extended with "(Custom)" in the list of subscriptions. Having a custom subscription may 
be useful if you want to provide services on specific terms that differ from the usual 
offerings in your business model. 

At any time, you can change the association between a subscription and plans in the 
following ways: 

Á Associate the subscription with another service plan. 

Á Add and remove add-on plans. 

Á Remove the subscription association with the service plan and add-ons. 

Syncing Service Plans and Subscriptions 

When you change the properties of a service plan, Panel automatically applies the 
changes to all subscriptions to this plan. If you want to prohibit automatic updating of a 
certain subscription, you can lock this subscription. To learn how to configure the 
synchronizing (or syncing) of your plans with subscriptions, see the section Syncing 
Subscriptions and Plans (on page 40). 

In this chapter: 

Properties of Hosting Plans, Add-ons and Subscriptions ................................... 18 
Syncing Subscriptions and Plans ...................................................................... 40 
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Properties of Hosting Plans, Add-ons and 
Subscriptions 

Properties of a hosting plan and subscription are grouped as follows: 

Á Resources 

Includes validity period, policy on overusing resources, system resources like disk space 
and traffic, and service resources like websites, subdomains, mailboxes, databases and 
so on. 

Á Permissions 

Includes provided services and privileges. 

Note : Some permissions prevent settings of the following services from syncing (on page 
40). See the details in the Permissions section (on page 24). 

Á Hosting Parameters  

Includes parameters of the provided hosting service.  

Á Mail 

Includes parameters of the provided mail service. 

Á DNS 

Specifies if the DNS zones of the subscription's domains should be master or slave. 

Note : In case the DNS zone management privilege is provided, this parameter is not synced, 

and subscribers can set up this parameter on a per-domain basis. 

Á Performance 

Includes parameters that affect performance of all services provided with the plan. 

Á Logs & Statistics 

Includes settings of how statistics and logs of the plan's subscriptions should be stored. 

Note : Hosting, Mail, DNS, Performance, Logs & Statistics parameters are fully visible and editable 
in the Administrative Panel only for service plans. For subscriptions, these parameters are 
available only in the Control Panel. To view or modify the parameters of a particular 
subscription, go to Subscriptions and click Control Panel to the right of the subscription name. 
Also note that the availability of these parameters to a subscriber depends on the 
permissions. 

Á Applications 

Lets you select which applications available to you should be provisioned to your 
customers. 

Next in this section: 

Visibility of Hosting Features in the Control Panel ............................................. 20 
Resources ......................................................................................................... 20 
Permissions ....................................................................................................... 24 
Hosting Parameters ........................................................................................... 28 
Mail ................................................................................................................... 37 
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DNS .................................................................................................................. 38 
Performance ...................................................................................................... 38 
Logs & Statistics ................................................................................................ 39 
Applications ....................................................................................................... 39 
Additional Services ............................................................................................ 39 
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Visibility of Hosting Features in the Control Panel 

Since version 10.4, Panel hides from customers those hosting features that are not provided 
in their subscription. The visibility of GUI elements responsible for a certain feature is 
determined by permissions and resource limits of a subscription. Note that when you (as the 
administrator) log in to the customer's Control Panel, you see GUI elements regardless of 
customer's permissions. The table below explains GUI visibility logic. 

 
Visible to a 
Customer 

Visible to the 
Administrator 

Resource Limit > 0 

Permission = True 

Yes Yes 

Resource Limit > 0 

Permission = False 

No Yes 

Resource Limit = 0 

Permission = True 

No No 

Resource Limit = 0 

Permission = False 

No No 

For example, when the number of Domains in a subscription is 10 and the Domains management 
permission is off, a customer does not see the Add New Domain button in the Control Panel. 
Nevertheless, this button is available to the administrator that logs in to the customer's 
Control Panel. 

Resources Without Numerical Limits 

If the resource type is logical or in other words, it can be just switched on or off (such as 
scripting language support), its visibility is controlled by a certain permission only. For 
example, if the Hosting settings management permission is granted, a customer is able to toggle 
the support of various scripting languages for their site. If the permission is not granted, the 
customer sees the list of languages that are switched on for their site in the read only mode. 
The disabled languages are not shown in the list. 
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Resources 

Resources (located at Service Plans > select a plan > Resources tab) define what system 
resources are provided with the subscription. 

Overuse policy  

Defines what happens if the subscription's usage of disk space and traffic reaches limit 
values: 

Á Overuse is not allowed will suspend the subscription only if you select the checkbox Suspend 
subscription when its disk space or traffic usage goes beyond the limit. If you do not select it, 
websites will not be suspended; only a notice will be sent to the subscribers.  

You can set up sending of notifications as soon as usage of disk space or traffic reaches 
a particular value (the Notify upon reaching options), in order to prevent subscriptions from 
suspension. The notifications will be sent according to the server notifications policy. 

Á Overuse is allowed will let the subscription operate properly. 

The option When limit on usage of a resource is reached, send e-mail according to the server 
notification settings triggers sending notifications according to the server notifications 
policy. 

Note:  The overuse policy does not apply to the limits set on size of mailboxes. Therefore, 
even if you enable overuse, be sure to allocate enough disk space to mailboxes. 

Disk space 

The total amount of disk space allocated to the subscription. It includes disk space occupied 
by all files related to the subscription: content of websites, databases, applications, 
mailboxes, log files, and backup files. 

Traffic 

The amount of data that can be transferred from the subscription's websites and FTP/Samba 
shares during a month.  

Notify upon reaching 

Available only if overuse is not allowed. This sets the soft quota for disk space or traffic 
usage in order to prevent subscriptions from suspension. When the quota is reached, the 
Panel sends notifications to users' e-mail addresses specified in Settings > Notifications: 
Resource usage limits exceeded by subscription. 

Sites published with Presence Builder 

The number of websites that can be published with Presence Builder. 

Domains 

The total number of domain names that the subscriber will be able to host within the 
subscription. This includes websites, web forwarding configurations that point to websites 
hosted on other servers, and domain names on which a website or web forwarding is not yet 
set up (domains with no hosting).  
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Mobile sites 

The total number of websites that can be hosted with the UNITY Mobile online service, which 
optimizes sites for viewing on mobile devices. UNITY Mobile hosts the optimized site copies 
on their own servers. 

How it works: 

1. A user creates a website with the domain name example.com  and clicks the link Create 

Mobile Site in the Control Panel. 

2. The user is prompted to specify a domain name for access to the mobile site copy. The 

user specifies mobile.example.com . 

3. The Panel connects to the UNITY Mobile hosting servers, sets up an account with UNITY 

Mobile for the domain name mobile.example.com . 

4. The userôs browser opens the UNITY Mobile website, where the user is automatically 
logged in to their account and prompted to import their website from the Panel-managed 
server. 

5. After the site is imported and optimized for mobile viewing, it becomes accessible by the 
address mobile.example.com. The Panelôs DNS server keeps a CNAME record pointing 
to the site on a UNITY Mobile server. 

The user can now perform the following operations on mobile site using links in the 
Control Panel: 

Á Open site editor. 

Á Change mobile site name. 

Á Remove mobile site. 

For more information about UNITY Mobile services, visit their website at 
http://www.unitymobile.com. 

For instructions on managing mobile sites through the Control Panel, refer to the Customer's 
Guide, section Setting Up Mobile Sites. 

Subdomains 

The total number of subdomains that the subscriber will be able to host within the 
subscription. 

Domain aliases 

The total number of additional alternative domain names that the subscriber will be able to 
use for their websites. 

Mailboxes 

The total number of mailboxes that the subscriber can host within the subscription. 

Mailbox size 

The amount of disk space that is allocated to each mailbox in a subscription for storing e-mail 
messages and auto-reply attachment files. 

http://www.unitymobile.com/
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Total mailboxes quota (available only for Windows hosting) 

The total amount of disk space in megabytes available for all mailboxes within the 
subscription. 

Mailing lists 

The total number of mailing lists that the subscriber can host within the subscription. 

Additional FTP accounts 

The maximum number of FTP accounts used to access the files and folders created within a 
subscription. This number does not include an account that is always created during the 
subscription creation. 

Databases (Unix hosting) 

The total number of databases that can be created on the Panel database servers and used 
by the subscription's websites. 

MySQL databases and Microsoft SQL Server databases (Windows hosting) 

The maximum number of MySQL and Microsoft SQL Server databases respectively that can 
be created on the Panel database servers and used by the subscription's websites. 

MySQL databases quota and Microsoft SQL databases quota (Windows hosting) 

The maximum amount of disk space (in megabytes) that the subscription's MySQL or 
Microsoft SQL Server databases can occupy respectively. 

Validity period/Expiration Date 

The term for a subscription.  

In service plan properties, it is Validity period: it is used only when a subscription is created: 
the Panel derives the subscription expiration date from it.  

In subscription properties, it is Expiration date: At this date, the subscription will be suspended, 
meaning that all sites within the subscription will be suspended, their Web, FTP and mail 
services will no longer be accessible to the Internet users, and the subscriber and their users 
will not be able to log in to the Control Panel.  

Subscriptions are not renewed automatically, so to bring a subscription's services back to 
operation, you will need to manually activate the subscription (on page 48). 

Java applications 

The total number of Java applications that can be hosted on the subscription's websites. 

Web users 

The total number of personal Web pages that the subscriber can host for other users under 
their websites. This service is mostly used in educational institutions that host non-
commercial personal pages of their students and staff. These pages usually have addresses 
like http://example.com/~webuser. 
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FrontPage accounts (Windows hosting) 

The maximum number of Microsoft FrontPage accounts that the subscriber can create within 
the subscription. 

Shared SSL links (Windows hosting) 

The total number of shared SSL links that the subscriber can use within the subscription. 

ODBC connections (Windows hosting)  

The total number of ODBC connections that the subscriber can use within the subscription. 

ColdFusion DSN connections (Windows hosting) 

The total number of ColdFusion DSN connections that the subscriber can use within the 
subscription. 

Permissions 

Permissions (located at Service Plans > select a plan > Permissions tab) define what privileges 
and services are provided with the subscription.  

DNS zone management 

Allows the subscriber to manage the DNS zones of their domains. 

Note : If this permission is granted, then the DNS service settings are not synced. 

Hosting settings management 

Allows modifying parameters of the hosting service provided with the subscription: changing 
hosting account features, setting up custom web server settings, and switching on or off 
support for programming and scripting languages, custom error documents, SSL support, 
and (Windows only) Microsoft FrontPage support. In addition, it allows you to toggle the 
following permissions: Hosting performance settings management and Common PHP settings 
management. 

Note : If this permission is granted, then the mentioned hosting parameters are not synced. 

Common PHP settings management 

Allows the subscriber to adjust common PHP settings individually for each website 
(subdomain) in their subscription.  

Note : If this permission is granted, then the common PHP settings are not synced. 

Setup of potentially insecure web scripting options that override provider's policy. Allows the 
subscriber to override the hosting security policy, if it is applied by the provider. 
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Management of access to server over SSH (Linux hosting)  

Allows the subscriber to access the server shell over SSH under their system user account. 
Also, lets the subscriber set up such hosting parameter as SSH access to server shell under the 
subscription's system user. 

Note : If this permission is granted, then the mentioned hosting parameter is not synced. 

Management of access to server over Remote Desktop (Windows hosting) 

Allows the subscriber to access the server via Remote Desktop protocol.  

Anonymous FTP management 

Provides the anonymous FTP service, which lets the subscriber set up a directory shared 
over FTP protocol and available to anonymous users. A subscription should reside on a 
dedicated IP address in order to provide this service. 

Scheduler management 

Allows the subscriber to schedule running of scripts or utilities. 

Spam filter management 

Lets the subscriber customize filtering settings of the SpamAssassin spam filter. 

Antivirus management 

Allows the subscriber to change settings of the server-side protection of incoming and 
outgoing mail from viruses. 

Data backup and restoration using the server repository 

Allows the subscriber to back up and restore their websites, and use the storage on the 
server for keeping backups. 

Data backup and restoration using a personal FTP repository  

Allows the subscriber to back up and restore their websites, and use external FTP servers for 
storing their backups. 

Web statistics management 

Allows the subscriber to select which Web statistics engine should be used, and whether 
reports should be accessible via a specific password-protected directory. 

Note : If this permission is granted, then the mentioned hosting parameter is not synced. 
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Log rotation management 

Allows the subscriber to adjust the cleanup of processed log files for their sites. Also, allows 
the subscriber to remove log files. 

Note : If this permission is granted, then the Logs & Statistics parameters (on page 39) are not 
synced. 

Access to Application Catalog 

Provides the subscriber with access to prepackaged applications that can be installed on 
websites. If you select this option, be sure to select the PHP support checkbox on the Hosting 
Parameters tab. 

You can view a list of applications available from your provider by doing the following: 

1. Set up your own website by using a plan or a custom subscription that grants access to 
the Application Catalog. 

2. Go to the Server Administration Panel > Subscriptions, and click the Manage Hosting link 
corresponding to your domain name. The Control Panel will open in a new browser 
window or tab. 

3. In the Control Panel, go to the Applications tab > All Available Applications. 

There is also a page in the Server Administration Panel, where you can view and update 
installed applications, and purchase license keys for commercial applications at Parallels 
Online Store: Tools & Utilities > Application Vault. 

For instructions on installing applications and license keys, refer to the Customer's Guide, 
section Using Website Applications. 

Domains management 

Allows the subscriber to add domains, create websites and set up web forwarding. 

Subdomains management 

Allows the subscriber to set up additional websites accessible by <subdomain>.<domain> 
addresses. 

Domain aliases management 

Allows the subscriber to set up additional alternative domain names for their websites. 

Additional FTP accounts management 

Allows the subscriber to manage FTP accounts for accessing the subscription's files and 
folders. 

Java applications management 

Allows the subscriber to install Java applications on their websites. 
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Mailing lists management 

Allows the subscriber to use mailing lists provided by the GNU Mailman software. 

Note : If this permission is granted, then the Enable mailing lists parameter (on page 37) is not 
synced. 

Hosting performance settings management 

Allows the subscriber to adjust performance PHP settings individually for each website 
(subdomain) in their subscription. In addition, lets the subscriber set up the limits on 
bandwidth usage and number of connections to their websites. 

Note : If this permission is granted, then the following settings are not synced: PHP 
performance settings, performance settings (on page 38) for bandwidth usage and the number 
of connections. 

IIS application pool management (Windows hosting) 

Provides the subscriber with a dedicated IIS application pool and the means to manage it: 
enable or disable it, and set up the maximum amount of CPU power that the pool may use. 

Note : If this permission is granted, then the Logs & Statistics parameter (on page 39) called 

Use dedicated pool is not synced. 

Additional write/modify permissions management (Windows hosting) 

Allows the subscriber to toggle the hosting parameter Additional write/modify permissions. 
These permissions are required if a subscriber's web applications use a file-based database 

(like Jet) located in the root of httpdocs  folder. Please note that selecting this option might 

seriously compromise the websites' security. 

Note : If this permission is granted, then the hosting parameter Additional write/modify 
permissions is not synced. 

Shared SSL management (Windows hosting) 

Provides the shared SSL service, and allows the subscriber to set up shared SSL links for 
their websites within the subscription.  

Hard disk quota assignment 

Allows the subscriber to set up the hosting parameter Hard disk quota. 

Note : If this permission is granted, then the mentioned hosting parameter is not synced. 

Database server selection 

Allows subscribers to select a database server for their databases, as opposed to using the 
default database server. For details about default database servers, see the section Hosting 
Parameters (on page 28). 
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Access to advanced operations: Website Copying and Website Maintenance Mode 

Specifies whether the website copying and maintenance mode are available to the 
subscriber in the Control Panel > Websites & Domains >  Show Advanced Operations. If denied, the 
Website Copying and Website Maintenance Mode links are not available to the subscriber.  

Password-protected directories management 

Specifies whether the protected directories feature is available to the subscriber in the Control 
Panel > Websites & Domains >  Show Advanced Operations. If denied, the Password-protected 
directories link is not available to the subscriber.  

Ability to manage auxiliary user accounts 

Specifies whether the subscriber can manage auxiliary user accounts on the Control Panel > 
Users tab. If denied, the Users tab is not available to the subscriber.  

Allow activating APS apps using license keys from the Panel license pool 

If granted, users will be able to install certain APS apps without the need to purchase app 
licenses from vendors. In this case, app license keys will be taken from the Panel license 
pool. Note that you cannot limit the number of app installations a user is allowed to perform. 
This permission is relevant only if your Panel license comes in a bundle with APS app 
licenses. Learn more about license bundles. 

Hosting Parameters 

These parameters define the hosting service provided with the plan or subscription. The 
parameters can be found in: 

Á Service Plans > select a plan > Hosting Parameters tab 

Á Subscriptions > select a subscription > Customize > Hosting Parameters tab 

Note : Unless specifically noted, the parameters are not synced if the Hosting management 
permission is granted to a subscription. 

Enable hosting 

Defines whether the hosting service is actually provided with the plan. 

Turn off this option to make up a service plan that provides only mail service. Subscribers of 
such a plan will be able to have 'domains without hosting' which will serve mailboxes. 

Status of websites in suspended subscriptions 

Defines whether sites in suspended subscriptions should be available over the Internet and 
which hosting services should be available for these sites. 
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In Panel, a website can receive a new status in two ways: 

Á When the site owner or hosting provider changes the status individually for the site (in 
Websites & Domains > Edit > Change status). As long as the subscription stays active, 
services like mail are available for sites with any status, and these services can be 
managed by means of Panel. Learn more in Website Status (on page 130). 

Á After the subscription has been suspended. It can be suspended automatically (when its 
expiration date passes) or manually by the hosting provider (using the Suspend button in 
the subscription's settings). The DNS and mail services are available for sites in 
suspended subscriptions, but cannot be managed by means of Panel.  

The setting Status of websites in suspended subscriptions enables you to specify the status 
that websites will receive when their subscription becomes suspended. 

Websites in suspended subscriptions can have the following statuses: 

Á Disabled. Disabled websites have all associated hosting services disabled. Visitors see 
the web server's default page defined by the hosting provider. 

Disabled websites are no longer hosted on the server: They are excluded from the web 
server configuration. However, the physical directories and files of disabled websites can 
be accessed using FTP clients and File Manager. 

Important: In Panel versions earlier than 11.5 this status was called Suspended. After 
upgrading from earlier Panel versions to 11.5, all websites that had the Suspended status 
will receive the status Disabled in order to keep their correct behavior. 

Á Suspended. Suspended websites do not open in browsers. Visitors are redirected with the 
search engine friendly 503 HTTP code to the custom maintenance page.  

Note: You can customize the maintenance page by using the Edit maintenance error page 
link in Control Panel > Websites & Domains > domain name. This link is displayed only if you 
select the Custom error documents checkbox in the site settings in Websites & Domains > 
domain name > Edit. Site owners can edit the maintenance page too. 

Suspended websites remain hosted on the server, which means that the services such as 
mail are running and web server configuration for these websites is kept on the server.  

Á Active. The website works as usual. 

Hard disk quota 

Hard quota imposed on disk space in addition to the soft quota (set with the option Notify upon 
reaching (on page 20)). Hard disk quota will not allow writing more files to the web space 
when the limit is reached: users will get an "Out of disk space" error at an attempt to write 
files. 

Note : (Linux hosting) Confirm that your operating system supports hard disk quota before 
you set any value other than Unlimited. In case you define a hard quota when it is not 
supported, you will get a synchronization conflict on all the plan's subscriptions. 

SSL support 

Allows setting up SSL encryption on websites hosted within the subscription. 
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Web statistics 

Selects a statistics engine that will create reports on how the subscription's websites are 
visited: how many people visited a site, and which web pages they viewed. 

The accessible via password protected directory /plesk-stat/webstat option allows a subscriber view 
website statistics at URLs like https://example.com/plesk-stat/webstat using their system 
user account login and password. 

Note : This parameter is not synced if the Web statistics management permission is selected. 

Custom error documents 

Allows subscribers to design and use their own error pages that the web server returns with 
HTTP error codes. 

SSH access to server shell under the subscription's system user (Linux/Unix hosting) 

Allows subscribers to upload securely web content to the server through SSH.  

Note : This parameter is not synced if the Management of access to server over SSH permission is 

selected. 

Scripting 

Support for programming and scripting languages that should be interpreted, executed or 
otherwise processed by a web server: Microsoft ASP.NET framework, PHP hypertext 
preprocessor (PHP), Common Gateway Interface (CGI), Perl, Python, Fast Common 
Gateway Interface (FastCGI), Microsoft or Apache Active Server Pages (ASP), Server Side 
Includes (SSI), ColdFusion, and Miva scripting required for running Miva e-commerce 
solutions. 

To learn more about adjustable PHP settings, see the section PHP Settings. 

Additional write/modify permissions (Windows hosting) 

This option is required if subscriber's web applications use a file-based database (like Jet) 

located in the root of httpdocs  folder. Please note that selecting this option might seriously 

compromise the Web site security. 

Allow web users to use scripts  

Allows scripting at web pages available at URLs like 
http://example.com/~<username>/<webpage>, where <username> refers to a web user.  

Web users are individuals who do not need their own domain names. This service is popular 
with educational institutions that host non-commercial personal pages of their students and 
staff. 

FrontPage support (Windows hosting).  

The options in the FrontPage support group allow subscribers to connect to the server and 
create websites with Microsoft Frontpage. 
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Default Database Server 

Specifies default database servers of each supported type to be used within a plan. 
Customers will be able to create databases only on the default database servers. Note that if 
you disable a database server for an existing plan or subscription (the None option), the 
databases already used by customers will still be accessible. 

Next in this section: 

PHP Settings ..................................................................................................... 32 
Customizing PHP Configuration ........................................................................ 34 
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PHP Settings 

Choose one of the following PHP handlers at Hosting Parameters > PHP handler type taking into 
consideration resources consumption and security aspects of each option: 

 
 

Performance 
 

Memory 
Usage 

Security 
 

Apache 
module (Linux 
only) 

High. 

Runs as a part of 
the Apache web 
server. 

Low This handler (also known as mod_php) is the least secure 
option as all PHP scripts are executed on behalf of the 

apache  user. This means that all files created by PHP 

scripts of any plan subscriber have the same owner 

(apache ) and the same permission set. Thus, there is a 

theoretical possibility that some users will try to affect files of 
another users or some important system files. 

Note:  You can evade some security issues by turning 
the PHP safe_mode option on. It disables a number of 
PHP functions that bring potential security risk. Note 
that this may lead to inoperability of some web apps. 
The safe_mode option is considered to be obsolete 
and is deprecated in PHP 5.3. 

ISAPI 
extension 
(Windows 
only, not 
supported 
since PHP 
5.3) 

High. 

Runs as a part of 
the IIS web server. 

Low The ISAPI extension can provide site isolation in case a 
dedicated IIS application pool is switched on for 
subscriptions. Site isolation means that sites of different 
customers run their scripts independently. Thus, an error in 
one PHP script does not affect the work of other scripts. In 
addition, PHP scripts run on behalf of a system user 
associated with a hosting account. 

Note:  The ISAPI extension handler is not supported 
since PHP 5.3. 

CGI 
application 

Low. 
Creates a new 
process for each 
request and closes it 
once the request is 
processed. 

Low The CGI handler provides PHP script execution on behalf of 
a system user associated with a hosting account. On Linux, 
this behavior is possible only when the suEXEC module of 
the Apache web server is on (default option). In other case, 

all PHP scripts are executed on behalf of the apache  user. 

We recommend that you use the CGI application handler only 
as a fall-back. 

FastCGI 
application 

High (close to 
Apache module and 
ISAPI extension). 

Keeps the 
processes running 
to handle further 
incoming requests. 

High The FastCGI handler runs PHP scripts on behalf of a 
system user associated with a hosting account.  
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PHP-FPM 
application 
(Linux only) 

High Low The PHP-FPM is an advanced version of FastCGI which 
offers significant benefits for highly loaded web applications. 

The PHP-FPM handler is available only if it was installed by 
hosting provider and if the option Process PHP by nginx in the 
websiteôs settings is turned on (Websites & Domains > select a 
domain > Web Server tab). 

Note: Switching PHP from Apache module to FastCGI application may break functionality of 
existing PHP scripts. Switching to PHP-FPM by selecting Process PHP by nginx in the websiteôs 
web server settings may do the same. 

PHP Version 

Panel supports different versions of PHP. For each handler, one or more PHP versions can 
be available. The list of available versions is defined by your hosting provider and available 
to you in the same location where you select the PHP handler: Websites & Domains tab > 
<domain_name> > Edit. 

Note: Always use PHP 5.x except the cases when you need PHP 4.x to host some old PHP 
apps. 

Since Panel 10.4, you have the ability to adjust PHP configuration individually for each 
hosting plan or subscription. For this purpose, Panel exposes a number of PHP configuration 
settings on the PHP Settings tab. To learn more about custom per-subscription PHP 
configuration, refer to the section Customize PHP Configuration. 
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Customizing PHP Configuration 

PHP is one of the most popular scripting languages for creating dynamic web pages. The 
majority of today's websites and web applications are based on PHP scripts. Thus, site 
administrators should understand how they can control the execution of PHP scripts. 
Typically, PHP behavior is defined by a number of configuration settings. These settings 
specify various script execution aspects, like performance (for example, the amount of 
memory a script can use), security (for example, access to file system and services), and so 
on. Administrators might want to adjust these settings for a number of reasons: 

Á Preventing a memory leak or server hang-up by poorly written scripts. 

Á Protecting data from malicious scripts. 

Á Meeting the requirements of a certain web app. 

Á Testing own scripts and other. 

Custom PHP Settings in Panel 

Generally, PHP settings are defined by the server-wide configuration file. For Linux it is, 

typically, /etc/php.ini  and for Windows - %WIN%\ php.ini . This file is managed by your 

hosting provider and defines PHP configuration for all websites hosted on the server. Since 
Panel 10.4, PHP settings are adjustable through the Control Panel and you can adjust them 
individually for each hosting plan or subscription. Moreover, your customers (if allowed) can 
adjust your PHP settings preset individually for each of their websites and subdomains. See 
the PHP settings hierarchy on the diagram below. 
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You can set the custom PHP configuration in the properties of a certain service plan, add-on 
plan, or subscription (on the PHP Settings tab). PHP settings from a higher level act as a 
preset for a lower level, thus each lower level overrides them. For example, you can 
consciously apply some PHP limitations to a service plan and then offer your customers the 
add-on plan that removes the limitations. PHP settings of the add-on plan will override the 
settings defined in the main service plan. 
If customers have the corresponding permissions, they can specify the PHP configuration 
that is unique for each website (or subdomain) in their subscription. 

Groups of PHP Settings 

For convenience, all PHP settings in Panel are divided into two groups: 

Á Performance settings.  
These settings define how scripts work with system resources. For example: Use the 

memory_limit  parameter to limit the amount of memory for a script and, as a 

consequence, to prevent memory leaks; or prevent scripts from tying up the server by 

limiting the maximum time scripts are allowed to run in max_execution_time . 

Á Common settings.  
This group contains other commonly used PHP settings. Generally, these are: Security 
settings (say, the PHP safe mode toggle or the permission to register global variables), 
error reporting settings (say, the directive to log errors), and others. 

Important: If you use Panel for Windows or for Linux, where PHP runs not as an Apache 
module, your customers are able to override some PHP settings regardless of any 

permissions. They can use the ini_set()  function in their scripts to change values of the 

following parameters: memory_limit , max_execution_time , and those of your 

additional directives that PHP allows to set anywhere (PHP_INI_ALL directives; learn more 
at http://php.net/manual/en/ini.list.php). 

If you cannot find particular parameters among performance or common settings, contact 
your hosting provider.   

The Default Values of PHP Parameters 

You can set the value of each parameter in PHP Settings either by selecting a value from a 
preset, typing a custom value, or leaving the Default value. In the latter case, Panel takes the 
parameter value from the server-wide PHP configuration. The only exceptions are add-on 
plans: the value set to Default on the add-on's PHP Settings tab will keep the parameter's value 
from the main service plan. 
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Allowing Customers to Change PHP Settings 

You can allow your customers to override subscription's PHP settings with their own per-
website and per-subdomain PHP configuration. For this purpose, you should use the 
following permissions on the Permissions tab of a certain service plan or subscription: 

Á Hosting performance settings management.  
Along with management of some other settings, this permission grants customers access 
to PHP settings from the performance settings group. 

Á Common PHP settings management.  
If granted, allows customers to adjust PHP settings from the common settings group. 

Note that you can toggle these permissions for a plan (subscription) only if it has the granted 
Hosting settings management permission.  

Even if your customers do not have permissions to adjust PHP settings, you (as the 
administrator) can always perform such per-website (subdomain) PHP configuration. To do 
this, open a certain hosting account from the Server Administration Panel and apply changes 
to the settings of a particular website (subdomain) on the PHP Settings tab. 

Mail 

These parameters (located at Service Plans > select a plan > Mail tab) define the mail service 
provided with the plan. 

Webmail 

Provides the webmail service, which allows users of mailboxes within the subscription to 
work with their mail using a web-based mail application. 

Enable mailing lists 

Turns on the mailing lists service provided by the GNU Mailman software on the 
subscription's websites. 

Note : This parameter is not synced if the permission Mailing lists management is selected. 

Policy on mail for non-existent users 

Defines how mail server should treat e-mail messages sent to e-mail addresses that are 
supposed to be registered under the subscription's domains but actually do not exist. The 
following options are available: 

Á Bounce with message returns the mail back to sender with a notice. 

Á Forward to address forwards the mail to another e-mail address. 

Á Reject silently rejects the mail without accepting it. This setting can decrease mail server 
load caused by a large amount of spam, which is often directed at randomly generated 
user names. However, this might be useful to spammers because scanning your mail 
server for valid e-mail addresses will speed up in such a case. 

Á Redirect to external mail server with IP address (on Windows hosting), forwards the mail to the 
specified mail server.  
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DNS 

These parameters (located at Service Plans > select a plan > DNS tab) define how the DNS 
service running on the Panel-managed server will serve DNS zones for websites hosted on 
the plan. 

Master 

A master or primary name server stores locally the zone file it serves, while a secondary 
server only retrieves a copy of this file from the primary. 

Slave 

A slave or secondary server retrieves a copy of the zone file from the primary name server. 

Performance 

These system parameters (located at Service Plans > select a plan > Performance tab) define 
performance of all services provided with the plan. 

Use dedicated IIS application pool (Windows hosting) 

Enables the use of dedicated IIS application pool for web applications within the subscription. 
Using dedicated IIS application pool dramatically improves the stability of web applications 
due to worker process isolation mode. This mode gives each site hosted on the server a 
possibility to allocate a separate process pool for execution of its web applications. This way, 
malfunction in one application will not cause stopping of all the others. This is especially 
useful when you are using shared hosting package. The Maximum CPU use (%) option limits the 
amount of the server CPU that the pool can use. 

Maximum bandwidth usage 

Defines the maximum speed (measured in KB per second) that a domain can share between 
all its connections. 

Connections limited to 

Defines the maximum number of simultaneous connections to web server for all websites 
within the subscription. This setting is intended for preventing the websites from Denial of 
Service (DOS) attacks and excessive usage of bandwidth. 
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Logs & Statistics 

These parameters (located at Service Plans > select a plan > Logs & Statistics tab) define how 
statistics and logs of a subscription should be stored.  

Note: These settings in subscriptions are not synchronized with service plans. 

Retain web and traffic statistics 

Sets a period (in months) for which reports on the subscription's web statistics (generated by 
the selected web statistics component) and traffic statistics (generated by Panel) should be 
available.  

Note: The setting Retain web and traffic statistics is not changed in subscriptions when you 
update it for a service plan. The only way to update this setting for each domain is changing 
it in the Panel database. See http://kb.parallels.com/en/6246 for details. 

Log rotation 

Enables automatic cleanup and recycling of web server log files. You can also switch on 
compression of processed log files and sending them to a specific e-mail address.  

Applications 

Depending on the service plan, a number of prepackaged applications can be available to 
Panel users. You can install the apps on your own sites as well as provision them to your 
customers. 

When setting up a hosting plan, you can select which of the apps should be provisioned to 
customers: 

Á To provide all available applications, on the Permissions tab, select the option Access to 
Application Catalog. 

Á To provide only selected applications, on the Permissions tab, select the option Access to 
Application Catalog, and then go to the Applications tab and select the option Provide only 
applications that I select. Use the button >> to add the selected applications to the plan. 

 

Additional Services 

If your provider configured Panel to provide custom additional services, then the Additional 
Services tab is shown in hosting plan properties. On this tab, you can select the services that 
you want to provide to subscribers. 
 

http://kb.parallels.com/en/6246
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Syncing Subscriptions and Plans 

Subscriptions associated with a particular plan are synchronized, or synced, with it: any 
changes made to the plan are automatically applied to all its subscriptions. This is true for 
both service and add-on plans. 

In case a plan offers a privilege which makes it possible for a subscriber to change a 
particular resource or service, this resource/service allocation is not synced. For example, if 
a subscription provides the privilege of DNS zone management, then the DNS zone settings 
of the associated service plan are ignored during synchronization. 

States of Subscription 

Subscriptions associated with a particular plan are synchronized, or synced, with it: any 
changes made to the plan are automatically applied to all its subscriptions. This is true for all 
kinds of plans: service plans, their add-ons, and reseller plans. 

The Panel allows the following deviations from the default subscription state (active and 
synced with the service plans): 

Á Locked state, which means locked for syncing, indicates that a subscription is excluded 
from syncing with the associated plans. 

A subscription gets locked if you change the parameters of the subscription, without 
changing the associated service plan. Such locking secures your customizations so that 
they are not overwritten the next time you change the plan and all its subscriptions are 
synced. 

Á Unsynced state indicates that some services or resources offered with the associated 
plans cannot actually be provided with the subscription.  

Á Suspended state. This state is not related to the synchronization of a subscription with the 
service plan, but it affects the behavior of websites. Panel suspends subscriptions 
automatically if their expiration date passes. In addition, you can suspend a subscription 
manually.  

Note:  If a plan offers a privilege that makes it possible for a subscriber to change a particular 
resource or service, this resource/service allocation is ignored during a sync. For example, if 
the plan provides the privilege of PHP settings management and a customer changes some 
PHP setting, its subscription remains synced with the plan (even if a value of the PHP setting 
in the subscription differs from the corresponding one in the plan). 
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Unsynced Subscriptions 

Panel does not check whether a service or a resource that a service plan should provide is 
actually available in the system. For example, when creating a plan, you can select to 
provide ColdFusion when ColdFusion is not installed on the server, and Panel will let you do 
it and will show no error or warning messages.  

A subscription is automatically marked as Unsynced if Panel cannot provision the resources 
and/or services defined by the plan. This may happen in the following cases:  

Á When the subscription is created. 

Á When the properties of the associated plan are changed. 

Á When an add-on plan is added to or removed from the subscription. 

ü To know which of the subscription's resources or services are not synced with 
the plan: 

1. Go to Subscriptions, and click the unsynced subscription name. 

2. Click Sync. 

The Panel will retry syncing the subscription with associated plans, and will display the 
conflicting properties if syncing fails. 

Be sure to take note of the conflict report: which properties are affected, and what the 
Plan value and the Available value are. 

Clicking OK at this page will initiate setting the subscription values according to the 
available values, Cancel will leave everything unchanged. 

Once you have identified the problem, you can resolve it. There are two possible ways: 

1. Fine-tune the plan to conform to the system's capabilities. 

2. Fine-tune the system to provide resources and services offered with the plan. 

ü To change the plan properties to conform to the system: 

1. Go to Service plans > <plan name>. 

2. Adjust the required settings so that they correspond to the Available values 
(see above). 

3. Click Update & Sync. 

The subscriptions will be synced automatically. 

ü To adjust the system: 

Contact your service provider. 

 



 

  
 

Organizing your offerings into service plans is only one of the many steps required to 
get your business ready to run. Before you can start serving customers, you should 
also think about how potential customers will find your offerings, how you will subscribe 
new customers and take payments, and other aspects of your business. To start your 
business more easily, you can use automation solutions that carry out different routines 
for you, for example, issue invoices and take payments from customers. 

The automation tools included in your reseller package by your hosting provider define 
whether you will be able to automate certain business routines. If your hosting provider 
offers you a business automation solution, learn how to automate certain routines in 
the appropriate documentation. Otherwise, you should take care of various aspects of 
your business on your own before you start serving customers. However, in this case, 
you can automate some aspects, for example, financial ones, by means of the 
appropriate software as well. 

To start your hosting business in Panel, do the following: 

Á Rebrand Panel and prepare hosting plans. 

Á Set up a website for your own company. 

After you complete these operations, you can start subscribing customers to your 
services. 

Rebranding Panel and Preparing Hosting Plans 

Before you can start serving your customers, you should do the following: 

1. Adjust Panel branding and appearance as described in the section 
Changing Branding and Interface Settings (on page 44). 

2. On the Service Plans page, add service plans and add-ons that you will 
offer to your customers. 

Setting Up Your Company's Presence on the Web 

To let your prospective customers become acquainted with your offerings and contact 
you, set up a website and e-mail addresses for your company on the Panel-managed 
server. 

To set up your website, create your own hosting subscription by clicking  Subscriptions > 
Create New Subscription. This will enable you to log in to the Control Panel and manage 
your web hosting just as your customers do: you can create web pages and mailboxes, 
install web applications, secure access to websites with SSL certificates, and so on. 
For detailed information about using your hosting resources for your own needs, see 
the chapter Website Management (on page 55). 
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Subscribing Customers to Your Services 

After you set up hosting plans in Panel, you can start subscribing customers to your 
services. When a new customer subscribes to your services, create an account and a 
subscription for this customer in Customers > Add New Customer. You will be prompted to 
enter the following information: 

Á The customer's contact information. 

Á A username and a password that the customer will use to log in to the Control 
Panel. 

Á Subscription details: 

Á A domain name that the customer owns and will use for their website hosted in 
Panel. 

Á An IP address used by the customer's website. 

Á The customer's username and password that they will use to access their 
folders, for example, using FTP. 

Á The service plan to which the customer subscribes. 

Á (Optional) Add-ons that the customer wants to add to the subscription. 

If the plan selected by the customer does not completely meet their needs and you 
do not offer add-ons that could help, adjust the subscription settings by selecting 
the checkbox Proceed to customizing the subscription parameters after the customer 
account is created. 

Once you create the account and the subscription, pass on the Panel access 
credentials to the customer and they will be able to log in to Panel and create their 
website. 

Periodically, you will need to manually perform various operations on user accounts 
and subscriptions. For example, renew (prolong) subscriptions at the end of 
subscription periods, or suspend the accounts of customers who do not pay on time. 
To learn how to manage existing customer accounts and subscriptions in Panel, refer 
to the sections Managing Customer Accounts (on page 47) and Managing Subscriptions (on 
page 48). 

 

 

 



 

  
 

This chapter describes how to select Panel's interface language, rebrand Panel, and 
add links to external sites or web applications. 

Change Interface Language 

In addition to English, Panel can be viewed in the following languages: 

Á Chinese (traditional and simplified) 

Á Dutch 

Á French 

Á German 

Á Italian 

Á Japanese 

Á Polish 

Á Portuguese 

Á Russian 

Á Spanish 

If you want to switch Panel to any of these languages, go to My Profile > Interface 
Preferences. 

When you switch to a language different from English, some button captions may 
become too long and corrupt the Panel layout. To prevent this, you can specify a limit 
on button caption length. In this case, the system will automatically shorten button 
captions longer than this limit and end them with an ellipsis (...).To define the caption 
length limit, enter its value in the Button label length field in My Profile > Interface 
Preferences. To disable automatic shortening, clear this field. 

Add Branded Content 

To disguise the fact that you are reselling another company's hosting resources, you 
can add your own branded content to Panel. Specifically, this content may be the 
following: 

Á The logo in the top left corner. Upload your own logo and your customers will see this 
instead of the original Panel logo in the Control Panel. Use a GIF, JPEG, or PNG 
file for your logo, preferably not larger than 100 kilobytes to minimize the download 
time. To ensure that your logo will fit into the top area, we recommend that you use 
an image 50 pixels in height. 

C H A P T E R  4  

Changing Branding and Interface 
Settings 



 

 Changing Branding and Interface Settings 45  

Á The URL to which the logo points. Make your logo a clickable link that points to your 
company's website to let your customers easily open the website any time they are 
in the Control Panel. 

Á The pages title. Let your customers see your company name or other relevant text in 
their browsers' title bars when they work in the Control Panel. 

To change any of these settings, go to Tools & Utilities > Panel Branding. 

Add Links to Websites and Applications 

If you want to have quick access from Panel to certain websites and applications, or 
wish to provide your customers with such access, create custom buttons. The buttons 
may lead to web resources, such as your corporate site, or to a web application that 
can process online requests and accept additional information about the users clicking 
the buttons. You can place these buttons on your Home page for yourself or in the 
Control Panel for your customers. 

You can place the buttons in the following locations of the Server Administration Panel 
and the Control Panel, and decide who should be able to see them: 

Á On the Home page in the Server Administration Panel, visible only to you. This is 
achieved by selecting the Reseller's Home page option in the button properties. 

Á On the Home tab in the Control Panel, visible to the hosting service customers and 
their users who are allowed to log in to the Control Panel. This is achieved by 
selecting the Customer's Home page option in the button properties. 

Á On the Websites & Domains tab in the Control Panel, visible to the hosting service 
customers and their users who are allowed to log in to the Control Panel. This is 
achieved by selecting the Websites & Domains page of Subscription option in the button 
properties. 

Á On the Home page in the Server Administration Panel and Control Panel, visible to 
you and your customers. This is achieved by selecting the Common access option in 
the button properties. 

You can specify what information about users should be passed: 

Á Subscription ID. 

Á Primary domain name associated with a subscription. 

Á FTP account username and password. 

Á Customer's account ID, name, e-mail, and company name. 

ü To add a custom hyperlink button to the Server Administration Panel or 
the Control Panel: 

1. Go to Tools & Utilities > Custom Buttons (in the Panel Management group), and 
click Create Custom Button. 

2. Specify the following properties of the button: 

Á Type the text that will show on your button in the Button label box. 

Á Choose the location for your button. 
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Á Specify the priority of the button. Your custom buttons will be arranged in the 
Panel in accordance with the priority you define: the lower the number, the 
higher the priority. Buttons are placed in the left-to-right order. 

Á To use an image for a button background, click Browse to browse for the desired 
file. It is recommended that you use a 16x16 pixel GIF or JPEG image for a 
button to be placed in the navigation pane, and a 32x32 pixels GIF or JPEG 
image for a button placed in the main frame. 

Á Type the hyperlink to be attached to the button into the URL box. 

Á Using the checkboxes, specify whether you want the customer information and 
other data to be transferred within the URL. These data can be used for 
processing by external web applications. 

Á In the Tooltip text input field, type in the help tip that will be displayed when users 
place the mouse pointer over the button. 

Á Select the Open URL in Parallels Panel checkbox if you want the destination URL to 
be opened in the main frame of the Panel; otherwise, leave this checkbox 
cleared to open the URL in a separate browser window or tab. 

Á If you want to make this button visible only to you, select the Show to me only 
checkbox. 

3. Click Finish to complete creation. 

To remove a custom button from the Panel, go to Tools & Utilities > Custom Buttons (in 
the Panel Management group), select the corresponding checkbox and click Remove. 

 



 

  
 

If you use Panel without software that automates creating and managing customer 
accounts, manage these accounts in Panel manually. 

To view the details of a customer account, click the customer's name on the Customers 
page. To change these details, use the buttons on the page: 

Á Edit Contact Info lets you update the customer's contact information: name, e-mail, 
address, phone, and so on. 

Á Edit Login Info lets you change the customer's username and password. 

If you want to stop serving a customer, for example, if they do not pay for your 
services, you may suspend the customer's accounts - block access to the Control 
Panel for this customer and users that they created. To suspend an account, click 
Suspend on the customer details page. In addition to suspending the account, this will 
suspend all its subscriptions making the customer's websites, FTP and mail services 
unavailable to the Internet users. 

Later you will be able to cancel the suspension by clicking Activate on the customer 
details page.  

You can also suspend multiple accounts at once or activate multiple suspended 
accounts. To do this, select the accounts that you want to suspend or activate at the 
Customers page and choose the appropriate action from the More Actions menu. 

To remove customer accounts and all subscriptions belonging to them, select these 
accounts at the Customers page and click Remove. 

C H A P T E R  5  

Managing Customer Accounts 



 

  
 

In Panel, you can do the following with existing subscriptions belonging to your 
customers and yourself: 

Á Change hosting settings of a subscription. 

That is, the IP address on which the subscription's websites are hosted, and 
credentials of system user account linked with the subscription (used to manage 
files and folders of websites within the subscription, and to access the server via 
SSH or Remote Desktop). To change a subscription's hosting settings, go to 
Subscriptions > subscription's name, and click Change Hosting Settings. 

Á Transfer one or several subscriptions to another user. 

This means that you change owner of subscriptions, or, in other words, reassign 
subscriptions to another user: another customer or yourself. In this case, the 
subscriptions are automatically unbound from their plans and become custom. To 
transfer one or several subscriptions to another user, go to Subscriptions, select the 
corresponding checkboxes and click Change Subscriber. 

Á Suspend subscriptions. 

Websites, FTP and mail services of suspended subscriptions are no longer 
accessible to the Internet users. Suspending a subscription manually may be useful 
in cases when a website hosted within the subscription gets attacked or the 
subscriber does not pay for the services. 

To suspend one or several subscriptions, go to Subscriptions, select the 
corresponding checkboxes and click Suspend. 

Á Activate suspended subscriptions. 

Once a subscription is activated, all the services provided with it resume operation. 
Activation is only useful for subscriptions that were suspended manually: if you 
activate a subscription that was expired, Panel will automatically suspend it again 
on the next day. To make an expired subscription active, renew it as described 
below. 

To activate one or several subscriptions, go to Subscriptions, select the 
corresponding checkboxes and click Activate. 

Á Renew an expired subscription. 

When a subscription's expiration date comes, Panel suspends it. In such cases, 
you should renew subscriptions manually.  

To renew a subscription, go to Subscriptions > subscription's name, click Activate, 
and then set a new expiration date (it may be unlimited). Then apply the new 
settings by clicking Update & Lock. 

Note:  After this step, the system will not apply further changes of the plan settings 
to this subscription. If you try to sync this subscription with the plan, the subscription 
will expire again unless you set the Unlimited validity period for this plan. 
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Á Remove subscriptions. 

To remove subscriptions, go to Subscriptions, select the corresponding checkboxes 
and click Remove. 

 



 

  
 

With the data backup and restore functions provided by your Parallels Plesk Panel, you 
can perform the following operations: 

Á Back up your account with all domains. The backup archive will include all settings and 
data related to your account and your domains (websites). 

Á Back up individual domains (websites). The backup archive will include all data related 
to a website and mail services, including the contents of mailboxes, address book 
contact lists, antispam and antivirus settings. The instruction for backing up a 
certain website is provided in the section Backing Up and Recovering Websites (on 
page 277). 

Á Schedule backups. Scheduling backup can be done both for your account and your 
domains. 

Á Restore your data from backup archives. 

Your customers granted with the permission to use the backup and restore functions 
can back up and restore their own account settings and websites through the Panel. 

In this chapter: 

Configuring the Control Panel for Using FTP Repository ................................... 51 
Backing Up Your Account with Your Sites ......................................................... 51 
Scheduling Backups .......................................................................................... 52 
Restoring Data From Backup Archives .............................................................. 53 
Downloading Backup Files from Server ............................................................. 54 
Uploading Backup Files to Server ..................................................................... 54 
Removing Backup Files from Server ................................................................. 54 
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Configuring the Control Panel for Using 
FTP Repository 

ü If you are going to use an FTP server for storing backup files, you should 
set up the Control Panel appropriately: 

1. Go to Tools & Utilities > Backup Manager > Personal FTP Repository Settings. 

2. Specify the following settings: 

Á FTP server's IP address or host name. 

Á Directory on the server, where you want to store backup files. 

Á User name and password for access to the FTP account. 

3. Click OK. 
 

Backing Up Your Account with Your Sites 

ü To back up your account with domains: 

1. Go to Tools & Utilities > Backup Manager, and click Back Up. 

2. Specify the following: 

Á Backup file name prefix and description. You cannot specify an arbitrary file 
name, however, you can set the control panel to add a prefix to backup file 
names. Note that the control panel automatically adds the date and time of 
backup file creation (in Universal Time) to backup file names. 

Á Splitting of the backup file. To create a multivolume backup, select the 
respective check box and specify volume size in megabytes. 

Á Location where to store the backup file. Select the repository where you would 
like to store the backup file. 

Á What data to back up. You can back up only the settings related to the user 
accounts and Web sites, or the settings with all user data. 

Á E-mail notification on backup completion. If you want to be notified of the 
backup completion, type your e-mail address. 

3. Click Back Up. The backup process will start and the progress will be 
shown under the Current Back Up Tasks tab. You can use the Refresh button 
to update the information on the screen. When backing up is finished, 
the backup file will be saved to the repository you selected. 
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Scheduling Backups 

ü To schedule backing up of data: 

1. Go to Tools & Utilities > Backup Manager. 

2. Click Scheduled Backup Settings. 

3. Select the Activate this backup task checkbox and specify the following: 

Á When and how often to run the backup. 

Á Backup file name. 

Á Splitting of the backup file. To create a multivolume backup, select the 
respective check box and specify volume size in megabytes. Note that volume 
size cannot exceed 4095 megabytes. 

Á Location where to store the backup file. Select the repository where you would 
like to store the backup file. 

Á Maximum number of backup files stored in the repository. Type a number if you 
want to recycle backup files: When this limit is reached, the oldest backup files 
are removed. 

Á E-mail notification on backing up errors. If you want to send an e-mail notice 
when something goes wrong during backing up, type the e-mail address you 
need. 

Á What data to back up. You can back up only settings, or settings and user data. 

4. Click OK. 
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Restoring Data From Backup Archives 

You can restore data from backup files kept in Panel's repository on the server, a 
custom FTP repository (on page 51), and you can upload a backup file (on page 54) in 
a ZIP archive (on Windows systems) or tar archive (on Linux systems), and then 
restore data from it. 

ü To restore data from a backup file: 

1. Go to Tools & Utilities > Backup Manager. 

2. Click the backup file name. 

3. Specify the following settings: 

Á Types of data to be restored. 

Á Suspend domain (Web site) until restoration task is completed. Select this if you want 
to avoid possible conflicts that may occur when users modify site content or 
settings while they are being restored. 

Á Send an e-mail notice when restoration task is completed. Type your e-mail address if 
you want the Control Panel to notify you when restoring is completed. 

Á Conflicts resolution policy. Specify what to do if any conflicts occur during 
restoration. 

4. Click Restore. 

In case if any errors or conflicts occur during restoration of data, the wizard will 
prompt you to select an appropriate resolution. Follow the instructions provided on 
the screen to complete the wizard. 

Note:  The Overwrite data restoring mode means that all objects will be restored 
from the backup files regardless of their current presence in the system. The 
Overwrite mode works as follows: 

Á If an object or settings from the backup file are not present in Parallels Plesk 
Panel, then they are created or set in Parallels Plesk Panel. 

Á If an object or settings from the backup file are present in Parallels Plesk Panel, 
then the object or settings from the backup file replace the corresponding object 
or settings that are present in Parallels Plesk Panel. 

Á If an object or settings are present in Parallels Plesk Panel, but are missing from 
the backup file, then the object or settings currently present in Parallels Plesk 
Panel are not changed. 
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Downloading Backup Files from Server 

ü To download a backup file from a backup repository within the Panel: 

1. Go to Tools & Utilities > Backup Manager. 

2. Click the icon  corresponding to the backup file you want to download. 

3. Select the location where you want to save the backup file and click 
Save. 

The backup file will be downloaded from the backup repository. 
 

Uploading Backup Files to Server 

ü To upload a backup file to a backup repository within the Panel: 

1. Go to Tools & Utilities > Backup Manager. 

2. Click Upload Files to Server Repository. 

3. Click Browse and select the required backup file. 

Note:  Make sure you select the appropriate backup file format, which depends on 
the operating system on which Parallels Plesk Panel is installed. On Linux/Unix 
systems, you should upload tar or zipped tar archives, and on Windows, ZIP 
archives. 

4. Click OK. 

The backup file will be uploaded to the backup repository. 

Removing Backup Files from Server 

ü To remove a backup file from the backup repository in the Panel: 

1. Go to Tools & Utilities > Backup Manager. 

2. Select a checkbox corresponding to the backup file you want to remove. 

3. Click Remove. 

4. Confirm removal and click OK. 

 



 

  
 

The Panel's main function is simplified administration of hosted websites, mailboxes, 
and other network resources. As a reseller, you can use leased hosting resources for 
your own needs as well as for selling these resources to customers. For example, you 
can set up your corporate website or mailbox on the Panel server. To set up your own 
hosting account, create a subscription in Panel by clicking Subscriptions > Add New 
Subscription. Then provide a domain name for this subscription, specify access 
credentials, and choose a service plan and add-ons if you need them. The subscription 
will appear in the list on the Subscription page together with your customers' 
subscriptions. To start creating your website or to edit the subscription settings, click 
the Open in Control Panel link next to the subscription's name. A list of operations 
available to you in the Control Panel is provided in the table below. 

Helping Customers Manage Their Subscriptions 

Your customers will have different levels of technical expertise and, therefore, may 
have problems with managing certain settings of their subscriptions. To assist your 
customers, you can log in to the Control Panel under a customer's account and edit 
their websites and subscription properties as if they were your own. To start managing 
a customer's subscription in the Control Panel, find the subscription in the list on the 
Subscriptions page and click Open in Control Panel. 

Operating in Control Panel 

Operations related to managing hosting accounts, such as managing website content, 
adding and removing mailboxes, changing hosting settings, and so on, are available to 
you in a separate interface called the Control Panel. 

The sections of this chapter explain how to perform hosting operations in the Control 
Panel. The instructions are applicable to your own subscriptions and subscriptions of 
your customers. This means that when we say your website, your subscription, and so 
on, we imply both your own and your customers' websites or subscriptions. The table 
below lists the sections of this chapter and briefly describes what you can learn from 
them. 

Section Description 

Quick Start with Parallels Panel Explains the workflow of setting up a website 
and a mail account in the Control Panel. 

Customer Account Administration Explains how to view and manage account 
settings, subscriptions, invoices, and 
resources in the Control Panel. 
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Websites and Domains  Explains how to create websites, fill them 
with content, add applications, and configure 
subscription properties related to websites 
and domain names. 

Building Websites with Presence Builder Provides instructions on creating websites 
using Presence Builder - a visual website 
editor coming in a bundle with Panel. 

FTP Access to Your Websites Explains how to set up access to websites 
using FTP for subscribers and auxiliary 
users. 

Mail Describes how to set up mail accounts and 
configure mail settings under subscriptions. 

Scheduling Tasks Provides instructions on configuring Panel to 
automatically run scripts at specific times. 

Using Databases Explains how to use databases under 
subscriptions: create new databases, import 
existing ones, or access external databases. 

Backing Up and Recovering Websites 

 

Provides instructions on backing up and 
restoring the data of certain hosting 
subscriptions on behalf of subscribers. 

 

In this chapter: 

Quick Start with Parallels Panel......................................................................... 57 
Customer Account Administration ..................................................................... 81 
Websites and Domains ..................................................................................... 108 
Creating Sites with Presence Builder ................................................................ 199 
FTP Access to Your Websites ........................................................................... 252 
Mail Accounts .................................................................................................... 256 
Scheduling Tasks .............................................................................................. 267 
Website Databases ........................................................................................... 272 
Backing Up and Recovering Websites............................................................... 277 
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Quick Start with Parallels Panel 

According to the latest studies, the Internet has become the most popular source of 
information in the world, leaving far behind all traditional media such as TV or 
newspapers. Nowadays, the first thing people do when trying to find services is to 
searching for them on the web. Thus, a proper web presence is vital for every 
business. There are a number of ways you can present your company on the Web. A 
web presence may be as simple as a contacts page, or as complex as a large 
company website with access to an ERP system. In both cases, you should perform 
the same steps to get your business online. 

Before proceeding any further, you will need to take the following two essential steps: 

Á Purchase a customer account from a hosting provider. 
Your customer account provides access to the services that are vital for a web 
presence - Internet connectivity, disk space to store your website content, and so 
on. For more information about customer accounts in Panel, refer to the chapter 
Customer Account Administration. 

Á Register a domain name. 
This is the name people will use to access your site from their browsers. For 

example, www.example.c om.  

These two elements - an account for web hosting management and a domain name 
make up your website. 

In this chapter, we will explain how to create your first website, fill it with content, create 
mailboxes for users of the site, and, finally, view the site visits statistics. 

Advanced Hosting Features 

Once you are comfortable with basic Panel capabilities, try out some advanced hosting 
features: Expand website functionality by installing web applications (on page 151), 
secure your sites with SSL certificates (on page 161), employ databases, and much 
more.  

Note:  Hosting providers can turn off some of the advanced features to make your 
Control Panel look simple and user friendly. We have used the (Advanced) prefix to 
designate the sections about features that may be turned off. If you require one of the 
advanced options, contact your hosting provider. 

Next in this section: 

Set Up Your First Website ................................................................................. 58 
Set Up Mail Accounts ........................................................................................ 62 
View Site Visit Statistics .................................................................................... 81 
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Set Up Your First Website 

Now that you have a customer account and a domain name, the first thing you will want to do 
is create a website. The information about the possible ways to do it is provided in the 
section 1. Create Your Site (on page 58) 

When your site is ready, you may want to take a look at the result in your browser. Learn 
how to do it in the section 2. Preview your Site (on page 61). 

Next in this section: 

1. Create Your Site ............................................................................................ 58 
2. Preview Your Site .......................................................................................... 61 
 
 

1. Create Your Site 

There are three general ways to create a website: 

Á Employ a web design studio to create a site for you, and then you will just maintain its 
content.  

Á Create a site by yourself using Presence Builder - the powerful tool that allows you to 
create professional-looking websites in a few mouse clicks. Learn more in the section 
Presence Builder (on page 59). 

Á Create your website in a third-party Content Management System - an editor that allows 
you to easily create and edit website content such as pages, scripts, applications, and so 
on. To learn more about creating sites in third-party content management systems, see 
the section Content Management Systems (on page 59). 

If you have purchased a ready-made site or created it by yourself, you should upload the site 
content to your account to make the site visible on the web. There are two ways to upload 
content: 

Á Using FTP. Learn more in the section Uploading Content Using FTP (on page 61).   

Á Using an integrated File Manager. Learn more in the section Uploading Content with File 
Manager (on page 61). 

Next in this section: 

Presence Builder............................................................................................... 59 
Content Management Systems ......................................................................... 59 
Uploading Content ............................................................................................ 60 
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Presence Builder 

Presence Builder is a tool that enables users with no knowledge of HTML markup or graphic 
design skills to create professional-looking sites. This tool provides a simple visual editor and 
a huge set of templates for different websites. The editor allows you to create web pages, 
add content of different types (text, images, video, scripts), and edit website settings such as 
website name, keywords, icons, and so on. 

To create websites in Presence Builder, ensure that your hosting subscription includes this 
option. If it does not, choose another way or upgrade your subscription. 

ü To create a website with Presence Builder: 

1. Go to the Websites & Domains tab and click your domain name. 

2. Click the link Launch Presence Builder. 

3. Select a topic that best suits your website. 

4. Edit the website: 

a. Structure: add more pages, remove the predefined pages that you do 
not need. 

b. Content: change the predefined content to your own, add text, 
images, videos, scripts, and other required elements. 

c. Design: change the layout and color scheme. 

5. Publish the website. 

Find more information about creating websites with Presence Builder in the section Building 
Websites with Presence Builder (on page 199). 

Content Management Systems 

Content Management Systems (or CMS) are applications that provide a graphical user 
interface for adding and editing website content: pages, scripts, files, multimedia content, and 
so on.  

Before you can create a website in a third-party CMS, you should install the CMS on your 
hosting account. Note that you can install the CMS only if your hosting subscription allows it. 

ü To create a website using a CMS: 

1. Go to the Applications tab.  

2. Find the CMS you need in the list of available applications, and install it as 
described in the section Using Website Applications (on page 151). 

3. Create your website in the CMS. For information about creating websites 
with your CMS, refer to the relevant documentation. 
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Uploading Content 

If you already have a website created by yourself or a web design studio, just upload the 
website files and folders to your provider's server. You can do this in one of the following 
ways: 

Á Using FTP. This way is better when several people manage a website's content because 
it does not require access to your customer account. You can just create FTP users for 
them. Learn more about this method in the section Uploading Content Using FTP (on page 
61). 

Á Using Control Panel File Manager. This way is more convenient since it uses the Control 
Panel GUI and provides a set of useful features, for example, a visual HTML editor and a 
file permissions manager. Find more information on the features of File Manager in the 
section Uploading Content with File Manager (on page 61). 

Next in this section: 

Uploading Content Using FTP........................................................................... 61 
Uploading Content with File Manager ............................................................... 61 
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Uploading Content Using FTP 

ü To publish a website using FTP: 

1. Connect to your webspace on the server with an FTP client program, using 
your FTP account username and password. 

You can change your username and password in the Panel at the Websites & Domains tab 
> Web Hosting Access. 

The FTP address should be ftp://your-domain-name.com, where your-domain-name.com 
is your site's Internet address. 

Enable the passive mode if you are behind a firewall. 

2. Upload the files and directories of your site to the httpdocs  directory. If you 

use CGI scripts, place them in the cgi - bin  directory. 

3. Close your FTP session. 

You can also set up additional FTP accounts if you need to collaborate on website content 
with other users. For more information, see the section Adding FTP Accounts (on page 253). 

Uploading Content with File Manager 

To upload a website from your computer to Panel server with File Manager, open the Files 
tab of Control Panel and drag the website folder to the central area of this tab. You can also 
upload your website as a compressed ZIP file and then extract the contents using the 
archiver integrated in File Manager.  

With File Manager, you can also do the following: 

Á Edit HTML files in the visual editor. 

Á Preview website pages. 

Á Edit files in the text editor. 

Á Manage the files' access permissions. 

Learn more about uploading and editing website files and folders with File Manager in the 
section Managing Website Content (on page 143). 
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2. Preview Your Site 

After you uploaded website files to the webspace, you can check how your site will look in a 
web browser, even before the information about the new site has spread in the Domain 
Name System. 

ü To preview a site:  

1. If you are subscribed to several hosting packages and have access to 
several webspaces associated with your account, select the required 
webspace in the Subscription menu at the top of the screen.    

2. Go the Websites & Domains tab. 

3. Click Preview below the domain name of the website that you want to preview. 

You site will open in a new browser window. 

Note:  The contents of password-protected directories might be inaccessible in the Preview 

mode. 

Sometimes, you may need to show your site to someone when your domain name is not 
registered yet. There are several ways to do it without giving a person access to your 
customer account. Learn more in the section Previewing Websites (on page 150).  

Set Up Mail Accounts 

Once your website is ready, you can start creating mail accounts. You can choose, for 
example, to create mail accounts for all users within your organization. Note that the number 
and size of mailboxes is limited by your hosting plan. 

Next in this section: 

1. Create Mail Account ...................................................................................... 63 
2. Access Your Mailbox ..................................................................................... 64 
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1. Create Mail Account 

ü To create an e-mail address: 

1. If you are subscribed to several hosting packages and have access to 
several webspaces associated with your account, in the Subscription menu at 
the top of the screen, select the required webspace.     

2. Click the Mail tab. 

3. Click Create E-mail Address. 

4. Type the left part of the e-mail address before the @ sign, and, if you have 
several domain names on your account, select the domain name under 
which the e-mail address will be created. 

5. Leave the Mailbox checkbox selected. 

Clearing this checkbox makes sense only if you want to use this address as a mail 
forwarder, which will forward all incoming mail to another address. 

6. Specify the mailbox size or use the default size defined by the provider's 
policy or your service plan. 

7. Specify a password consisting of five or more Latin characters. 

8. Click OK. 
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2. Access Your Mailbox 

There are two ways to access a mailbox for sending and receiving e-mail messages: 

Á Set up and use an e-mail client program on your computer. Typically, in such programs 
you should specify the following settings: 

Á Username. In this field, specify your full e-mail address. For example, 
johndoe@example.com. 

Á Password. Most likely, the password to your e-mail account. 

Á Mail server protocol. This property defines whether you want to keep copies of 
messages on the server or not.  To keep the copies on the server, select the IMAP 
option. If you do not want to keep them on the server, select POP3. Selecting IMAP will 
also allow you to train the SpamAssassin spam filter on e-mail messages you receive, 
if SpamAssassin is enabled on the server. 

Á Incoming mail server (POP3/IMAP). Type your domain name. For example, 
example.com. The POP3 port is 110. The IMAP port is 143. 

Á Outgoing mail server (SMTP). Type your domain name. For example, example.com. 
The SMTP port is 25. This server requires authentication. 

To get detailed instructions on configuring popular e-mail clients to work with your 
mailbox, see subsections of this section. 

Á Use a web browser to connect to the webmail interface. 

 

Note: If you cannot access your mailbox following the instructions in this section, this might 
be caused by mail server settings. Contact your hosting provider to resolve the issue. 

Next in this section: 

Access from Webmail ........................................................................................ 65 
Access from Microsoft Office Outlook ................................................................ 65 
Access from Microsoft Outlook Express ............................................................ 69 
Access from Mozilla Thunderbird ...................................................................... 73 
Access from Apple Mail ..................................................................................... 76 
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Access from Webmail 

ü To access your mailbox through webmail, do any of the following: 

Á In a Web browser, visit the URL webmail.example.com , where example.com  is the 

Internet address of your website. When prompted, specify your full e-mail address as the 

username (for example, mail@example.com ), and specify the password that you use 

for logging in to the Panel. 

Á When logged in to the Panel, click the Mail tab, and in the list of e-mail addresses, click 

an icon  corresponding to the e-mail address you need. 

 
 

Access from Microsoft Office Outlook 

ü To set up Microsoft Office Outlook 2010: 

1. Open Microsoft Office Outlook. 

2. Go to File > Info > Add Account. 

3. Select the checkbox Manually configure server settings or additional server types. 
Click Next. 
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4. Select the Internet E-mail option and click Next. 
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5. Specify the following: 

Á Your name. 

Á Your e-mail address. 

Á Account type. If you want to keep copies of messages on the server, select the IMAP 
option. If you do not want to keep any messages on the server, select the POP3 
option. Selecting IMAP will also allow you to train the SpamAssassin spam filter on e-
mail messages you receive, if SpamAssassin is enabled on the server. 

Á Incoming mail server. Type your domain name. For example, example.com. 

Á Outgoing mail server (SMTP). Type your domain name. For example, example.com. 

Á User Name. Specify your full e-mail address. Example: johndoe@example.com. 

Á Password. Most likely, this password coincides with the password you use for logging 
in to Panel. 

Á Require logon using Secure Password Authentication (SPA). Leave this option cleared. 
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6. Click More Settings, open the Outgoing Server tab and check My outgoing server 
(SMTP) requires authentication. 

 

7. Click Next. 

8. Click Finish. 
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Access from Microsoft Outlook Express 

The instructions provided in this section were verified against Microsoft Outlook Express 6. 
They might not work with earlier or later versions of Microsoft Outlook Express. 

ü To set up Microsoft Outlook Express: 

1. Open Microsoft Outlook Express. 

2. Go to Tools > Accounts. 

3. Click the Add button and select the Mail item. 

4. Enter your name as you want it to appear in any messages you send, and 
click Next. 
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5. Type your e-mail address, and click Next. 
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6. Specify the following settings: 

Á Protocol of your incoming mail server. 

If you want to keep copies of messages on the server, select the IMAP option. If you 
do not want to keep any messages on the server, select the POP3 option. Selecting 
IMAP will also allow you to train the SpamAssassin spam filter on e-mail messages 
you receive, if SpamAssassin is enabled on the server. 

Á Incoming mail server. Specify your website's Internet address. 

Á Outgoing mail server. Specify your website's Internet address. 
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7. Click Next. 

8. Specify the following: 

Á Your account name. Type your e-mail address in the Account name box. 

Á Your password. Most likely, this password coincides with the password you use for 
logging in to the Panel. 

Á Remember password checkbox. Leave it selected if you do not want to be prompted to 
enter password each time your e-mail program connects to the mail server to check 
for new mail, and click Next. 

 

9. To complete setting up your e-mail program, click Finish. 
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Access from Mozilla Thunderbird 

The instructions provided in this section were verified against Mozilla Thunderbird 12. They 
might not work with earlier or later versions of Mozilla Thunderbird. 

ü To set up Mozilla Thunderbird: 

1. Open Mozilla Thunderbird. 

2. Go to Tools > Account Settings > Account Actions > Add Mail Account. 

3. Specify the following: 

Á Your name, as you want it to appear in any messages you send. 

Á Your e-mail address and password. 
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4. Click Continue. 

5. If Thunderbird fails to find the settings automatically, specify the following:  

Á Account type. If you want to keep copies of messages on the server, select the IMAP 
option. If you do not want to keep any messages on the server, select the POP3 
option. Selecting IMAP will also allow you to train the SpamAssassin spam filter on e-
mail messages you receive, if SpamAssassin is enabled on the server. 
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6. Click Create Account. 

 

If you set up a mail account manually, please use the following typical combinations of 
connection security and authentication method settings. If the settings do not work for you, 
ask your hosting provider about the correct combination. 

On Linux: 

Á Connection security: STARTTLS 

Á Authentication method: Encrypted password 

 

On Windows, IMAP: 

Á Connection security: None 

Á Authentication method: Encrypted password 

 

On Windows, POP3: 

Á Connection security: None 

Authentication method: Password, transmitted insecurely Other parameters that you may need 
when configuring your account manually: 

Á POP3 port: 110 

Á IMAP port: 143 

Á SMTP port: 25  

Á Username. Your full e-mail address. For example: johndoe@example.com. 

Á Incoming server address (POP3/IMAP). Specify your website's Internet address. Example: 
example.com 

Á Outgoing server address. Specify your website's Internet address. Example: example.com 
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Access from Apple Mail 

The instructions provided in this section were verified against Apple Mail 3.6 (Leopard). They 
might not work with earlier or later versions of Apple Mail. 

ü To set up Apple Mail: 

1. Run Apple Mail. 

If you run it for the first time and do not have any mail accounts configured in it, skip the 
next step: Apple Mail will take you directly to creating one. 

2. Open the Adding Mail Account wizard: 

a. Click Mail > Preferences.... 

b. Select the Accounts tab. 

c. Click the + button at the bottom left corner. 

3. Enter the account information: 

Á Your full name 

Á Your full e-mail address 

Á The password you use to log in to the Panel.  
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4. Click Continue. 

5. Fill in the following incoming mail server information: 

Á Account Type: select whether you want to use IMAP or POP protocol. 

We recommend selecting IMAP if you use SpamAssassin as a spam filtering solution: 
IMAP account is a requirement for SpamAssassin learning which messages are spam 
and which are not. 

Á Incoming Mail Server: type in the name of domain which serves your mail (which follows 
the @ sign in your e-mail address). 

Á User Name: enter your full e-mail address.  

Á Password: leave it auto-completed (Apple Mail takes it from the previous step). 
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6. Click Continue. 

7. (Optional) Specify the incoming mail security options: 

a. Select the Use Secure Sockets Layer (SSL) checkbox. 

b. Select the authentication method. 

Keep the default method if you are not sure which to select. 

Apple Mail displays this setup screen only if a mail server bundled with Panel supports 
SSL for the selected account type (POP or IMAP). 
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8. Click Continue. 

9. Fill in the following outgoing mail server information: 

Á Outgoing Mail Server: type in the name of domain which serves your mail (which follows 
the @ sign in your e-mail address). 

Á Use only this server: selected. 

Á Use Authentication: selected. 

Á User Name: enter your full e-mail address.  

Á Password: leave it auto-completed (Apple Mail takes it from the previous step). 
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10. Click Continue. 

Apple Mail displays overall description of the mail account that is going to be created. 

11. Select the Take account online checkbox and click Create. 

 

 

 

 
 



 

 Website Management 81  

View Site Visit Statistics 

Finally, when your site works fine and search engines return it in search results, it is the best 
time to evaluate site efficiency by viewing the visits statistics. 

ü To find out how many people visited a site, from what countries, and what 
pages of the site they viewed: 

1. If you are subscribed to several hosting packages and have access to 
several webspaces associated with your account, in the Subscription menu at 
the top of the screen, select the required webspace.     

2. Go to the Websites & Domains tab and click the domain name for which you 
want to view the statictics 

3. Click Web Statistics. 

The site visitor statistics will show in a new browser window. 

4. To view statistics for web pages viewed from the SSL-secured area of your 
site, select SSL Web Statistics in the menu. 

5. To view statistics for files downloaded over the file transfer protocol (FTP), 
select FTP Statistics in the menu. 

Alternately, you can view the visits statistics for a site by visiting the following URL: 
https://your-domain.com/plesk-stat/webstat. When prompted for username and password, 
specify your FTP account username and password. 

You have successfully completed the quick start part of the guide. Feel free to read about 
other features that are available to you in the Control Panel. 

Customer Account Administration 

As described in the section Quick Start with Parallels Panel, the first step in establishing your 
company's web presence is signing up to the services provided by a hosting company 
(hosting provider). After you subscribe to a hosting plan, a customer account in Panel is 
created to enable you to log in to Panel and use the hosting services and resources like 
mailboxes, disk space, and bandwidth. 

 

 

 

https://your-domain.com/plesk-stat/webstat
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Customer Account and Multiple Subscriptions 

Panel allows you to subscribe to as many hosting plans as you need. For example, if you do 
not want your main site to share hosting resources with a company's branch site you can 
subscribe to another hosting plan under the same customer account. In other words, a 
customer account is a personalized access to all your subscriptions (see the picture below). 
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Another reason for using multiple subscriptions is that subscription is limited to only one IPv4 
and one IPv6 address. Thus, all domains within a subscription share the same IP address 
(v4 or v6). If you need to host sites on different IP addresses, you should additionally order 
the same plan for as many IP addresses as you need. This can be useful, for example, if you 
want to secure connections to each of your sites with a separate SSL certificate. For 
information on how to purchase an additional subscription, refer to the section Ordering More 
Resources (on page 97). 

If you have multiple subscriptions under a single customer account, you can easily switch 
among them from the Account tab. To be more specific, the Account tab provides access to 
operations that apply to all your subscriptions. All other tabs (like Mail, Users, or Domains & 
Websites) are, on the contrary, subscription-wide. This means that to change mail settings on 
a particular subscription, you should first switch to it before clicking Mail.  

System Users 

For each hosting subscription, Panel creates a system user - a user account in the Panel 
server operating system. Customers obtain their system users' access credentials from their 
service providers and use these credentials for connecting to the server through FTP, SSH, 
and so on. In addition, all operations with files and directories in Panel are performed on 
behalf of system users. For example, when a customer adds a new file in File Manager, the 
subscription's system user becomes the owner of the file. 

Adding Resources to a Subscription 

Purchasing a new subscription for extending hosting resources is not always necessary. You 
can always improve just one of your subscriptions. For example, add extra disk space or SSL 
support. This can be done by switching to another hosting plan or by purchasing hosting plan 
add-ons. Learn more in the section Ordering More Resources (on page 97). 

Managing Customer Account 

In Panel, you can perform a number of administrative operations on your customer account:   

Á Change an account password and personal information. Learn more in the section 
Changing Your Password and Contact Information (on page 85). 

Á View the list of services and resources provided by subscription on the Account tab. For 
detailed information about all subscription features, refer to the section Viewing 
Subscription Summary (on page 86). 

Á Make payments to renew your subscription. Learn more in the section Managing Account 
Balance and Invoices (on page 93). 

Á View statistics on your account: For example, disk space or traffic usage. Learn more in 
the section Viewing Statistics (on page 99). 
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Allowing Other Users to Access Your Account 

If the number of hosting maintenance operations is too large to be handled by one person, 
you can delegate some of them to other people. For this purpose, you can create auxiliary 
user accounts grouped by means of user roles. For example, you can create a group that is 
allowed to only upload content to websites. Users in this group will not be able to perform 
any operations except for managing website content. For more information about auxiliary 
users, refer to the section (Advanced) Managing Auxiliary User Accounts (on page 101). 

 

Next in this section: 

Changing Your Password and Contact Information ........................................... 85 
Viewing Subscription Summary ......................................................................... 86 
Managing Account Balance and Invoices .......................................................... 93 
Ordering More Resources ................................................................................. 97 
Viewing Statistics .............................................................................................. 99 
(Advanced) Managing Auxiliary User Accounts ................................................. 101 
 

 



 

 Website Management 85  

Changing Your Password and Contact Information 

ü To change your password for access to the Control Panel: 

1. Click a link with your name at the top of the screen. 

2. Type a new password, and click OK. 

ü To change a username or password that you use for connecting to your 
subscription over FTP or SSH: 

1. Click the Websites & Domains tab. 

2. Click Web Hosting Access. 

3. Type the new username or password, and click OK. 

ü To change your contact information: 

1. Click a link with your name at the top of the screen. 

2. Click the Contact Details tab. 

3. Update your contact information and click OK. 
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Viewing Subscription Summary 

When you subscribe to hosting services, a user account is created in the Panel to allow you 
to manage your websites and mailboxes on your own. 

You can view the following information about your account: 

Á Current subscriptions to service plans. 

You can be subscribed to a number of service plans at once, and, therefore, can have 
several subscriptions associated with your account. If a billing system is connected to the 
Panel, then you can also purchase additional subscriptions, upgrade or downgrade them, 
and pay your invoices.   

Á Allocated and consumed resources. 

Á Hosting features available for your websites. 

Á Operations you can perform in your Panel. 

Á Account balance, unpaid invoices, and monthly fee for your hosting package. 

ü To view the information about your account and your current subscriptions: 

1. Click the Account tab. 

A list of your current subscriptions is shown. 

2. If the billing system is integrated with the Panel, then the following 
information is shown: 

Á Account credit balance. This is how much money is available in your billing account. 

Á Due invoices balance. This is how much money you owe to your provider. Here, you can 
pay all invoices at once by clicking Pay All Outstanding Invoices, or pay one of invoices 
by clicking a Pay Now link in the list titled Latest Outstanding Invoices. You can also view 
all invoices by clicking the link Show all invoices, or print an invoice by clicking an 
invoice number and then clicking Print. 

Á Latest to-do items. This shows reminders from the system about the actions you need to 
take. 

Á List of all your subscriptions. You can use links in the list to perform the following 
operations: 

Á View subscription properties by clicking a link with subscription name. 

Á Select a subscription that you want to manage through the Control Panel by 
clicking the corresponding link Switch to Subscription. 

Á Order an SSL certificate for a site by clicking Request SSL Certificate. This operation 
is described in the section Ordering SSL Certificates. 

Á View properties of already ordered SSL certificates by clicking Show Certificate Info. 

Á View or change domain information, contact information, and DNS settings 
specified at a registrar's site, by clicking Show Domain Info. These operations are 
described in the section Registrar's DNS Settings in Panel (on page 122). 

3. To view detailed information about resource allotments, available hosting 
options, and permissions for operations, click a subscription's name. 
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4. Do any of the following: 

Á To view a list of allocated and consumed resources, click the Resources tab.  

Á To view a list of hosting features available for your account, click the Hosting Options 
tab. 

Á To view a list of operations that you can perform in your Hosting Panel, click the 
Permissions tab. 

 

 

Next in this section: 

Allocated and Consumed Resources ................................................................. 88 
Hosting Features Available for Your Websites ................................................... 90 
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Allocated and Consumed Resources 

If you are subscribed to a number of service plans at once, then you have several 
subscriptions. For each subscription, the following types of allocated resources are listed in 
the Panel at the Account tab > subscription name > Resources tab: 

Á Disk space. This is the total amount of disk space allocated to your account with 
subscription. This amount includes all data related to your websites, e-mail accounts, 
applications, backups, and log files. 

Á Traffic. This is the total amount of data in megabytes that can be transferred monthly from 
all your websites. 

Á Domains. This is the number of websites that can have separate second-level domain 
names, such as, for example, example.com. 

For information about setting up websites, refer to the sections Set Up Your First Website 
(on page 58) and Adding Domains (on page 110). 

Á Subdomains. This is the number of additional websites that can have third-level domain 
names, such as, for example, news.example.com. 

For information about setting up subdomains, refer to the section Adding Subdomains (on 
page 112). 

Á Domain aliases. This is the number of additional domain names that can be set up to point 
to one of your sites. For example, example.fr and example.de can both point to 
example.com. 

For information about setting up domain aliases, refer to the section Adding Domain Aliases 
(on page 114). 

Á Mailboxes. This is the number of mailboxes that can be created under all your websites. 

For information about creating mailboxes, refer to the chapter Mail. 

Á Mailbox size. This is the amount of disk space that can be occupied by a mailbox. 

Á Total mailboxes quota. This is the total amount of disk space that can be used by all 
mailboxes under all your domains. This option is available only on Windows-based 
customer accounts. 

Á Mailing lists. This is the total number of mailing lists that can be set up under all your 
websites. Note that there are mailing lists and mail groups, which serve the same 
purpose, but are slightly different in functionality. Mailing lists support archiving and pre-
moderation of messages, while mail groups can only be used for sending one message to 
a number of recipients at once. 

For information about setting up and using mailing lists, refer to the section Using Mailing 
Lists (on page 266). 

Á Additional FTP accounts. This is the number of FTP accounts that can be set up for 
accessing the webspace, in addition to the main FTP account that was created when your 
subscription was activated. 

For information about setting up FTP accounts, refer to the sections Changing FTP Access 
Credentials (on page 252) and Adding FTP Accounts (on page 253).  

Á Databases (Linux). This is the number of databases that can be hosted for all your 
websites. Databases are a standard means of organizing data storage that allows 
dynamic websites, web applications, and their users to store, search, and retrieve 
information. 

For information about working with databases, refer to the chapter (Advanced) Using 
Databases. 
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Á MySQL databases and Microsoft SQL Server databases (Windows). This is the maximum 
number of MySQL and Microsoft SQL Server databases respectively that can be created 
on the Panel database servers and used by the subscription's websites. 

Á MySQL databases quota and Microsoft SQL databases quota (Windows). This is the maximum 
amount of disk space (in megabytes) that the subscription's MySQL and Microsoft SQL 
Server databases respectively can occupy. 

Á Java applications. This is the number of Java applications packaged in WAR format that 
you can install on your sites. 

Á Sites published with Presence Builder. This is the number of sites that you can create and 
publish using Presence Builder, if Presence Builder option is included in your hosting 
package. 

Á Mobile sites.This is the total number of websites that you can host with the UNITY Mobile 
online service, which optimizes sites for viewing on mobile devices. 

Á Web users. This is the number of user accounts that you can create for hosting web pages 
for other users under your domains. 

Á FrontPage accounts. This is the number of Microsoft FrontPage user accounts that you can 
create for collaboration on site content using FrontPage. This option is available only for 
Windows-based customer accounts. 

Á Shared SSL links. This is the number of websites that you can secure with an SSL 
certificate shared by your provider. This option is available only for Windows-based 
customer accounts. 

Á ODBC DSN connections. This is the number of connections to external databases that you 
can create for web applications running on your customer account. This option is 
available only for Windows-based customer accounts. 

Á ColdFusion DSN connections. This is the number of connections to external databases that 
you can create for web applications written in Adobe ColdFusion, which are running on 
your customer account. This option is available only for Windows-based customer 
accounts. 
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Hosting Features Available for Your Websites 

Depending on your service plan, the following hosting features may be available for your 
websites (listed at the Account tab > subscription name > Hosting Options tab): 

Á SSL support. This allows you to secure connections to websites with SSL encryption. 

For information about securing sites with SSL, refer to the section Securing Connections 
with SSL Certificates (on page 161). 

Á Web statistics. This allows you to view website visits statistics presented in diagrams and 
charts. 

For information about viewing website visits statistics, refer to the section Viewing Statistics 
(on page 99). 

Á Custom error documents. This allows you to create custom HTML pages and configure web 

server to show them instead of typical error messages, such as 404 Not Found . 

For information about setting up custom error documents, refer to the section Setting Up 
Custom Error Pages (on page 170).   

Á Support for programming and scripting languages, such as PHP, CGI, Perl, Python, Microsoft 
ASP, ASP.NET, Adobe ColdFusion, SSI.  

Á Microsoft FrontPage support and Microsoft FrontPage over SSL support. These allow you to use 
Microsoft FrontPage to create and edit website content. These options are available only 
for Windows-based customer accounts. 

Á Remote Microsoft FrontPage authoring (Windows). This allows you to use Microsoft 
FrontPage to create and edit website content directly on the server. This option is 
available only for Windows-based customer accounts. 

Á Dedicated IIS application pool (Windows). This provides isolation and improved stability for 
web applications working on sites. 

Á Additional write/modify permissions (Windows). This option allows the web applications to 

use a file-based database (like Jet) located in the root of httpdocs  folder. 

Á Allow web users to use scripts. This allows scripting at web pages available at URLs like 
http://example.com/~<username>/<webpage>, where <username> refers to a web user. 
Web users are individuals who do not need their own domain names. This service is 
popular with educational institutions that host non-commercial personal pages of their 
students and staff. 

  

The following is a list of permissions for operations that you can perform in your Panel 
(shown at the Account tab > subscription name > Permissions tab): 

Á DNS zone management. Manage resource records in the DNS zones of websites. DNS 
stands for Domain Name System. It is a service that enables web browsers to locate 
websites by domain names. 

For information about configuring DNS settings for your websites, refer to the section 
(Advanced) Configuring DNS for a Domain (on page 116). 

Á Hosting settings management. Manage web hosting settings, such as custom web server 
settings or support for scripting languages. 
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Á PHP safe mode management. This option is available only for Linux-based customer 
accounts. It allows you to switch PHP safe mode on or off for websites. Safe mode is a 
security restriction that does not allow scripts written in PHP to perform potentially 
dangerous operations on the server. You might need to switch off the safe mode for PHP 
if you use some web applications written in PHP and if they do not function properly. 

Á Management of access to the server over SSH and Management of access to the server over Remote 
Desktop. Securely upload web content to the server through Secure Shell (Linux) or a 
Remote Desktop connection (Windows).  

Á Anonymous FTP management. Set up a folder on the server which should be accessible to 
the Internet users over FTP protocol. This folder can have an address like, for example, 
ftp://downloads.example.com. This feature is called anonymous FTP because the users 
will not need to specify a username and password to browse, download, or upload files. 

For information about setting up FTP folder with unrestricted access, refer to the section 
Setting Up Anonymous FTP Access (on page 255). 

Á Scheduler management. Schedule execution of programs or scripts in the server's operating 
system. 

For information about scheduling tasks, refer to the chapter Scheduling Tasks. 

Á Spam filter management. Set custom settings for protection from unsolicited commercial e-
mail, also known as spam. 

For information about setting up spam filtering, refer to the section Protecting Mailboxes 
from Spam. 

Á Antivirus management. Set custom settings for protection from viruses and other malicious 
software that spreads itself through e-mail. 

For information about setting up virus protection, refer to the section Protecting Mailboxes 
from Viruses. 

Á Data backup and restoration using the server repository. Use the backup and restore functions 
of the Panel to back up and restore websites, mail accounts, settings, and keep your 
backup files on the server. 

For information about backing up and restoring data, refer to the chapter (Advanced) Back 
Up and Restore Data.  

Á Data backup and restoration using a personal FTP repository. Use the backup and restore 
functions of the Panel to back up and restore websites, mail accounts, settings, and save 
your backup files to an FTP folder on another server. 

For information about backing up and restoring data, refer to the chapter (Advanced) Back 
Up and Restore Data.  

Á Web statistics management. Set custom preferences for visitor statistics reports. 

For information about configuring and viewing website visitor statistics, refer to the 
section Viewing Statistics (on page 99).  

Á Log rotation management. Set custom preferences for recycling (rotation) of web server 
logs. Web server records information about connections to your sites and errors occurred 
on attempts to retrieve missing files. You can use these log files for website debugging 
purposes. 

For information about working with web server access logs, refer to the section Log Files 
(on page 100). 

Á Access to Application Catalog. View and install applications on websites. For information 
about applications, refer to the section Employing Website Applications (on page 151). 

Á Setup of potentially insecure web scripting options that override provider's policy. This allows you 
to override the hosting security policy, if it is applied by the provider. 



 

92 Website Management 

 

Á Domain creation. Set up and manage new websites. 

For information about setting up websites, refer to the sections Set Up Your First Website 
(on page 58) and Adding Domains (on page 110). 

Á Subdomains management. Set up and manage new websites with addresses like 
forum.example.com. 

For information about setting up subdomains, refer to the section Adding Subdomains (on 
page 112).  

Á Domain aliases management. Set up and manage additional domain names for a site. 

For information about setting up domain aliases, refer to the chapter Adding Domain Aliases 
(on page 114). 

Á Additional FTP accounts management. Set up and manage additional FTP accounts. To 
enable collaboration on website content, you can set up FTP accounts for other users 
and specify which directories of the site should be accessible to them. 

For information about setting up FTP accounts, refer to the section Adding FTP Accounts 
(on page 253).  

Á Java applications management. Install and manage Java applications distributed in WAR 
archives and obtained separately from third-party vendors or application developers. 

For information about installing Java applications, refer to the section Installing Java 
Applications.  

Á Mailing lists management. Set up and manage mailing lists. 

For information about setting up and using mailing lists, refer to the section Using Mailing 
Lists (on page 266). 

Á Hosting performance settings management. Limit the bandwidth and number of connections to 
websites. 

For information about restricting bandwidth usage for sites, refer to the section Limiting 
Bandwidth and Number of Connections to Websites (on page 177). 

Á IIS application pool management. Set custom preferences for IIS application pool (available 
only on Windows-based customer accounts). 

For information about setting up IIS application pool, refer to the section Setting Up IIS 
Application Pool (Windows) (on page 196). 

Á Additional write/modify permissions management. Set additional write/modify permissions for 
websites that use file-based databases (available only on Windows-based customer 
accounts). 

Á Shared SSL management. Secure connections to your sites with SSL protection by using an 
SSL certificate shared by your provider. 

For more information, refer to the section Using Shared SSL Certificates (Windows) (on page 
165). 

Á Hard disk quota assignment. Adjust hard quotas on disk space if that is supported by your 
customer account. 

Á Database server selection. Select a database server for creating databases, if multiple 
database servers are available. 
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Managing Account Balance and Invoices 

The operations described below are available if your Control Panel is integrated with 
Parallels Parallels Customer and Business Manager. 

ü To view your account balance and pay for hosting services: 

1. Click the Account tab. 

2. The following information is shown: 

Á Account credit balance. This is how much money is available in your account. 

Á (Optional) Usage charge. If your subscription allows consuming hosting resources 
over the plan limit, this number shows how much money you should pay for these 
resources in addition to your subscription price. To view the detailed information about 
how much resources you used over limits, click the link See details below the charge 
amount. To learn how the system calculates usage charges, see the section 
Calculating Usage Charges (on page 95). 

Á Due invoices balance. This is how much money you owe to your provider. Here, you 
can pay all invoices at once by clicking Pay All Outstanding Invoices, or pay one of 
invoices by clicking a Pay Now link in the list titled Latest Outstanding Invoices. 

Á Latest to-do items. This shows reminders from the system about actions you need to 
take. 

Á (Optional) Affiliate programs. Your provider may let you earn money for promoting 
their plans. To start earning, you should join their affiliate programs. Here you can find 
the link to join affiliate programs or the info about your money you earn if you already 
joined the programs. To learn how to get profit from affiliate programs, see the section 
Earning Money by Promoting a Provider's Plans (on page 95).  

Á List of all your subscriptions. You can use links in the list to perform the following 
operations: 

Á To view subscription properties, click a link with subscription name. 

Á To select a subscription that you want to manage through the Control Panel, click 
the corresponding link Switch to Subscription. 

Á To order an SSL certificate for a site, click Order a Certificate. For more information 
about this operation, see the section Ordering SSL Certificates. 

Á To view properties of already ordered SSL certificates, click Show Certificate Info. 

Á To view or change domain information, contact information, and DNS settings 
specified at a registrar's site, click Show Domain Info. For more information about 
these operations, see the section Registrar's DNS Settings in Panel (on page 122). 
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ü To choose a payment method that you would like to use for paying for 
services: 

1. Go to the Account tab > Billing Accounts. 

A record about the payment method that you used for purchasing the services for the first 
time is shown. 

2. Do any of the following: 

Á To view or change settings for a billing account, click the corresponding link in the 
Billing account name column, specify the information about your bank card or account, 
and select the subscriptions that should be paid by it. Click OK. 

Á To add a new billing account, click Add New Billing Account, select the payment method, 
and click Next.  Then choose the account owner (you or an auxiliary user that will be 
able to use this account), specify the required information about your bank card or 
account, and select the subscriptions for which you will pay with it. Click OK. 

Á To remove a billing account, click the corresponding Remove link. 

 

Next in this section: 

Calculating Usage Charges ............................................................................... 95 
Earning Money by Promoting a Provider's Plans ............................................... 95 
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Calculating Usage Charges 

If the pay-as-you-go web hosting is allowed for a plan, Business Manager calculates usage 
charges - total costs of hosting resources overage - for the plan's subscribers basing on 
resource usage statistics that Business Manager collects from the connected Panels on a 
daily basis. No matter what billing mode and billing cycles you use, this happen on the first 
day of each month: The system finds the average daily overage of each resource except 
traffic and multiplies it by the month length and the monthly usage price of this resource. 

Traffic 

The traffic usage charge is calculated in the following way: Business Manager counts the 
total traffic overage for a month and multiplies it by the monthly traffic usage price. For 
example, if subscribers download 10 GB of files during a month while the plan limit is 5 GB, 
then the traffic overage is 5 GB. Assuming that the traffic usage price is $1 for a 1 GB, such 
subscribers will pay (10 GB - 5 GB) * $1 = $5 traffic usage fee. 

Other Resources 

For calculation usage charges for other resources, Business Manager uses the average daily 
usage values. For example, if a customer uses 500 MB of disk space over the subscription 
quota for 15 days and then uses extra 700 MB for other 15 days, the average overage will be 
(500 * 15 + 700 * 15)/30 = 600 MB. If the disk space usage price is $1 for 1 GB, then the 
customer will pay $0.6 for disk space overage this month. 

Calculating Usage with Add-ons 

If a customer purchases additional resources in the middle of a month, then the system 
subtracts the resource amount provided by the add-on from the daily resource usage of each 
day starting from the add-on purchasing day. 

For example, if a customer uses 500 MB of disk space over the plan limit for a whole month 
and purchases the add-on that provides an additional 1 GB of disk space on the 7th day of 
the month, then the usage charge will include the payment for only 7 days of 500 MB of disk 
space overage. 

 

Earning Money by Promoting a Provider's Plans 

Panel lets you earn money for promoting your provider's service plans. Particularly, you can 
get a certain commission for each subscription ordered in the provider's online stores by 
people who signed up using your referral link.  
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Participants of affiliate programs (affiliates) distribute links to their provider's online stores. 
Each link is unique, so the system defines who brought a new customer and adds the 
commission to the link owner's affiliate balance. This commission is defined by the terms of 
the affiliate program and may vary depending on an online store. The commission consists of 
two different elements: 

Á Initial rate - a percentage that the affiliate earns from the price of each order placed using 
the affiliate's link.  

Á Recurrent rate - a percentage that the affiliate earns from each invoice issued for 
subscriptions that were ordered using the affiliate's link.  

Affiliates can use money they earn only after the provider pays out the money to them. 
Depending on the affiliate program conditions, the provider can pay out the commission 
either to the affiliate's account credit balance or transfer the money outside the system, for 
example, by check or cash. Normally, the provider pays out affiliates' commissions when 
they exceed the affiliate program's payment threshold. When the threshold is exceeded, 
affiliates can request the provider to pay out the commission by using the button in the 
Control Panel. Alternatively, affiliates can delay payments in order to earn a larger amount. 

Becoming an Affiliate 

To start earning money, click the link Become an Affiliate on the Account tab. Once became an 
affiliate, you will get the access to the list of the provider's affiliate programs and your affiliate 
links. To see the programs list and your links, click the Affiliate Programs list on the Account 
tab. 

Tracking Your Earnings 

To see your current affiliate balance, go to the Account tab and find the balance in the Affiliate 
Programs group. If you want to see detailed information about your earnings, click the link 
Revenue from Referrals. 

To request a payout after exceeding a payment threshold, go to the Affiliate Programs page, 
select the programs and click Request Payout. 

Note: If none of your affiliate balances exceed the corresponding thresholds, you will not see 
the Request Payout button. 

Example 

For example, your provider offers you an affiliate program with 10% commission rate and 
$20 payment threshold. You share your affiliate link with your friends, and three of them 
subscribe to a web hosting plan which costs $50. The total commission that you get to your 
affiliate balance is $50 * 3 * 10% = $15. This amount is less than the program's payment 
threshold, so to receive credits, you should bring more customers to the online store with 
your link. When you do this and your balance exceeds the payment threshold which is $20, 
the provider will add this balance to your credits. When you receive them, you can use them 
to pay for your subscriptions or subscribe to new services in the provider's online stores. 
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Participating in Multiple Programs 

Your hosting provider may have multiple online stores with different currencies. If the 
provider offers affiliate programs for stores with different currencies, you will receive separate 
commissions in the corresponding currencies. For example, if you distribute links to stores 
with USD and EUR currencies, your affiliate balance contains two separate affiliate balances, 
one for each currency. Your provider pays out the commissions separately as well. For 
example, your affiliate balance is USD 50 and EUR 40 and the payment thresholds of the 
corresponding programs are USD 40 and EUR 45, your provider will pay out USD 50 to your 
credits and your affiliate balances will be USD 0 and EUR 40.  

Ordering More Resources 

The operations described below are available if your Control Panel is integrated with a billing 
system. 

ü To add more resources to your subscription or upgrade to another service 
plan: 

1. Click the Account tab. 

2. In the list of subscriptions, locate the subscription that you want to upgrade 
to another service plan, and click a link with the currently used plan's name. 

3. Click Upgrade. 

If there is no Upgrade link, then it means that you cannot upgrade to another hosting plan 
from your Control Panel, and you need to contact your provider. 

4. Do any of the following: 

Á To add resources to your subscription without upgrading to another plan, select the 
options you would like to add and click Adjust Add-ons. 

Á To upgrade to another service plan, click Order Upgrade. 

ü To reduce the amounts of resources or downgrade to another service plan: 

1. Click the Account tab. 

2. In the list of subscriptions, locate the subscription that you want to 
downgrade to another service plan, and click a link with the currently used 
plan's name. 

3. Click Downgrade. 

If there is no Downgrade link, then it means that you cannot downgrade to another hosting 
plan from your Control Panel, and you need to contact your provider. 

4. Do any of the following: 

Á To reduce the amounts of allocated resources without downgrading to another plan, 
select the options you would like to reduce and click Adjust Add-ons. 

Á To downgrade to another service plan, click Order Downgrade. 
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ü To subscribe to a hosting plan in addition to your main plan: 

1. Go to the Account tab and click the Add Subscription link. 

2. Select the hosting plan to which you want to subscribe, and click Buy Now. 
Follow the instructions on the screen to complete the order. 
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Viewing Statistics 

ü To view the reports on disk space and traffic usage by your account: 

1. If you have several subscriptions associated with your account, in the 
Subscription menu at the top of the screen, select the required subscription.     

2. Click the Statistics tab. 

The following information is presented in charts: 

Á Disk space used by the following files and directories in the subscription: 

Á Websites 

Á Mail accounts 

Á Databases 

Á Logs 

Á Backups 

Á Chroot directories 

Á Configuration files 

Á Anonymous FTP directory 

Á Traffic used by FTP, web, and mail services during the current month. 

FTP field shows the information about the total size of files transferred to and from the 
webspace over the file transfer protocol. 

HTTP field shows the information about the total amount of data transferred from all of 
your websites over HTTP protocol, that is, retrieved by web browsers. 

POP3/IMAP field shows the total amount of data received by all mail accounts under 
your domains. 

SMTP field shows the total amount of data sent by all mail accounts under your 
domains. 

3. Do any of the following: 

Á To view a report on the amount of data transferred to and from your sites over FTP, 
click FTP Statistics. 

Á To view a report on the amount of data transferred to and from your FTP directory, 
which is accessed without authorization, click Anonymous FTP statistics. 

Á To view a report on the amount of traffic used by services during a certain month, click 
Data Transfer Statistics, and select the required month from the menu. 

 

Next in this section: 

Log Files ........................................................................................................... 100 
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Log Files 

All connections to the web server and requests for files that were not found on the server are 
registered in log files. These log files are analyzed by the statistics programs running on the 
server, which then present graphical reports on demand. You may want to download these 
log files to your computer for processing by third-party statistics programs, or view their 
contents for web server debugging purposes. 

ü To prevent these log files from growing too large, you should enable automatic 
cleanup and recycling of log files: 

1. If you are subscribed to several hosting packages and have access to 
several webspaces associated with your account, in the Subscription menu at 

the top of the screen, select the required webspace.     

2. Go to the Websites & Domains tab > Logs > Log Rotation. 

3. Click Switch On. If you see only the Switch Off button there, this means that log 
recycling is already switched on. 

4. Specify when to recycle log files and how many copies of each log file to 
store on the server. Also specify whether they should be compressed and 
sent to an e-mail address after processing. 

5. Click OK. 

ü To view the contents of a log file or download it to your computer: 

1. If you are subscribed to several hosting packages and have access to 
several webspaces associated with your account, in the Subscription menu at 
the top of the screen, select the required webspace.     

2. Go to the Websites & Domains tab > Logs. A list of log files opens. 

3. Do any of the following: 

Á To view all entries in a log file, click the log file name. If you want to view only a few 
last lines from the log file, type the number of lines into the input box under the Settings 
group, and then click the log file name. 

Á To download a file to your computer, click the corresponding icon .  

Á To remove a processed log file from the server, select the corresponding checkbox 
and click Remove. Confirm removal and click OK. 

ü To download log files to your computer via FTP: 

1. Connect to the Panel server via FTP. 

2. Go to the /var/www/vhosts/<domain_name>/logs  directory and copy 

the log files to you computer. 
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(Advanced) Managing Auxiliary User Accounts 

If you want to allow other users to access the Panel for managing websites and installed 
applications, or to use e-mail services under your domains, then you need to create user 
accounts for them. 

Auxiliary Users and User Roles 

Auxiliary user accounts are created based on user roles. The roles include privileges to 
access certain areas of the Panel and perform operations in the Panel. There are several 
predefined user roles, namely: Accountant, Application User, Owner, and Webmaster. You 
can review and modify the Accountant, Application User, and Webmaster roles to suit your 
needs, or you can create your own custom roles. For more information on user roles and 
user account creation, refer to the sections User Roles (on page 102) and Auxiliary User 
Accounts (on page 104) correspondingly. 

After auxiliary user accounts are created, the users will be able to log in to their accounts in 
Panel and use shortcuts in their Panels to access their mailboxes and work with applications. 
In addition, you can extend the list of links available to your auxiliary users with your custom 
links. These can be links to corporate resources, sites on the web, and so on. Learn more in 
Custom Links (on page 106).  

Auxiliary Users and Multiple Subscriptions 

Since Panel 10.4, if your customer account includes more than one subscription, you can 
allow auxiliary users to access only a specified subscription. If the Access to subscriptions 
property of a user account is set to a certain subscription, the user will always log in to this 
subscription and will not be able to switch to other subscriptions. 

Next in this section: 

User Roles ........................................................................................................ 102 
Auxiliary User Accounts ..................................................................................... 104 
Custom Links .................................................................................................... 106 
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User Roles 

ü To create a user role: 

1. Go to the Users tab > User Roles tab > Create User Role. 

2. Specify the following: 

Á User role name. 

Á Access to Panel services. Grant the required permissions for operations to the user: 

Á Manage users and roles. Add, modify, and remove user accounts and roles. Note that 
even if this permission is not granted to a user, the user will be able to browse 
contact information of other users after logging in to the Panel. 

Á Create and manage sites. Set up, modify, remove domain names and subdomains, 
host websites and change web hosting settings. 

Á Configure log rotation. Manage settings for recycling of web server access and error 
log files. View, download, and remove log files. 

Á Configure anonymous FTP service. Set up a directory accessible to all Internet users 
over FTP without authorization. 

Á Create and manage scheduled tasks. Schedule execution of scripts or programs on 
your customer account. 

Á Configure spam filter. Set up spam protection for mailboxes. 

Á Configure antivirus. Set up virus protection for mailboxes. 

Á Create and manage databases. Add, modify, and remove databases stored on your 
customer account. 

Á Configure and perform data backup and restoration. Back up and restore data related to 
your customer account, websites, and mailboxes under your domains. 

Á View statistics. View reports on disk space and traffic usage by your websites, and 
website visits. 

Á Install and manage applications. Install applications on websites and manage them. 

Á Design sites in Presence Builder. Create websites using Presence Builder. 

Á Upload and manage files. Manage files and directories located in the webspace by 
using the Panel's file manager. 

Á Create and manage additional FTP accounts. Set up additional FTP accounts for other 
users. 

Á Manage DNS settings. Manage DNS settings for domains. 

Á Install and manage Java applications. Install on websites third-party Java applications.  

Á Create and manage mail accounts. Create, modify, and remove e-mail accounts. 

Á Create and manage mailing lists. Create, modify, and remove mailing lists. 

Á Access to apps. Select the applications that the user should be able to access and use. 
All web applications installed on the server are listed in this area. 

For more information about installing applications and providing access to users, refer 
to the section Granting Auxiliary Users Access to Apps (on page 154). 
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Á Access to the billing operations. Grant these permissions if you want users of this role to 
view and pay invoices for your subscriptions. 

3. Click OK. 

ü To modify user role properties: 

1. Go to the Users tab > User Roles tab. 

2. Click a link with the role name that you want to change. 

3. Change the role properties as required and click OK.  

ü To remove a user role: 

1. Go to the Users tab > User Roles tab. 

2. Select a checkbox corresponding to the role you want to remove and click 
Remove. Note that it is impossible to remove the Owner role and other roles 
that are assigned to one or more users. 

3. Click Yes to confirm the removal. 
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Auxiliary User Accounts 

ü To create a user account: 

1. Go to the Users tab > Create User Account. 

2. Specify the following: 

Á Contact name. 

Á E-mail address. The e-mail address will be used as a user name for logging in to Panel, 
unless you specify another name in the Username box. 

Á To create a new e-mail address for the user, select the option Create an e-mail 
address under your account,    

type the desired left part of the address which goes before the @ sign, and, if you 
have a number of domains on your account,  select the domain name under which 
the e-mail address should be created. 

Á To associate with this user account an external e-mail address, select the option 
Use an external e-mail address, and specify an existing external e-mail address. 

Á User role. Select the required user role from the menu. 

Á Access to subscriptions. Allow a user to access only a specified subscription. The All 
value grants them access to all subscriptions within your customer account. 

Á Username. The user name for access to Panel. 

Á Password. The password for access to Panel. 

3. Leave the User is active checkbox selected. Otherwise, the user will not be 
able to access the Panel and use applications on your customer account.  

4. Click OK. 

5. Now, if you want to add contact information for the user, click a link with the 
user's name, and then click the Contact Details tab, and specify the user's 
contact information. 

6. Click OK. 

Now you can notify the user about creation of his or her account and ability to access Panel. 
Provide the user with the address to open in his or her browser, the username (which is the 
user's e-mail address), and the password that you specified in the account settings. 

ü To change user account properties: 

1. Click the Users tab. 

2. Click a link with the user's name. 

3. Make the required changes and click OK. 
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ü To suspend or activate a user account: 

1. Click the Users tab. 

2. Click a link with the user's name. 

3. Do any of the following: 

Á To suspend a user account, clear the User is active checkbox. The user will no longer 
be able to log in to the Panel and access applications. 

Á To activate a user account, select the User is active checkbox. 

4. Click OK. 

ü To remove a user account: 

1. Click the Users tab. 

2. Select a checkbox corresponding to the user account you want to remove, 
and click Remove. Note that you cannot remove your own account. 

3. Click Yes to confirm the removal. 
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Custom Links 

You can add custom hyperlinks to the Panel and make them visible for your users. The links 
may lead to web resources, such as your corporate site, or to a web application that can 
process online requests and accept additional information about the users who click these 
links. 

You can specify what information about users should be passed: 

Á Subscription ID. 

Á Primary domain name associated with a subscription. 

Á FTP account username and password. 

Á Customer's account ID, name, e-mail, and company name. 

You can place the links in the following locations of the Control Panel, and decide who 
should be able to see them: 

Á On the Websites & Domains page in the Control Panel, visible only to you. This is achieved 
by selecting the Customer's Home page option in the link properties. 

Á On the Websites & Domains page in the Control Panel, visible to you and your users who 
are allowed to log in to the Control Panel. This is achieved by selecting the Common 
access option in the link properties. 

Á On the Websites & Domains tab in the Control Panel, visible to you and your users who are 
allowed to log in to the Control Panel. This is achieved by selecting the Websites & Domains 
page of Subscription option in the link properties. 

ü To add a custom hyperlink to the Control Panel: 

1. Go to the Account tab > Additional Services, and click Add Link to Service. 

2. Specify the following settings: 

Á Type the text that will show on your button in the Button label box. 

Á Choose the location for your button. 

Á Specify the priority of the button. Your custom buttons will be arranged in the Panel in 
accordance with the priority you define: the lower the number, the higher the priority. 
Buttons are placed in the left-to-right order. 

Á To use an image for a button background, type the path to its location or click Browse 
to browse for the desired file. It is recommended that you use a 16x16 pixels GIF or 
JPEG image for a button to be placed in the navigation pane, and 32x32 pixels GIF or 
JPEG image for buttons placed in the main frame or desktop. 

Á Type the hyperlink of your choice to be attached to the button into the URL box. 

Á Using the checkboxes, specify whether you want the customer information and other 
data to be transferred within the URL. These data can be used for processing by 
external web applications. 

Á In the Tooltip text input field, type in the help tip that will be displayed when the users 
place the mouse pointer over the button. 



 

 Website Management 107  

Á Select the Open URL in Parallels Panel checkbox if you want the destination URL to be 
opened in the main frame of the Panel, otherwise, leave this checkbox cleared to 
open the URL in a separate browser window or tab. 

Á If you want to make this button visible only to you, select the Show to me only checkbox. 

3. Click Finish to complete creation. 

ü To remove a hyperlink button from the Panel: 

1. Go to the Account tab > Additional Services. 

2. Select a checkbox corresponding to the link that you want to remove and 
click Remove. 
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Websites and Domains 

As described in the chapter Quick Start with Parallels Panel, creating your web presence always 
starts with purchasing a domain name. The domain name (or simply, domain) is the name 

people use to access your site from their browsers, for example, www.example.com . The 

domain registration is carried out by authorized companies - domain name registrars. 
Hosting providers often carry out this function. For detailed information about how to manage 
domains in Panel, refer to the section Domains and DNS (on page 109). 

However, a domain is not a website. To make it accessible from the web and fill it with 
content, you should subscribe to hosting services (obtain a customer account). That is to 
supplement your domain with Internet connectivity, some disk space to store your content, 
mail services, and so on. Thus, a website is a domain with provided hosting services.  

Panel provides a full range of operations in regard to domains and websites: 

Á Adding and removing domains, subdomains, and aliases. 

Á Managing the content of your websites. 

Á Installing various web apps. 

Á Securing connections to your websites and much more. 

This chapter provides detailed information on all the possible operations on websites and 
domains in Panel. Note that some of these operations may be unavailable according to your 
hosting plan. 

Next in this section: 

Domains and DNS ............................................................................................. 109 
Hosting Settings ................................................................................................ 125 
Website Content ................................................................................................ 143 
(Advanced) Restricting Access to Content......................................................... 148 
Previewing Websites ......................................................................................... 150 
Web Applications ............................................................................................... 151 
(Advanced) Website Security ............................................................................ 160 
(Advanced) Extended Website Management ..................................................... 166 
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Domains and DNS 

As described above, a domain name is the name that people type in their browsers to access 
your website.  

A domain name is hierarchical and can consist of a number of parts called labels: 

Á The label furthest to the right is called the top-level domain. For example, com is the top-

level domain of www.example.com . The number of top-level domains is limited and all of 

them are managed by separate international authorities. 

Á The second-level domain is the label that we mainly use to imply the purpose of our 

website. In www.example .com  it is the example part. The combination of the second-

level and top-level domain names specifies the exact location of your website. 

Á Each label to the left is a subdomain of the domain to the right. For example, www is the 

subdomain of example.com . Subdomains can be convenient when you want to isolate 

some content from the main site, e.g. you can organize your personal blog on 

myblog.example.com . For information on how to add subdomains in Panel, refer to the 

section Adding Subdomains (on page 112). 

If you want to host more than one website under your subscription, you can register more 
domains and add them to your subscription. Registering new domains may be available to 
you in the Control Panel if your hosting provider allows this. For information on how to 
purchase and add domains in Panel, refer to the section Adding Domains (on page 110). 

In fact, domain names exist only for convenience; the real communication between browser 
and web servers uses IP addresses - the numerical host identifiers. For example, the real 

address of www.example.com  may be 192.0.2.12 (IPv4). To resolve domain names into IP 

addresses, web hosts use DNS technology. For more details about how DNS is implemented 
in Panel, refer to the section (Advanced) Configuring DNS for a Domain (on page 116).   

DNS allows several domains to be resolved into one IP address. Such additional names are 
called domain aliases. This is convenient when you have purchased several domains that 
you want to point to the same website. For information on how to add aliases to existing 
domains, refer to the section Adding Domain Aliases (on page 114).  

Next in this section: 

Adding Domains ................................................................................................ 110 
Adding Subdomains .......................................................................................... 112 
Adding Domain Aliases ..................................................................................... 114 
Adding Wildcard Subdomains (Linux) ................................................................ 115 
(Advanced) Configuring DNS for a Domain ....................................................... 116 
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Adding Domains 

If your hosting package includes more than one domain name (website), then you can easily 
add new domains to the server. Before you start adding a new domain that will use a 
second-level domain name, like example.com, be sure to register this domain name. If your 
hosting provider provides the domain name registration service, you can do this from the 
Control Panel as described below. Otherwise, you should register your domain name with 
another domain name registration authority. 

You can set up the following types of site configurations through Panel: 

Á Website addressed by a second-level domain name. The following services are available for 
websites: 

Á A unique Internet address (domain name), like example.com. 

Á Additional domain names (domain aliases). 

Á Subdomains - divisions of a site accessible by easy-to-remember addresses that are 
added to the main site, like mail.example.com. 

Á Separate FTP accounts for collaboration on the site content. For every FTP account, 
you can specify which directories can be accessed. 

Á Creating content using Presence Builder. 

Á Simplified deployment of applications, such as content management systems, photo 
galleries, shopping carts, blogging platforms, and many more.  

Á Secure data exchange implemented by SSL protocol. This requires that a site be 
hosted on a dedicated IP address, which is not shared among other users and sites. 

Á Mailboxes and mailing lists. 

Á Viewing statistics on site visits. 

Á Website or a division of a website addressed by a third-level domain name (subdomain). This is 
usually a division of an existing site. It has an Internet address comprising of three parts 
separated by dots. The following services are available for subdomains: 

Á Separate document root from the main site. Document root is a directory on the server 
where web pages of a site are stored. 

Á Access over FTP for content management. 

Á Creating content using Presence Builder. 

Á Simplified deployment of applications. 

Á Secure data exchange implemented by SSL protocol.  

Á Viewing statistics on site visits. 
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Adding More Domains 

ü To host a new website with a second-level domain name: 

1. If you are subscribed to several hosting packages and have access to 
several webspaces associated with your account, select the required 
webspace in the Subscription menu at the top of the screen.    

2. Click the Websites & Domains tab, click Add New Domain and follow on-screen 
instructions. 

Note : If you select the recommended option, you should connect the DNS settings 
related and your domain name with the domain name at the registrar's side. To achieve 
this, enter the Panel name server IP address into the respective NS record of the 
registrar. The instruction on how to obtain the IP is as follows: go to Websites & Domains > 
<domain name> > DNS Settings, find the NS record, and then find the A record 
corresponding to the NS record value. 
For example, if your NS record is 
example.com. NS ns.example.com, 
find the A record with ns.example.com, for example,  
ns.example.com. A 192.0.2.12 

The resulting value, 192.0.2.12, is the Panel name server IP you need. 

3. Click OK. 

The new domain name is now shown in the list at the bottom of the screen. 

4. If the operation of changing hosting settings is available for your account, 
then you can click the domain name of the new website to view or change 
the hosting settings, as described in the section Changing Hosting Settings (on 
page 125). 

You can now start creating your website with Presence Builder or upload your web content to 
the webspace of the new website, as described in the section Managing Website Content (on 
page 143). 

Registering Domains 

If your service provider offers the domain name registration service as well as web hosting, 
you can initiate a domain registration directly from Panel. To register a domain name, add it 
as described above and then click the link register it now beside the new domain name on the 
Websites & Domains tab. This will redirect you to the provider's online store where you can 
complete the registration. 

After you register a domain name, it appears in the Registered domain names list on the 
Websites & Domains tab. To get information about a domain name registration, for example, 
the registration price and next renewal date, click the domain name in this list. 
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Removing Domains 

When you delete a domain from Panel, all data related to the corresponding site are deleted 
from the server. The first domain name (default domain) that was created for your account 
cannot be deleted; however, it can be renamed.  

ü To remove a domain: 

1. If you are subscribed to several hosting packages and have access to 
several webspaces associated with your account, select the required 
webspace in the Subscription menu at the top of the screen.    

2. Go to the Websites & Domains tab and click the name of the domain or 

subdomain you want to remove. 

3. Click Remove Website or Remove Subdomain. 

4. Confirm removal and click OK. 

Note: Removing domain names from the Control Panel does not cancel the registration of 
these names. If you registered these domains name, you still can use them for your 
websites. 

Adding Subdomains 

If your hosting package includes subdomains, which are additional third-level domain names, 
then you can use them to: 

Á Organize logically the structure of your site. 

Á Host additional websites or parts of a website on the same server without the need to pay 
for registration of additional domain names. 

An example of using subdomains: 

You have a website your-product.com dedicated to promoting and selling your product. For 
publishing information related to customer service and online order tracking, you can 
organize the subdomain "orders" so that your users will be able to access this information 
directly by visiting the Internet address "orders.your-product.com".  

As subdomains have the same status with the additional domains, you can use the same set 
of tools and services for working with subdomains. For example, SSL protection, Presence 
Builder, web statistics, and so on. 

ü To set up a subdomain for a site division or a separate site: 

1. If you are subscribed to several hosting packages and have access to 
several webspaces associated with your account, select the required 
webspace in the Subscription menu at the top of the screen.    

2. Click the Websites & Domains tab. 

3. Click Add New Subdomain. 
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4. Specify the following: 

a. In the Subdomain name box, type the portion of address that will be 
added to the domain name of your main site. 

b. In the Document root box, type the desired location of the directory 
where all files and subdirectories of this site will be kept. You can 
use the default directory of the main site, called httpdocs, or specify 
another directory. 

5. Click OK. 

The new subdomain name is now shown in the list at the bottom of the screen. 

You can now upload your web content to the subdomains webspace (directory on the 
server), as described in the section Uploading Content over FTP. 

Wildcard Subdomains 

If you enter the asterisk (*) symbol as a subdomain name, Panel will create a so-called 
wildcard subdomain.When site visitors enter any subdomain name that is not registered in 
Panel, they will be redirected to this wildcard subdomain. You can create wildcard 
subdomains on any domain name level. For example, you can create the 
*.mystore.example.com subdomain. Learn more about wildcard subdomains in the section 
Adding Wildcard Subdomains (Linux) (on page 115). 
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Adding Domain Aliases 

Domain aliases allow you to point several domain names to the same website. This can be 
useful, for example, for branding purposes.  

ü To set up a domain alias in Panel: 

1. Run the Add New Domain Alias wizard in the Websites & Domains tab. 

2. Specify the domain for which you are creating an alias (the primary domain) 

and the aliasôs domain name, for example alias. tld , and set up the 

following: 

Á Synchronization of DNS zone with the primary domain 

If this option is enabled, the DNS zone of the domain alias will be in sync with the zone of 
the primary domain. Any changes made in the DNS zone of the primary domain will be 
automatically applied to the DNS zone of the alias.  For example, if you create the 

CNAME record like blog.primary_domain.tld , the corresponding 

blog.alias.tld  record will be added to the zone of the alias. 

Note: If a domain aliasôs DNS zone is synced with the primary domain, you cannot modify 

resource records in the alias's DNS zone. 

Á Mail service 

Panel does not allow creating mailboxes under domain aliases. Instead, the mailboxes of 
the primary domain are used. If you select the Mail service option, the mailboxes created 
under the primary domain will also be available under the alias. To enable users to read 
mail sent to mailboxes under the alias, Panel redirects it to the corresponding mailboxes 
under the primary domain. 

For example:  

You have an email address mail@domain.tld . Then you set up an alias for 

domain.tld , for example, alias.tld . If you select the Mail service option, all mail sent 

to mail@alias.tld  will be available at mail@domain.tld . Otherwise, the mailbox 

mail@domain.tld  will not receive mail sent to mail@alias.tld . 

Á Web service 

If this option is turned on, the website will open in the browser at the aliasôs URL. If you 
clear the Web service check box, the alias will be used for mail only provided that Mail 
service is selected. 

Á Redirect with the HTTP 301 code 

By default, Panel uses web server internal redirection for aliases. In this case, the alias 
appears to be a separate website for visitors and for web search engines. This causes 
the problem because search engines index the content of the alias separately, so your 
primary domain loses search engine rankings. 

To avoid this, you can use redirection with the HTTP 301 code (Moved permanently) by 
selecting Redirect with the HTTP 301 code. In this case, only the primary domain will rank in 
search engines. Learn more at 
http://support.google.com/webmasters/bin/answer.py?hl=en&answer=93633 

 

 

http://support.google.com/webmasters/bin/answer.py?hl=en&answer=93633
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Á Java web applications 

If you use hosting services based on a Linux platform, and you have Java applications 
installed on your site that you want to make accessible through the domain alias, select 
the Java web applications option. 

 

Adding Wildcard Subdomains (Linux) 

Use wildcard subdomains to redirect visitors from non-existent subdomains to one of your 
websites, commonly, to your main website. The typical use cases of this feature are: 

Á Improve website organization and run marketing campaigns. 

For example, you do not have the vps-limited-offer subdomain but wish to forward users 
from limited-vps-offer.example.com to example.com. 

Á Help users reach your website even if they mistyped a subdomain name. 

It is a widespread mistake to mistype a website name if it has the leading www prefix (for 
example, typing ww.example.com). 

Á Finally, some website applications (WordPress) use wildcard subdomains to create 
dynamic subdomains for convenience and better user experience. 

Note : Traffic to existent subdomains will not be affected in any way if you add a wildcard 
subdomain. 

How to Add Wildcard Subdomains 

You can add one wildcard subdomain per each of domain names under a subscription. For 
this, go to the Websites & Domains tab and add a new subdomain which name is "*" to one of 
your domain names. Example: *.example.com. If you wish this subdomain to have a custom 
set of scripts or website content, specify a custom document root for this subdomain. 

Limitations of Wildcard Subdomains 

Wildcard subdomains act like typical subdomains with the following exceptions: 

Á Linux-only feature. Currently, wildcard subdomains are supported only on Panel for 
Linux. 

Á Renaming is not available. It is not possible to rename such subdomains. 

Á No DNS zone. This type of subdomains does not have own zone record in the Panel's 
DNS server. Instead, they have the A record that points to the IP address associated with 
a corresponding domain name. 

Á Installation of APS apps is not allowed. Panel users are unable to install APS apps to 
wildcard subdomains. 

Á No Presence Builder sites. Panel users are unable to edit and publish sites to these 
subdomains. 
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(Advanced) Configuring DNS for a Domain 

The Domain Name System (DNS) is a hierarchical naming system that translates 
understandable domain names into the numerical identifiers (IP addresses) associated with 
web hosts. Such translation is called resolving. When you add a domain name (using 
Websites & Domains > Add New Domain), you should choose the role of Panel in resolving your 
resources: It can directly process all translation requests, be a backup server, or pass the 
translation requests to a remote server. This role can be changed for existing domain names 
(Websites & Domains > domain name > DNS Settings). We discuss details about each of the 
roles and provide instructions how to assign them next in this section. 

Note: If your Panel does not use its own DNS service and does not allow configuring DNS 
settings on a remote DNS server, you can only view the information about your registered 
domain name. The link DNS Settings in Websites & Domains will be replaced with Whois 
Information. 

DNS Name Resolving 

DNS is based on a hierarchical tree structure called the domain namespace. This global 
namespace contains all possible domain names and is divided into logical parts - domain 
zones (see the picture below). A domain zone is a part of the namespace that contains the 
addresses of particular domains. Addresses are stored in a file on a separate name server 
with authority for that zone. For example, when a browser tries to access 

www.example.com , it gets the site's IP address from a server with authority for the 

example.com  zone. For more information about how DNS works, refer to the respective 

documentation. You can find it in numerous sources on the Internet, for example, Microsoft 
TechNet. 
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When you purchase a domain, a registrar gives you access to the settings for the DNS zone 
responsible for your domain and its subdomains. You can either allow the registrar to 
manage the zone, or delegate the zone to Panel. The latter option gives you the ability to 
manage a zone directly from your customer account. For information about how to delegate 
your zone to the Panel, refer to the section Panel as a Master DNS Server (on page 118). 

If you are an advanced user and already have a DNS server that you want to give authority 
for your zone, you can set up Panel to be a slave (also called secondary) DNS server. In this 
case, Panel just stores a copy of your zone and you do not have the option to manage it from 
the Control Panel. The Panel DNS server will be used only if your primary name server 
becomes inaccessible or inoperable. For information about how to make Panel act as a 
secondary DNS server, refer to the section Panel as a Slave DNS Server (on page 122). 

If you decide not to use Panel as a DNS server, all zone management should be performed 
on a domain registrar's site. Some registrars provide support for remote DNS zone 
management. If your hosting provider uses this feature, you will still be able to modify the 
DNS zone from the Control Panel regardless of where your authoritative name server is 
located. For information about how to switch off the Panel's DNS server and manage your 
zone remotely, refer to the section Registrar's DNS Settings in Panel (on page 122). 

Next in this section: 

Panel as a Master DNS Server .......................................................................... 118 
Panel as a Slave DNS Server............................................................................ 122 
Registrar's DNS Settings in Panel ..................................................................... 122 
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Panel as a Master DNS Server 

For each new domain name, the Panel automatically creates a DNS zone in accordance with 
the settings configured by your service provider. The domain names should work fine with 
the automatic configuration, however, if you need to perform custom modifications in the 
domain name zone, you can do that through your Panel. 

ü To view the resource records in a DNS zone of a domain: 

1. Go to the Websites & Domains tab and click the domain name whose DNS 
settings you want to view. 

2. Click DNS Settings. 

ü To add a new resource record to the zone: 

1. Go to the Websites & Domains tab and click the domain name whose DNS 
settings you want to manage..  

2. Click DNS Settings. 

3. Click Add Record. 

4. Select a resource record type, and specify the appropriate data: 

Á For an NS record, which specifies the domain name of a name server that is 
responsible for a DNS zone of a domain, you need to specify the domain name (or a 
subdomain), and then the corresponding name server's domain name. If you are 
defining an NS record for your main domain, then you should leave the domain name 
field empty. If you are defining a name server for a subdomain, then type the 
subdomain into the domain name field. After that, type the appropriate name server's 
domain name into the name server field. For example: ns1.mynameserver.com. 

Á For A and AAAA records, which associate IP addresses with domain names, you 
need to specify the domain name and IP address. If you are simply defining a record 
for your main domain, then you should leave the domain name field empty. If you are 
defining a record for a name server, then type ns1 or ns2 into the domain name field. 
Then specify the appropriate IP address with which to associate the domain name. 

Á For a CNAME record, which specifies which subdomains (or domain aliases that look 
like subdomains, for example, www) should be associated in the Domain Name 
System with the main domain address, you need to type the subdomain name or www 
alias, and then, the main domain name. 

Á For an MX record, which specifies the host name of the preferred mail server for the 
given domain, you need to specify the mail domain (or subdomain), the domain name 
of the mail exchange server responsible for receiving e-mail, and the server's priority. 
For the main domain, you would simply leave the available field blank. Then type the 
domain name of your mail server. If you are running a remote mail server named 
'mail.myhostname.com', then simply type 'mail.myhostname.com' into the Mail 
exchange server field. After that, specify its priority: 0 is the highest and 50 is the lowest. 

Á For a PTR record, which is required for reverse DNS lookup (an IP address is 
translated to domain name), you need to enter the IP address/mask, and then type 
the appropriate domain name for this IP address to be translated to. 
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Á For a TXT record, which is used for specifying arbitrary human-readable text, you can 
type an arbitrary text string, or an SPF record. 

Á For an SRV record, which is used for specifying location of services other than mail, 
you will need to enter the service name, protocol name, port number, and target host. 
You can also specify the priority of the target host, and relative weight (for records 
with the same priority) in the appropriate fields.  

   4. Click OK, and then click Update. 

ü To modify the properties of a resource record: 

1. Go to the Websites & Domains tab and click the domain name whose DNS 
settings you want to manage. 

2. Click DNS Settings. 

3. Click the hyperlink in the Host column corresponding to the resource record 
you want to modify. 

4. Modify the record as required, click OK, and then click Update. 

In addition to the resource records described above, there is also a Start of Authority record. 
This record indicates that this DNS name server is responsible for the domain's DNS zone. It 
also contains settings that affect propagation of information about the DNS zone in the 
Domain Name System. 

ü To modify the entries in the Start of Authority (SOA) record for a domain: 

1. Go to the Websites & Domains tab and click the domain name whose DNS 
settings you want to manage. 

2. Click DNS Settings. 

3. Click SOA Record. 

4. Specify the required values: 

Á Refresh interval. This is how often the secondary name servers check with the master 
name server to see if any changes have been made to the domain's zone file. The 
Panel sets the default value of three hours. 

Á Retry interval. This is the time a secondary server waits before retrying a failed zone 
transfer. This time is typically less than the refresh interval. The Panel sets the default 
value of one hour. 

Á Expire interval. This is the time before a secondary server stops responding to queries, 
after a lapsed refresh interval where the zone was not refreshed or updated. The 
Panel sets the default value of one week. 

Á Minimum TTL. This is the time a secondary server should cache a negative response. 
The Panel sets the default value of three hours. 

Á Default TTL. This is the amount of time that other DNS servers should store the record 
in a cache. The Panel sets the default value of one day. 

5. Click OK, and then click Update. 



 

120 Website Management 

 

Usage of serial number format recommended by IETF and RIPE is mandatory for many 
domains registered in some high-level DNS zones, mostly European ones. If your domain is 
registered in one of these zones and your registrar refuses your SOA serial number, using 
serial number format recommended by IETF and RIPE should resolve this issue. 

The Panel-managed servers use UNIX timestamp syntax for configuring DNS zones. UNIX 
timestamp is the number of seconds since January 1, 1970 (Unix Epoch). The 32-bit 
timestamp will overflow by July 8, 2038. 

RIPE recommends using YYYYMMDDNN format, where YYYY is year (four digits), MM is 
month (two digits), DD is day of month (two digits) and NN is version per day (two digits). 
The YYYYMMDDNN format will not overflow until the year 4294. 

ü To change the Start of Authority (SOA) serial number format to YYYYMMDDNN 
for a domain: 

1. Go to the Websites & Domains tab and click the domain name whose DNS 
settings you want to manage. 

2. Click DNS Settings. 

3. Click SOA Record. 

4. Select the Use serial number format recommended by IETF and RIPE checkbox. 

Note:  See the sample of SOA serial number generated with the selected format. If the 
resulting number is less than the current zone number, the modification may cause 
temporary malfunction of DNS for this domain. Zone updates may be invisible to the 
Internet users for some time. 

5. Click OK, and then click Update.  

ü To remove a resource record from the zone: 

1. Go to the Websites & Domains tab and click the domain name whose DNS 
settings you want to manage. 

2. Click DNS Settings. 

3. Select a checkbox corresponding to the record you want to remove. 

4. Click Remove. 

5. Confirm removal, click OK, and then click Update. 

ü To restore the original zone configuration in accordance with the default DNS 
template settings used on the server: 

1. Go to the Websites & Domains tab and click the domain name whose DNS 
settings you want to manage. 

2. Click DNS Settings. 

3. Click Restore Defaults. 
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4. In the IP address menu, select the IP address to be used for restoring the 
zone. 

5. Specify whether a www alias is required for the domain. 

6. Select the Confirm the restoration of the DNS zone checkbox, and click OK. 

ü To restore the default Start of Authority (SOA) serial number format (UNIX 
timestamp) for a domain: 

1. Go to the Websites & Domains tab and click the domain name whose DNS 
settings you want to manage. 

2. Click DNS Settings. 

3. Click SOA Record. 

4. Clear the Use serial number format recommended by IETF and RIPE 
checkbox. 

Note:  See the sample of SOA serial number generated with the selected format. If the 
resulting number is less than the current zone number, the modification may cause 
temporary malfunction of DNS for this domain. Zone updates may be invisible to the 
Internet users for some time. 

5. Click OK, and then click Update. 

By default, transfer of DNS zones is allowed only for the name servers designated by NS 
records contained within each zone. If you are using a Windows-based account, then you 
can change zone transfer settings. 

ü If your domain name registrar requires that you allow transfer for all zones you 
serve: 

1. Go to the Websites & Domains tab and click the domain name whose DNS 
settings you want to manage. 

2. Click DNS Settings. 

3. Click Zone Transfers. A screen will show all hosts to which DNS zone transfers 
for all zones are allowed. 

4. Specify the registrar's IP or network address and click Add Network. 
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Panel as a Slave DNS Server 

If you host websites on your account and have a standalone DNS server acting as a primary 
(master) name server for your sites, you may want to set up the Panel's DNS server to 
function as a secondary (slave) name server. 

ü To make the Panel's DNS server act as a secondary name server: 

1. Go to the Websites & Domains tab and click the domain name whose DNS 
settings you want to manage. 

2. Click DNS Settings. 

3. Click Switch DNS Service Mode. 

4. Click Add Record. 

5. Specify the IP address of the primary (master) DNS server. 

6. Click OK, and then click Update. 

7. Repeat steps from 2 to 6 for each website that needs to have a secondary 
name server on your server. 

ü To make the Panel's DNS server act as a primary back: 

1. Go to the Websites & Domains tab and click the domain name whose DNS 
settings you want to manage. 

2. Click DNS Settings. 

3. Click Switch DNS Service Mode. 

The original resource records for the zone will be restored. 

Registrar's DNS Settings in Panel 

If you have external primary and secondary name servers that are authoritative for some of 
your websites, switch off the Panel's DNS service for each of these sites. 

ü To switch off the Panel's DNS service for a site served by external name 
servers: 

1. Go to the Websites & Domains tab and click the domain name whose DNS 
settings you want to manage. 

2. Click DNS Settings. 

3. Click Switch Off the DNS Service. 
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Turning the DNS service off for the zone will refresh the screen, so that only a list of 
name servers remains. Note that the listed name server records have no effect on the 
system. They are only presented on the screen as clickable links to give you a chance to 
validate the configuration of the zone maintained on the external authoritative name 
servers. 

4. If you want to validate the configuration of a zone maintained on 
authoritative name servers, do the following: 

a. Add to the list the entries pointing to the appropriate name servers 
that are authoritative for the zone: Click Add Record,  specify a name 
server, click OK, and then click Update. 

b. Repeat the step a for each name server you would like to test. The 
records will appear in the list. 

c. Click the records that you have just created. 

The Panel will retrieve the zone file from remote name servers and will check the resource 
records to make sure that domain's resources are properly resolved. The results will be 
interpreted and displayed on the screen. 

If your Control Panel is integrated with a billing system, then the following operations on 
domains might be available from the Panel: 

Á Setting a password for access to domain management panel at a registrar's site. 

Á Locking and unlocking domain name for transferring to another provider. 

Á Changing domain registrant and other contact information. 

Á Changing DNS settings for domain zones served by a domain registrar. 

Á Configure automatic renewal of the domain account at the domain name registration 
company. 

ü To set a new password for access to your domain management control panel at 
a registrar's site: 

1. Go to the Account tab. 

2. Locate the domain name for which you want to change settings, and click the 
link Show Domain Info next to it. 

3. Click Change Domain Password. 

4. Type a new password and click OK. 

ü To lock or unlock domain name for transferring to another provider: 

1. Go to the Account tab. 

2. Locate the domain name for which you want to change settings, and click the 
link Show Domain Info next to it. 

3. Click Change Registrar Lock Setting. 

4. To allow domain name transfer, clear the Lock checkbox and click OK. 
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ü To change domain owner's contact, technical, administrative, or billing 
information: 

1. Go to the Account tab. 

2. Locate the domain name for which you want to change settings, and click the 
link Show Domain Info next to it. 

3. Click Edit Contact Info. 

4. Make the necessary changes and click OK. 

ü To change DNS settings for a domain: 

1. Go to the Account tab. 

2. Locate the domain name for which you want to change settings, and click the 
link Show Domain Info next to it. 

3. Click Edit DNS Settings. 

4. Specify the domain name servers that serve the DNS zone for your website 
and IP address of the server where the website is hosted. 

5. If the DNS zone of your website is served by your domain name registrar, 
then you can also specify other resource records that affect how your 
website's services are accessible over the Internet. 

6. To save your changes, click OK. 

ü To configure automatic renewal of the domain name: 

1. Go to the Account tab. 

2. Locate the domain name for which you want to change settings, and click the 
link Show Domain Info next to it. 

3. Click Automatic Domain Renewal. 

4. To allow auto renewal of the domain registration, select the Turn on auto 
renewal checkbox and click OK.  
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Hosting Settings 

The websiteôs hosting settings are available on the Websites & Domains tab of the Control 
Panel. All per-website hosting settings form the following groups: 

Á General.  
Hosting type, security, scripting and statistics settings. See General Settings (on page 126). 

Á PHP. 
PHP scripting language settings. See PHP Settings (on page 132).  

Á Web Server. 
Web server settings (Apache (with nginx) or IIS). Web server type depends on Panel 
version: Apache with nginx is used on Panel for Linux, and IIS on Panel for Windows. 
See Apache Web Server Settings (on page 138) and IIS Web Server Settings (on page 140) 
correspondingly.  

Note that in the IIS web server settings you can configure basic website security settings, 
such as anonymous access, ssl usage, and directory browsing. 

On Windows, you can also set up custom ASP.NET settings in Websites & Domains > select a 
domain > ASP.NET Settings. For details, see  ASP.NET Settings (Windows) (on page 136).  

 

 

Next in this section: 

General Settings................................................................................................ 126 
Web Scripting Settings ...................................................................................... 131 
Web Server Settings ......................................................................................... 138 
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General Settings 

To view a website's general hosting settings, click Hosting Settings beside its name on the 
Websites & Domains tab. The general website hosting settings are divided into groups: 

Basic Settings 

Á Domain name. The domain name that you register with a domain registrar and will use for 
this website. 

Á Hosting type. The hosting type (Website hosting, Forwarding, and No hosting) defines the 
website behavior. By default, all webistes belong to the Website hosting type as they are 
physically hosted on the server. 

To change the hosting type, use the Change link. To learn more about hosting types, see 
Hosting Types (on page 127). 

To suspend the website with all mailboxes and mailing lists hosted under the website's 
domain name use the Suspend option. 

Note: Other basic settings depend on the selected hosting type. See Hosting Types (on 
page 127). 

Á Website status. The website status defines the site's accessibility in browsers and available 
hosting services. Apart from working as usual, the site can be suspended so it will not 
open in browsers, and even more, the hosting features of the site (such as the mail 
service and DNS service) can be disabled. You should change the status if you want the 
site to be temporarily unavailable, for example, for maintenance purposes. See Website 
Status (on page 130). 

Á Document root. Displayed for domains with the Website hosting type. See Website Hosting 
(on page 128). 

Á Preferred domain. Displayed for domains with the Website hosting type. See Website Hosting 
(on page 128). 

Security Settings 

Á Enable SSL support. Secure Sockets Layer encryption is generally used for protecting 
transfer of sensitive data during online transactions on e-commerce websites that run 
on dedicated IP addresses. SSL certificates that participate in the encryption process 
are usually applied to a single domain name on a single IP address, therefore, each 
site that needs SSL protection must be hosted on a dedicated IP address. An 
exception to this is subdomains, which you can protect with a wildcard certificate. 
Installing an SSL certificate on a web server that hosts several websites with different 
domain names on a single IP address is technically possible, however, it is not 
recommended: the encryption will be provided, but users will get warning messages 
on attempt to connect to the secure site. To allow SSL encryption for the website, 
select the Enable SSL support checkbox. 
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Web Scripting and Statistics 

Á Scripting languages. Specify programming and scripting languages you want the 
website to support. For PHP, you can also select the custom PHP version and handler 
type. More PHP settings are available on the PHP tab. To learn more about PHP 
handlers and PHP configuration, see PHP Settings (on page 132). 

Á Microsoft FrontPage settings. Microsoft FrontPage is a popular website authoring tool. To 
enable content creation and publishing  through Microsoft FrontPage, select the 
options Microsoft FrontPage support, Microsoft FrontPage over SSL support, and Remote 
FrontPage authoring allowed. 

Á Web statistics. Select the web statistics software that you want to use for viewing 
graphical reports and charts on website visitors. Also, select the corresponding 
checkbox if you want to be able to access the statistical reports by visiting the 

password-protected directory http://your - website/plesk - stat/webstat .  

Á Custom error documents. When visitors coming to a site request pages that the web 
server cannot find, the web server generates and displays a standard HTML page 
with an error message. If you want to create your own error pages and use them on 
the web server, select the Custom error documents checkbox. 

Á Additional write and modify permissions (available only for Windows hosting). This option 
is required if web applications on the site will be using a file-based database (like Jet) 

located in the root of the httpdocs directory. Note that selecting this option will 

seriously compromise the website security. 

 

 

Next in this section: 

Hosting Types ................................................................................................... 127 
Website Status .................................................................................................. 130 
 
 

Hosting Types 

The hosting type defines the website's behavior. Panel supports three types of hosting: 
Website hosting, Forwarding, and No hosting. 

Next in this section: 

Website Hosting ................................................................................................ 128 
Forwarding ........................................................................................................ 129 
Domains Without Web Hosting .......................................................................... 129 
 
 



 

128 Website Management 

 

Website Hosting 

The Website hosting means that a website is physically located on the server. 

For the website hosting type you can specify: 

Á Document root. The location of the directory where all files and subdirectories of the site 

will be kept. You can use the default directory httpdocs or specify another directory.  

Á Preferred domain. Typically, any website is available on two URLs: with the www prefix (like 

in www.example.com )  and without it (like in example.com ). We recommend that you 

always redirect visitors to one of these URLs (typically to the non-www version). For 

example, after you set the Preferred domain to the non-www version (example.com ), 

site visitors will be redirected to this URL even if they specify www.example.com  in their 

browsers. 

 
Panel uses the search engine friendly HTTP 301 code for such a redirection. This allows 
preserving search engine rankings of your site (preferred domain). If you turn off the 
redirection by choosing None, search engines will treat both URL versions (www and non-
www) as URLs of different sites. As a result, rankings will be split between these URLs.  

 



 

 Website Management 129  

Forwarding 

You can make one or more registered domain names to point to the same physical website, 
by using the domain name forwarding. This allows automatic redirection of visitors from the 
URL they specify in a browser to a site with a different URL. For example, visitors of the site 

www.example.com  can be redirected to www.somedomain.tld . There are two types of 

forwarding in Panel: the standard and frame forwarding. 

Standard Forwarding 

With the Standard forwarding, users who have been redirected to another URL can see the 
destination URL in the browser address bar. 

Depending on how long you intend to use the redirection, you can select the type of 
redirection ï Moved permanently (code 301) or Moved temporarily (code 302). These are 
HTTP response codes which Panel sends to browsers to perform the redirection. From 
visitorsô point of view, the response code does not matter: in both cases they will be simply 
redirected to the destination URL. For search engines, the code defines how they should 
treat the redirected site and affects search engine rankings. 

Á Moved permanently (code 301). 

Use this redirection type if you want to keep search engine rankings of your site after 
moving it permanently to another address. 

For example, if example1.com  has been moved permanently to the domain 

example2.com , the rankings will not be split between example1.com  and 

example2.com  ï search engine crawlers will treat them as a single website. 

Á Moved temporarily (code 302). 

Use this redirection type when the destination domain is used temporarily, for example, 
when you are testing a new version of your site with real visitors while keeping the old 
version intact. If you set this redirection for a newly created destination domain, this 
domain will not be indexed by search engines. 

Frame Forwarding  

With the Frame forwarding, when visitors are redirected to another site, the address bar of their 
browsers continues to show the source URL. Thus, visitors remain unaware of the 
redirection. This is called frame forwarding as the index page of the source site contains a 
frame with the destination site. 
 

Domains Without Web Hosting 

You can switch off web service and use only email services under that domain (Websites & 
Domains tab > domain name > the Change link > the No web hosting option). 
 

http://www.somedomain.tld/
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Website Status 

The website status defines whether a website is available over the Internet and what hosting 
services are provided for it. The hosting provider may need to change the status of a site if 
the client does not pay for the services. Site owners can change the status of their sites if 
they want the sites to be temporarily unavailable. 

Panel supports three website statuses: Suspended, Disabled, and Active. 

Suspended Sites 

If you want to shut down a site for maintenance and let your visitors know that it is 
temporarily unavailable, you can suspend the website so that it will not open in browsers 
(Websites & Domains > domain name > the Suspend link). Visitors will be redirected with the 
search engine friendly 503 HTTP code (Service Unavailable) to the "503 Service 
Unavailable" error page. The site's search engine rankings will not be affected, and the 
hosting services such as mail will still be available and manageable by means of Panel. 

You can customize the error page using the link Edit maintenance error page in Control Panel > 
Websites & Domains > domain name.  

Note: The link Edit maintenance error page is displayed only if your hosting plan provides the 
option to customize web server error documents (the Custom error documents is On in the 
domain settings in Websites & Domains > domain name > Edit). 

Disabled Sites 

If you stop supporting a website, you can disable it using Websites & Domains > domain name 
> the Disable link. Visitors will see the web server's default page set by the hosting provider, 
and the site's search engine rankings will drop. 

Disabled websites stop being hosted on the server: They are excluded from the web server 
configuration. However, the physical directories and files of disabled sites can be accessed 
by FTP clients and File Manager. The hosting services such as mail will be unavailable. 

Note: In Panel versions earlier than 11.5 this status was called Suspended. 

Active sites 

To bring the website back online, use Websites & Domains > domain name > the Activate link. 
The website will start working as usual. 
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Web Scripting Settings 

For each website in your subscription you can specify which of the following programming 
and scripting languages should be supported by the web server: Active Server Pages (ASP), 
Microsoft ASP.NET,  Server Side Includes (SSI), PHP hypertext preprocessor (PHP), 
Common Gateway Interface (CGI), Fast Common Gateway Interface (FastCGI), Perl and 
Python. Since Panel 10.4, you are able to configure PHP settings individually for each 
website (or subdomain) in your subscription. This is possible only if your subscription has the 
corresponding permissions. To get the details about custom PHP configuration, refer to the 
section PHP Settings. 

Next in this section: 

PHP Settings ..................................................................................................... 132 
ASP.NET Settings (Windows) ........................................................................... 136 
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PHP Settings 

PHP is one of the most popular scripting languages for creating dynamic web pages. The 
majority of today's websites and web applications are based on PHP scripts. This is why site 
administrators should clearly understand how they can control the execution of PHP scripts.  

How PHP scripts are executed for a certain website is fully defined by two aspects: PHP 
handler and PHP settings for the site. You can set up these parameters for a certain website 
in the Control Panel as described below. 

PHP Handler 

When a visitor accesses a site based on PHP scripts, a web server interprets site scripts to 
generate a page that will be shown to the visitor. PHP handler calls PHP libraries needed for 
this interpretation. You can choose from a number of PHP handlers: ISAPI (Windows), 
Apache module (Linux), FastCGI, CGI, or PHP-FPM (Linux). The decision on what PHP 
handler to choose should depend on a number of factors like security considerations, script 
execution speed, and memory consumption.  

ü To choose a PHP handler for your website: 

1. Go to Websites & Domains. 

2. Click Hosting Settings near the domain name of a website for which you want 
to choose the PHP handler. 

3. Choose one of the following PHP handlers as the value of the Run PHP as 
parameter (beside the PHP support option): 

 

Run PHP as 
 

Performance 
 

Memory 
Usage 

Security 
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Apache 
module (Linux 
only) 

High. 

Runs as a part of 
the Apache web 
server. 

Low This handler (also known as mod_php) 
is the least secure option as all PHP 
scripts are executed on behalf of the 

apache  user. This means that all files 

created by PHP scripts of any plan 
subscriber have the same owner 

(apache ) and the same permission 

set. Thus, a user has a theoretical 
possibility to affect files of another user 
or some important system files. 

Note:  You can evade some 
security issues by turning the PHP 
safe_mode option on. It disables a 
number of PHP functions that bring 
potential security risk. Note that this 
may lead to inoperability of some 
web apps. The safe_mode option is 
considered to be obsolete and is 
deprecated in PHP 5.3. 

ISAPI 
extension 
(Windows 
only, not 
supported 
since PHP 
5.3) 

High. 

Runs as a part of 
the IIS web server. 

Low The ISAPI extension can provide site 
isolation in case a dedicated IIS 
application pool is switched on for 
subscriptions. Site isolation means that 
sites of different customers run their 
scripts independently. Thus, an error in 
one PHP script does not affect the 
work of other scripts. In addition, PHP 
scripts run on behalf of a system user 
associated with a hosting account. 

Note:  The ISAPI extension handler 
is not supported since PHP 5.3. 

CGI 
application 

Low. 
Creates a new 
process for each 
request and closes it 
once the request is 
processed. 

Low The CGI handler provides PHP script 
execution on behalf of a system user 
associated with a hosting account. On 
Linux, this behavior is possible only 
when the suEXEC module of the 
Apache web server is on (default 
option). Otherwise, all PHP scripts are 

executed on behalf of the apache  

user. 

We recommend that you use the CGI 
handler only as a fall-back. 

FastCGI 
application 

High (close to 
Apache module and 
ISAPI extension). 

Keeps the 
processes running 
to handle further 
incoming requests. 

High The FastCGI handler runs PHP scripts 
on behalf of a system user associated 
with a hosting account. 
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PHP-FPM 
application 
(Linux only) 

High Low The PHP-FPM is an advanced version 
of FastCGI which offers significant 
benefits for highly loaded web 
applications. 

The PHP-FPM handler is available 
only if it was installed by hosting 
provider and if the option Process PHP 
by nginx in the websiteôs settings is 
turned on (Websites & Domains > select 
a domain > Web Server tab). 

Note:  Switching PHP from Apache module to FastCGI application may break functionality of 
existing PHP scripts. Switching to PHP-FPM by selecting Process PHP by nginx in the websiteôs 
web server settings may do the same. 

PHP Version 

Panel supports different versions of PHP. For each handler, one or more PHP versions can 
be available. The list of available versions is defined by your hosting provider and available 
to you in the same location where you select the PHP handler: Websites & Domains tab > 
<domain_name> > Edit. 

Note: Always use PHP 5.x except the cases when you need PHP 4.x to host some old PHP 

apps. 

PHP Settings 

PHP behavior is defined by a number of configuration settings. These settings specify 
various script execution aspects, like performance (for example, the amount of memory a 
script can use), security (for example, access to file system and services), and so on. You 
may adjust these settings for a number of reasons: 

Á Preventing a memory leak or server hang-up by poorly written scripts. 

Á Protecting data from malicious scripts. 

Á Meeting the requirements of a certain web app. 

Á Testing own scripts and other. 

PHP settings are located in the Control Panel, Websites & Domains > select a website > PHP 
Settings. For convenience, all PHP settings are divided into two groups: 

Á Performance settings.  
These settings define how scripts work with system resources. For example: Use the 

memory_limit  parameter to limit the amount of memory for a script  to prevent a 

memory leak. In addition, you can prevent scripts from tying up the server by limiting the 

maximum time scripts are allowed to run using max_execution_time . 

Á Common settings.  
This group contains other commonly used PHP settings. Generally, these are: Security 
settings (for example, the PHP safe mode toggle or the permission to register global 
variables), error reporting settings (for example, the directive to log errors), and others. 
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You can set the value of each parameter in PHP Settings either by selecting a value from a 
preset, typing a custom value, or leaving the Default value. In the latter case, Panel uses the 
values defined by the server-wide php.ini file. For information about certain PHP settings, 
refer to the respective documentation. For example, http://php.net/manual/en/ini.list.php.  

It is possible to use three placeholders in parameter values:  

Á {DOCROOT} for the document root directory of a domain that gets custom PHP 

configuration. 

Á {WEBSPACEROOT} for the root directory of a subscription (webspace). 

Á {TMP}  for the directory which stores temporary files. 

Note:  Default values of PHP settings in Panel differ from the ones suggested by the official 
PHP documentation at http://php.net/manual/en/ini.list.php. 

Note: Custom PHP configuration of a website acts as a preset for all subdomains of this site. 
You can perform further per-subdomain PHP configuration in the same way as for the 
websites.  
 

http://php.net/manual/en/ini.list.php
http://php.net/manual/en/ini.list.php
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ASP.NET Settings (Windows) 

ü To configure ASP.NET Settings for a site: 

1. If you are subscribed to several hosting packages and have access to 
several webspaces associated with your account, in the Subscription menu at 
the top of the screen, select the required webspace.     

2. Go to the Websites & Domains tab and click your website's domain name. 

3.  Click ASP.NET Settings. 

4. Set up the strings that determine database connection data for ASP.NET 
applications that use databases. This option is available only for ASP.NET 
2.0.x. 

When you open the ASP.NET configuration screen for the first time, sample 
connection parameters with common constructions are displayed. You can delete 
them and specify your own strings. 

Á To add a string, enter the required data into the Name and Connection Parameters input 

fields and click  next to them. 

Á To remove a string, click  next to it. 

5. Set up custom error messages that will be returned by ASP.NET applications 
in the Custom Error Settings field: 

Á To set the custom error messages mode, select an appropriate option from the Custom 
error mode menu: 

Á On - custom error messages are enabled. 

Á Off - custom error messages are disabled and detailed errors are to be shown. 

Á RemoteOnly - custom error messages are displayed only to remote clients, and 
ASP.NET errors are shown to the local host users. 

Á To add a new custom error message (which will be applied unless the Off mode was 

selected), enter the values in the Status Code and Redirect URL fields, and click . 

Á Status Code defines the HTTP status code resulting in redirection to the error page. 

Á Redirect URL defines the web address of the error page presenting information 
about the error to the client. 

Due to possible conflicts, you cannot add a new custom error message with an error 
code that already exists, but you can redefine the URL for the existing code. 

Á To remove a custom error message from the list, click  next to it. 
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6. Configure compilation settings in the Compilation and Debugging field: 

Á To determine the programming language to be used as default in dynamic compilation 
files, choose an entry from Default web page language list. 

Á To enable compiling retail binaries, leave the Switch on debugging checkbox empty. 

Á To enable compiling debug binaries, select the Switch on debugging checkbox. In this 
case, the source code fragments containing error will be shown in a diagnostic page 
message. 

Note.  When running applications in debug mode, a memory and/or performance 
overhead occurs. It is recommended to use debugging when testing an application and to 
disable it before deploying the application into production scenario. 

7. Configure encoding settings for ASP.NET applications in the Globalization 
Settings section: 

Á To set an adopted encoding of all incoming requests, enter an encoding value into the 
Request encoding field (default is utf-8). 

Á To set an adopted encoding of all responses, enter an encoding value into the 
Response encoding field (default is utf-8). 

Á To set an encoding which must be used by default for parsing of .aspx , .asmx , and 

.asax  files, enter an encoding value into the File encoding field (default is Windows-

1252). 

Á To set a culture which must be used by default for processing incoming web requests, 
select an appropriate item from the Culture list. 

Á To set a culture which must be used by default when processing searches for a 
locale-dependent resource, select an appropriate item from the UI Culture list. 

8. Set a code access security trust level for ASP.NET applications in the Code 
Access Security field. 

CAS trust level is a security zone to which applications execution is assigned, defining 
what server resources the applications will have access to. 

Important:  When an assembly is assigned a trust level that is too low, it does not 
function correctly. For more information on the permissions levels see 
http://msdn.microsoft.com/library/en-
us/dnnetsec/html/THCMCh09.asp?frame=true#c09618429_010. 

9. Enable the usage of the auxiliary scripts in the Script Library Settings field. 
Specifying the script library settings is necessary if the validation web 
controls are used on your web site. This option is available only for ASP.NET 
1.1.x. 

Á If you need to use auxiliary scripts (specifically, scripts implementing objects for 
validating input data), provide the settings for .NET framework script library. To do so, 
enter the path beginning with the domain root directory preceded by the forward slash 
into the Path to Microsoft script library field, or click the folder icon next to the Path to 
Microsoft script library field and browse for the required location. 

Á To initiate the auto-installation of files containing the scripts to the specified location, 
select the Install checkbox. If the files already exist there, they will be rewritten. 

 

http://msdn.microsoft.com/library/en-us/dnnetsec/html/THCMCh09.asp?frame=true#c09618429_010
http://msdn.microsoft.com/library/en-us/dnnetsec/html/THCMCh09.asp?frame=true#c09618429_010
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10. Set client session parameters in the Session Settings field: 

Á To set up the default authentication mode for applications, select an appropriate item 
from the Authentication mode list. Windows authentication mode should be selected if 
any form of IIS authentication is used. 

Á To set up time that a session can remain idle, type the number of minutes into the 
Session timeout box. 

11. Click OK to apply all changes. 

 
 

Web Server Settings 

Web server type depends on Panel version: Apache (with nginx) is used on Panel for Linux, 
and IIS on Panel for Windows. Depending on your Panel version, refer to Apache Web Server 
Settings (on page 138) or IIS Web Server Settings (on page 140). 

Next in this section: 

Apache Web Server Settings............................................................................. 138 
IIS Web Server Settings .................................................................................... 140 
 
 

Apache Web Server Settings 

Panel uses the Apache web server (http://en.wikipedia.org/wiki/Apache_HTTP_Server) to 
deliver the pages of your website to clients (such as browsers through which visitors access 
your website). By default, to achieve better performance, Apache is supplemented with 
another web server - nginx. For details about how Apache is integrated with nginx in Panel, 
see Apache with nginx in the Administratorôs Guide. 

Default web server settings are specified by the server administrator (hosting provider). For 
example, these settings can determine how web servers process different types of files, how 
they use SSL, where they store log files, and so on. 

However, you (as a website owner) can set up custom web server settings for your website. 
For example, add a new type of the index file, restrict access to the site, and so on.  

Note:  You can adjust web server settings for your websites only if your hosting subscription 

provides the corresponding permission. 

Next in this section: 

Adjusting Apache Web Server Settings ............................................................. 139 
 
 

http://en.wikipedia.org/wiki/Apache_HTTP_Server
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Adjusting Apache Web Server Settings 

All customizable web server settings are located on the Websites & Domains > <domain_name> 
> Web Server Settings page. Custom settings work only for the selected website. The settings 
are divided into two groups: 

Á Common Apache settings.  

These settings are typically changed by site owners, who may want to add a new type of 
index files (Index files), or a MIME type for files with a certain extension (MIME types), to 
restrict access to the site (Deny access to the site), or specify Apache handlers for a certain 
file type (Handlers). 

Á nginx settings.  

These settings define how the processing of web requests is divided between the Apache 
and nginx web servers to achieve better performance for a specific site. 

Important: nginx settings are for advanced users only. To learn more about nginx 
settings, see Adjusting nginx Settings for Virtual Hosts in the Administratorôs Guide. 

Á Smart static files processing. 

Caution: Turn off this option only to troubleshoot nginx related issues. 

Turning this option off will limit the role of nginx: It will only pass requests and 
responses without modification. Except for troubleshooting the nginx related issues, 
we recommend that you leave this option turned on. 

Á Serve static files directly by nginx. 

For sites with a lot of static content (like image or video files) and high load, better 
performance can be achieved by delegating serving static files to nginx. Apache will 
not take any part in processing the requests for the files with the specified extensions. 

For example, to exclude Apache from delivering jpg and gif files, you should turn on 
the option Serve static files directly by nginx and specify file extensions like this   

gif jpg  

or 

gif|jpg  

Caution: Because requests for static files never reach Apache, they do not pass 

through Apache handlers. This means, for example, that rewrite rules or .htaccess 
directives will not be applied. 

Á Process PHP by nginx. 

When the Process PHP by nginx option is on, Apache does not take any part in 
processing the requests for PHP files. All requests for PHP files are processed by 
nginx using the PHP-FPM handler. The handlers used by Apache are not available on 
nginx. The PHP-FPM is an advanced version of FastCGI which offers significant 
benefits for highly loaded web applications. To learn more about PHP-FPM, see 
http://php-fpm.org/about/. 

Caution: Because requests for PHP files do not reach Apache they do not pass 
through its handlers (CGI, FastCGI, or an Apache module), so some web apps 
may not work as expected. 

http://php-fpm.org/about/
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Note that subdomains have their own web server settings, therefore, when you change web 
server settings for a site that has subdomains, the subdomains will not receive these 
changes. 

If you do not find the necessary setting, contact your server administrator (hosting provider), 
who can set up more custom settings for websites. 

The Default Value of Server Settings  

You can set the value of each parameter either by typing a custom value, or leaving the 
Default value. In the latter case, Panel uses the values from the default web server 
configuration defined by the server administrator (hosting provider). 

Your values override the default ones. The only exception is the Deny access to the site 
setting  - IP addresses from the default configuration, as well as the IP addresses specified 
by you, will all be applied to your website. In case of a conflict (for example, when you allow 
the IP address that is denied in the default configuration), Apache uses your settings. 
 

IIS Web Server Settings 

Panel uses the IIS web server (http://en.wikipedia.org/wiki/Internet_Information_Services) to 
deliver the pages of your website to clients (such as browsers through which visitors access 
your website). The behavior of IIS is defined by variety of settings. 

Default web server settings are specified by the server administrator (hosting provider). For 
example, these settings can determine how IIS process different types of files, how it uses 
SSL, and so on. 

However, you (as a website owner) can set up custom web server settings for your website. 
For example, add a new type of the index file, restrict access to the site, and so on.  

Note:  You can adjust web server settings for your websites only if your hosting subscription 
provides the corresponding permission. 

Next in this section: 

Adjusting IIS Web Server Settings ..................................................................... 141 
 
 

http://en.wikipedia.org/wiki/Internet_Information_Services
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Adjusting IIS Web Server Settings 

All customizable web server settings are located in Websites & Domains > select a website > 
Web Server Settings. Custom settings work only for the selected website. The settings are 
divided into groups: 

Common Settings 

These settings are typically changed by site owners, who may want to: 

Á Allow site visitors to view the listing of files and subdirectories of the siteôs directory in 
their browsers (Directory browsing). The directory listing will be displayed if there are no 
matches for default index pages in the siteôs root directory.  

Á Add a new type of default index pages (Default documents). 

Á Add a new MIME type for files with a certain extension (MIME types). 

Directory Security Settings 

These settings allow site owners to:  

Á Restrict access to the site by username and password ï only system users will be able to 
access the site (Anonymous access). Denying anonymous access may be useful if your site 
is not intended for any visitor, for example, it is a web application for internal use. Note 
that FTP users and additional FTP users created in Panel will have access to such a site 
if they were granted access to the siteôs directory. 

Á Force all clients (such as browsers or FTP clients) to use the secure HTTPS protocol to 
access their site (Require SSL). You need this option, for example, if the site contains and 
transmits personal information. 

Access Restriction Settings 

These settings allow site owners to restrict access to the site by IP address of the visitor 
(Deny access to the site) by denting and allowing access from certain IP addresses. 

Note:  Subdomains have their own web server settings, therefore, when you change web 
server settings for a site that has subdomains, the subdomains will not receive these 
changes. 

If you do not find the necessary setting, contact your server administrator (hosting provider), 
who can set up more custom settings for websites. 

The Default Value of Server Settings  

You can set the value of each parameter either by typing a custom value, or leaving the 
Default value. In the latter case, Panel uses the values from the default web server 
configuration defined by the server administrator (hosting provider). 
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Your values override the default ones. The only exception is the Deny access to the site setting 
- IP addresses from the default configuration, as well as the IP addresses specified by you, 
will all be applied to your website. In case of a conflict (for example, when you allow the IP 
address that is denied in the default configuration), IIS uses your settings. 
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Website Content 

To create your website and fill it with the content you need (text, images, videos, and so on), 
use one of the methods provided by the Panel: 

Á Using website creation and management tools. If you do not have a website yet, consider 
setting one up by yourself with a tool for creating, editing, and publishing websites. You 
can do this even if you do not possess the necessary web programming and design skills. 
The best tools of this sort are the following: 

Á Presence Builder - a website editor integrated with the Control Panel.  

Á Third-party Content Management Systems (CMS) - web applications for creating and 
editing websites.  

Á Uploading existing websites to your hosting account using one the following methods: 

Á FTP client program. You can obtain a free FTP client from the Internet, or, if you are 
using Windows, use Windows Explorer. This enables you to access your directory on 
the hosting server and manage your files. If you collaborate with other people when 
managing your website (such as programmers or designers), you can provide them 
with access to your directory using FTP to let them edit the website by themselves. 

Á File Manager. A tool for uploading and managing website files and directories through 
the Panel web interface.  

Note: if you have a website created in Microsoft FrontPage editor, refer to the section Working 
with Microsoft Frontpage Websites (Windows) (on page 178) for details on managing this site in 
Panel. 

Below you will find detailed descriptions of the ways to manage your content. 

Presence Builder 

Presence Builder is a great tool that enables users with no knowledge of HTML markup or 
graphic design skills to create professional-looking sites. Just pick a suitable page design 
and content template, add your text to the pages, and publish the site. 

You can create and publish websites using Presence Builder if your hosting subscription 
provides this option. If it does not, or if you have already created and published the allowed 
number of sites, you still can create a new website with Presence Builder and edit it. 
However, to publish this website, you will need to upgrade your hosting plan. 

To start creating a website using Presence Builder or edit an existing Presence Builder site, 
go the Websites & Domains tab, click you domain name, and click Launch Presence Builder. Find 
more information on creating and editing websites in Presence Builder in the chapter Building 
Websites with Parallels Presence Builder (on page 199). 
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Third-Party Content Management Systems 

To create and maintain a website, you can use third-party Content Management Systems 
(CMS) - web applications that let you easily edit a website's structure and content with a 
graphical user interface. Examples of such systems are Drupal and Joomla. 

CMS are usually server applications, so to start using one of them you should install it on 
your hosting account. Hence, if you plan to use a CMS, ensure that your hosting subscription 
allows such applications to be installed. 

ü To create a website using a CMS: 

1. Go to the Applications tab.  

2. Find the CMS you need in the list of available applications, and install it as 
described in the section Employing Website Applications (on page 151). 

3. Create and edit your website in the CMS. For information on how to create 
websites with your CMS, refer to the relevant documentation. 

Uploading Using FTP 

If you already have all your website files and directories, consider uploading them to your 
hosting account using FTP. This is the quickest way for simple uploading of files when you 
do not need to edit or manage them on the server. 

ü To upload files using FTP: 

1. Connect to your site's domain name with an FTP client program using your 
FTP access credentials. Learn how to configure these credentials in the 
section Adding FTP Accounts (on page 253).  

2. Copy the website files and directories to your directory on the server.  

File Manager 

Another way to publish a website created outside the Panel is File Manager - a tool that 
provides a set of file management functions through the web interface. File Manager is 
located on the Files tab of the Control Panel.  

To upload a website from your computer to Panel server with File Manager, open the Files 
tab of the Control Panel and drag the website folder to the central area of this tab. If your 
website is compressed to a ZIP file, you can upload this file to the server and then extract it 
by clicking Extract Files in the More menu. 

If you want to edit pages of your website, you can do it in File Manager. It provides an HTML 
editor that allows visual editing of HTML pages (without needing to manually type HTML 

tags). To edit a file in the HTML editor, place the mouse pointer over the file, click the link  
to open the file's context menu, and select Edit in HTML Editor. 
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You can also edit files in File Manager's text editor if you like. To open a file in the text editor, 
open the file's context menu and select the Edit in Text Editor. 

If you have files or web pages that you want to make inaccessible on the Internet, change 
these files' access permissions in File Manager. To edit access permissions for a file or a 
directory, click the corresponding link in the Permissions column. To learn how to review and 
edit the permissions, refer to the sections Setting File and Directory Access Permissions (on page 
146). 

Next in this section: 

Setting File and Directory Access Permissions .................................................. 146 
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Setting File and Directory Access Permissions 

ü To review or change the permissions set for files and directories on Linux 
systems: 

1. If you are subscribed to several hosting packages and have access to 
several webspaces associated with your account, select the required 
webspace in the Subscription menu at the top of the screen.    

2. Go to the Files tab. 

The permissions set for files and directories are shown in the Permissions column. They 
are represented as three sets of symbols, for example, 'rwx rwx r--'. The first set tells 
what the owner of the file or directory can do with it; the second tells what the user group, 
the file or directory belongs to, can do with the file or directory; the third set indicates what 
other users (the rest of the world, that is, Internet users visiting a site) can do with the file 
or directory. R means the permission to read the file or directory, W means the 
permission to write to the file or directory, and X means the permission to execute the file 
or look inside the directory. 

3. Locate the file or directory for which you want to modify permissions and 
click a hyperlink in the Permissions column. 

4. Modify the permissions as desired and click OK. 

  

ü To set access permissions for a file or directory on Windows systems: 

1. If you are subscribed to several hosting packages and have access to 
several webspaces associated with your account, in the Subscription menu at 
the top of the screen, select the required webspace.     

2. Go to the Files tab. 

3. Locate the file or directory for which you want to set access permissions, and 

click the corresponding icon . 

4. Do the following: 

Á To make the file or folder inherit permissions from a parent folder (if it does not), 
select the checkbox Allow inheritable permissions from the parent to propagate to this object 
and all child objects. Include these with entries explicitly defined here. 

Á To make the files and folders, which are contained in this folder, inherit the folder 
permissions you define, select the checkbox Replace permission entries on all child objects 
with entries shown here that apply to child objects. 

Á To change or remove permissions from a group or a user, click the required name in 
the Group or user names list. If the group or user is not listed in the Group or user names 
list, select the required user or group name from the menu located above the list and 

click : the user/group appears in the list. Select it. 
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To allow or deny permissions to a selected group/user, select the Allow or Deny 
checkboxes corresponding to permissions listed under Permissions for <user/group 
name>. If the checkboxes in the Allow or Deny columns are shown in grey, it means that 
the corresponding permissions are inherited from a parent folder. 

Á To deny the permissions, which are inherited from a parent object as allowed, select 
the required checkboxes under Deny. This will override inherited permissions for this 
file/folder. 

Á To allow the permissions, which are inherited from a parent object as denied, clear the 
Allow inheritable permissions from the parent to propagate to this object and all child objects. 
Include these with entries explicitly defined here checkbox: this removes the inherited 
permissions. Then select the required checkboxes under Allow and Deny. 

Á To remove access permissions from a group or user, select the required name in the 

Group or user names list and click the icon  next to it. 

5. If you need advanced fine-tuning of permissions, click the Advanced button, 
and do the following: 

Á To create a permission entry for a group or user, select the required name from the 

Group or user names list and click . 

Á To set or change file/folder permissions for a group or user, select the required name 
from the Group or user names list, select the required Allow and Deny checkboxes 
corresponding to permissions listed under Permissions for <user/group name>. 

Á To remove a permission entry for a group or user, select the required name from the 

Group or user names list and click . 

Á To make child objects of a folder inherit its permissions defined under Permissions for 
<user/group name>, select the Replace permission entries on all child objects with entries 
shown here that apply to child objects checkbox, and select checkboxes in the Apply to list 
which correspond to the objects that must inherit the permissions. 

6. Click OK. 
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(Advanced) Restricting Access to Content 

If you have directories in a site that only authorized users should see, restrict access to these 
directories with password protection. 

ü To protect a directory in your site with a password and to specify authorized 
users: 

1. If you are subscribed to several hosting packages and have access to 
several webspaces associated with your account, in the Subscription menu at 
the top of the screen, select the required webspace.     

2. Go to the Websites & Domains tab and click the site's domain name. 

3. Click Password-protected Directories. 

4. Click Add Protected Directory. 

5. In the Directory name box, specify the path to the directory that you want to 
protect with a password.   

This can be any directory existing in the site, for example: /private . If the directory that 

you would like to protect has not yet been created, specify the path and the directory 
name ï the Panel will create it for you. 

6. If you are using a Linux-based account, you can also protect your CGI 

scripts stored in the cgi - bin  directory. To do this, leave '/' in the Directory 

name box and select the cgi-bin checkbox. 

7. In the Title of the protected area box, type a resource description or a welcoming 
message that your users will see when they visit the protected area. 

8. Click OK. The directory you specified will be protected. 

9. To add authorized users, click Add New User. 

10. Specify the username and password that will be used for accessing the 
protected area. The password should be from 5 to 14 symbols in length. 
Click OK. 

ü To add an authorized user of a protected directory: 

1. If you are subscribed to several hosting packages and have access to 
several webspaces associated with your account, in the Subscription menu at 
the top of the screen, select the required webspace.     

2. Go to the Websites & Domains tab and click the site's domain name. 

3. Click Password-protected Directories. 

4. Click on the name of the directory you need. 

5. Click the Add New User icon. 
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6. Specify the username and password that will be used for accessing the 
protected area. The password should be from 5 to 14 symbols in length. 

7. Click OK. 

ü To change password for an authorized user of a protected directory: 

1. If you are subscribed to several hosting packages and have access to 
several webspaces associated with your account, in the Subscription menu at 
the top of the screen, select the required webspace.     

2. Go to the Websites & Domains tab and click the site's domain name. 

3. Click Password-protected Directories. 

4. Click on the name of the directory you need. A list of authorized users will 
open. 

5. Click on the userôs name. 

6. Specify the new password and re-type it for confirmation. 

7. Click OK. 

ü To revoke a permission to access the protected directory from a user: 

1. If you are subscribed to several hosting packages and have access to 
several webspaces associated with your account, in the Subscription menu at 
the top of the screen, select the required webspace.     

2. Go to the Websites & Domains tab and click the site's domain name. 

3. Click Password-protected Directories. 

4. Click on the name of the directory you need. A list of authorized users will 
open. 

5. Select a checkbox corresponding to the userôs name. 

6. Click Remove. Confirm the operation and click OK. 

ü To remove password protection and make the resource available to the public: 

1. If you are subscribed to several hosting packages and have access to 
several webspaces associated with your account, in the Subscription menu at 
the top of the screen, select the required webspace.     

2. Go to the Websites & Domains tab and click the site's domain name. 

3. Click Password-protected Directories. 

4. Select a checkbox corresponding to the name of the directory, from which 
you want to remove protection. 

5. Click Remove Protection. The protection will be removed and the contents of 
the directory will be accessible to the public without restrictions. 
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Previewing Websites 

After you purchase a domain, its registration can require some time. The reason for the delay 
is that name servers update their zone information periodically. Thus, until all name servers 
have received information about your zone, you will not be able to access your site by its 
domain name. Nevertheless, you can always access your site during domain name 
propagation using the Preview button on the Websites & Domains tab. 

During domain name propagation other people can access your site too. For this purpose, 
Panel registers your website as a subdomain of one of the provider's sites. For example, if 
your website is my-domain.tld and a provider has configured the preview service on provider-
domain.tld, you can access your site on my-domain.tld.192-0-2-12.provider-domain.tld. Here 
192-0-2-12 is the site's IP address where dots are replaced with dashes. 

Notes:  

The contents of password-protected directories might be inaccessible in the Preview mode. 

If you do not have the site preview button on the Websites & Domains page, contact your 
hosting provider. 
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Web Applications 

You can significantly increase your website functionality by using different web apps. Apps 
installed on a website can perform a number of tasks. If you are an individual, you can, for 
example, present yourself with a blog or organize an online storage of your media files. 
Companies can move their business online using the e-commerce or CRM web apps. All 
these apps are available for installation from the Applications tab of the Control Panel. 

The list of available apps is governed by your hosting plan. For example, it might include only 
free apps or no apps at all. For more information on available apps, contact your hosting 
provider. 

App Types 

There are two types of web apps: 

Á Apps installed directly on your website (for example, the WordPress blogging platform or 
the Joomla! content management system). 

Á Apps installed on external servers and provided by third-parties. 

Regardless of the installation type, apps can be either free or commercial. Commercial apps 
require you to obtain a license key to start working with them. You can recognize commercial 
apps in the catalog on the Application tab by the button Buy now (instead of Install for free 
apps). If you decide to use commercial apps, read the Managing Commercial App Licenses (on 
page 156) section to learn more about acquiring and managing app licenses.  

App Installation and Maintenance 

The process of installation is fully automated and does not require any specific skills. To 
learn how to install web apps from the Control Panel, refer to the section Installing Apps (on 
page 153). 

Further app management is also facilitated as you can update or remove apps directly in 
Panel. Moreover, you can access some functions that apps reveal to the Control Panel 
(without the need to log in to an app). For example, you can add SugarCRM user account 
right from your Control Panel. Such app functionality is a service provided by the app. 

After you install an app, grant other auxiliary user accounts access to it if you want them to 
be able to use the app. To get started with managing apps, see the section Managing Apps (on 
page 154).   
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App Databases 

If an app requires a database, Panel creates it automatically during installation of the app. To 
create a database, Panel uses app database settings, which you can change in the Main 
configuration section (Show All Settings link) when installing an app: 

Á A database name and a database server where the app will store the database.  

Á Database user credentials, which Panel will use to access the app database. It may be 
convenient to employ a single database user with access to all databases. In this case, 
you can create a universal user account and specify it when installing apps. To learn 
more, refer to the section Managing Database User Accounts (on page 275). 

Note that if you exceed the maximum number of databases allowed for your subscription, a 
new app does not create a new database. Instead, it adds tables to one of the existing 
databases, and adds prefixes to table names. Prefixes make it easier to distinguish tables of 
different apps from each other. For example, the Wordpress app will add the ñwpress_ò prefix 
to the names of its tables. 

Access to Apps 

By default, after you install an app, it is available only for users with the Owner role. You can 
make your apps available to certain auxiliary users by adjusting their permissions. For details 
on setting up access to apps for auxiliary users, refer to the section Granting Auxiliary Users 
Access to Apps (on page 154). 

Apps and Auxiliary User Accounts 

Some apps let you create and manage user accounts directly in Panel. For example, the 
SugarCRM app allows you to add SugarCRM users without logging in to the app. All apps 
with such "account services" can associate their accounts with users of a Panel subscription 
(auxiliary users). To perform such an association, you should grant the auxiliary users 
access to that account service (in the same way as you grant access to apps). For details on 
account association, refer to the section Linking Apps and Auxiliary  (on page 155)User Accounts. 

Next in this section: 

Installing Apps ................................................................................................... 153 
Managing Apps ................................................................................................. 154 
Granting Auxiliary Users Access to Apps .......................................................... 154 
Linking Apps and Auxiliary User Accounts......................................................... 155 
Updating Apps ................................................................................................... 156 
Managing Commercial App Licenses ................................................................ 156 
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Installing Apps 

Depending on your needs and expertise level, you can choose one of the following ways to 
install an app: 

Á Quick. This is the easiest way to install an app. If you choose this way, Panel will perform 
a typical installation of the latest app version of the selected app, Panel will use the 
default values for the app settings. For example, your Panel access credentials will be 
used as the app administrator's credentials.  

Note:  Some apps require you to fill in certain settings even if you select the quick 
installation. 

Á Custom. This way allows you to customize app installation settings such as administrator 
credentials and location, installation path, and other. Particularly, you should use custom 
installation if you want to switch off automatic upgrades of the app.  

ü To install an app: 

1. Go to the Applications tab and find the app you need. 

2. Click either the Install button for the quick installation or the Install (Custom) for 
the custom installation. 

3. (Optional) Turn off automatic upgrades of the app. 

If you do not want the app to be updated automatically, deselect the option Automatically 
update this app when updates are available on the installation settings page. 

4. (Optional) Select the app version.  

Sometimes, you may need to install a specific version of an app. For example, if you plan 
to use app extensions that are incompatible with the latest app version. In this case, click 
the app name > Select another version to select the version you need. Then install the app. 

Note: For commercial apps, you should obtain a license key by clicking Buy now before 
starting the installation. To learn more about using commercial apps refer to the section 
Managing Commercial App Licenses (on page 156). 
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Managing Apps 

Generally, all apps allow the configuration of their main parameters directly in the Control 
Panel. You can access app settings by selecting the app from the list in Applications > Manage 
My Applications. After you select an app, you can configure the following: 

Á General settings. 
These are basic settings (for example, the app administrator password) that can be 
changed with Change Settings. 

Á Service settings. 
If an app provides a part of its functionality to Panel by means of services, you have the 
option to configure them. For example, the SugarCRM app allows the creation of user 
accounts and provides this ability as a service in the Control Panel. After you select this 
service in Provided services, you can view all app user accounts and create new ones. 
For some apps, you can associate the app accounts with auxiliary user accounts. Learn 
more about account association in the section Linking App and Auxiliary  (on page 155)User 
Accounts. 

 
 

Granting Auxiliary Users Access to Apps 

By default, after you install an app, only users with the Owner role can access it. To allow 
other subscription users to access the app: 

Á Grant permission to access the app to a certain user group in Users > User Roles. 

Á Be sure to add users of your choice to the group. 

Once you allow users to access the app, a link to the app appears on their  Websites & 
Domains page under the name of the corresponding website. Note that you can control app 
access only for user groups, so you should either modify the permissions of an existing 
group or create a new one, and then assign users to it.  

By default, the app administrator is a subscription user with the Owner role. As well as 
accessing the apps from the Websites & Domains page, this user can also install and manage 
apps within a subscription. For these purposes, their interface has the additional Applications 
tab. You can provide the same administrative privileges to other subscription users by 
granting the Install and manage applications permission to their role in Users > User Roles. This 
gives users full administrative access to all apps within a subscription. As well as the 
administrator, the users with this permission can install, configure, update, and remove apps 
through the Applications tab in their Control Panel. 
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Linking Apps and Auxiliary User Accounts 

Some apps let you create and manage user accounts without logging in to the app. If an app 
provides such an account service, you can link users of a Panel subscription with accounts in 
the app. To perform such an association: 

1. Organize the users into a certain group (Users > User Roles). 

2. Grant one of these group permissions: 

Á Public access. 
If granted, all users in the group will have access to the app through the link on the 
Websites & Domains page. 

Á Personal access. 
If granted, the app will automatically create accounts for all users in the group. After 
that, the users' Websites & Domains page will contain an additional link that allows 
logging in to a personal account in the app. Note that if you deny the Personal access 
permission, the app will automatically remove all accounts associated with this group. 
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Updating Apps 

Automatic Updates 

By default, Panel installs the latest available app versions and updates apps immediately 
once the newer versions are available. However, updating an app can significantly change its 
functionality: For example, plug-ins or extensions developed for a particular app version may 
be incompatible with newer versions. Therefore, you might want to turn off automatic updates 
for a certain app.  

ü To turn automatic updates on or off: 

1. Go to Applications > Manage My Applications and click the app's name. 

2. Click Change Settings. 

3. Select or deselect the option Automatically update this app when updates are 
available. 

Manual Updates 

If you prohibit automatic updates for an app, Panel will inform you about the availability of 
newer versions by adding the link Update available under the app name in Applications > Manage 
My Applications. Click this link to review the changes available in the new version and decide 
whether to update the app or continue with the current version. 

Managing Commercial App Licenses 

If you decide to buy an application license in the Control Panel and click the corresponding 
button on the Applications tab, you will be forwarded to Storefront, the online store where you 
complete your order. Actually it is not only a store, it also includes its own web interface to 
help you perform various operations with the licenses you own. For example, from this web 
interface you can renew a license, cancel it, change your payment methods and so on. This 
section explains how to carry out these operations. 

Storefront Basics 

When you order a first license in Storefront, it creates an account for you. This account 
contains your personal and financial information; if you log in to Storefront under this 
account, you will be able to do various operations with your licenses.  

Each time you successfully check out in Storefront, a purchase order is generated. It is a 
document that lists the cart items you ordered. Storefront assigns different statuses to 
orders. These statuses explain the current state of your purchase - whether it is unpaid, 
canceled, or successfully delivered.  
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Storefront and Panel share the service plans business model. In Storefront, each application 
is presented by a separate service plan, and when you order an application license you 
subscribe to one of the service plans. In other words, each license you purchase is shown as 
a subscription in the web interface. For instance, if you would like to view a license price, 
terms, or an expiration date, you should open the corresponding subscription. 

How to Get a License File or Key 

After you order a license and pay for it, Storefront sends you an e-mail with your license file 
or key. We recommend that you keep the information in a safe place because there is no 
way to request it again or view it from the web interface. If you did not receive the e-mail with 
a license file or key, contact us at https://support.parallels.com/.  

Available Operations 

The operations you can carry out in Storefront fall into three groups: 

Á Operations with your user account. These operations include viewing and modifying your 
personal information and preferences and changing the password to your user account. 

Á Operations with payments and payment methods. This group comprises operations with 
your credit cards, payments, and orders. 

Á Operations with subscriptions. Use them to acquire new licenses, obtain information 
about your existing licenses, and check the subscription renewal method for a particular 
subscription. 

Learn more about these operations in the subsections of this section. 

Next in this section: 

User Account ..................................................................................................... 158 
Payments and Payment Methods ...................................................................... 159 
Subscriptions ..................................................................................................... 160 
 

 

https://support.parallels.com/
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User Account 

You can do the following operations with your user account. 

View and Change Your Account Information 

The system uses your account information to add your personal and financial details into 
invoices. If you see that you need to update your details, open the My Contact Info submenu 
on the Navigation menu and select Account Info.  

View and Change Your Personal Information 

Your personal information mostly duplicates the account information. It does not appear in 
financial documents, but some services use this information as technical contact details. For 
example, it is possible to order a domain name through Storefront, and if you do so, 
Storefront will send your personal information (as the technical contact) to a domain name 
registrar. 
To view user personal information, open the My Contact Info > Personal Info menu on the left 
panel. Here you can also edit your personal information and change password to your 
Storefront account. 

Configure e-mail notifications 

E-mail notifications are sent on different events to your account contact e-mail address. They 
fall into a number of categories. For example, subscription renewal and expiration, your 
credit card(s) expiration, etc. You can select messages format for every group of messages 
and decide whether to send certain messages or not. To configure messages types to 
receive, open My Contact Info > Notification Methods.  
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Payments and Payment Methods 

This section describes operations with payments and credit cards available to you in 
Storefront. 

Registering a Credit Card 

Before a credit card becomes available for making online payments, it is necessary to 
register it in Storefront. To register a credit card, open Billing Manager > My Financial Info > 
Payment Methods and click the appropriate button.  

Configuring Automatic Payments 

You can assign one of the registered credit cards to be used for paying orders automatically. 
In this case, you will not need to pay each order manually. If you assign a payment method 
to be used for automatic payments, the previous default one is unselected automatically. 
Thus, only one payment method can be used for automated payments. 

To turn on automatic payments from a card, go to Billing Manager > My Financial Info > Payment 
Methods, select the card  by clicking on its ID or Type, and, finally, enable automatic payments 
on the card properties screen. 

Making a Payment 

To add new payment, open the Billing Manager > New Payment link on the dashboard. The 
adding new payment wizard starts. The list of pending documents appears on the screen. If 
there are no pending documents, click Cancel to finish the wizard. Otherwise, walk through 
the wizard by providing the payment settings. 

Viewing Open Orders 

Your open orders are available in the Billing Manager > My Financial Info > Open Orders 
submenu. 
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Subscriptions 

Storefront offers you a powerful and comprehensive mechanism of subscriptions (licenses) 
management, allowing you to perform the following operations. 

Buying a Subscription 

If you want to purchase one more app license or another service offered by Storefront, there 
is no need for you to go to the Control Panel. The Storefront web interface provides all 
facilities for making the purchase. To start the subscription ordering wizard, open Billing 
Manager > Subscription Management and click Buy New Subscription.  

Renewing a Subscription Manually 

If you did not configure the auto renewal feature, your subscription will expire unless you do 
not renew it manually. The auto renewal setup instructions are given later in this section. To 
renew a subscription manually, open Billing Manager > Subscription Management > Renew 
Subscription and follow the wizard steps. 

Renewing Subscriptions Automatically 

Configuring a subscription for auto renewal helps renewing your subscriptions in time. To 
allow the auto renewal, open Billing Manager > Subscription Management > Renew Subscription, 
click a subscription for which you want to turn the option on, and click Turn On AutoRenew 
Option. Clear the option to cancel the auto renewal. 

Canceling a Subscription 

A subscription cancelation results in termination of the subscription services and money 
refund. To cancel a subscription, open Billing Manager > Subscription Management > Renew 
Subscription, click a subscription you want to cancel, and start the cancelation wizard by 
clicking Cancel Subscription. 

(Advanced) Website Security 

Next in this section: 

Securing Connections with SSL Certificates ...................................................... 161 
Protecting Sites from Hotlinking (Windows) ....................................................... 166 
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Securing Connections with SSL Certificates 

If your website transfers private data, for example, visitors' credit card numbers, we 
recommend that you use the SSL secure channel for this website. To set up such a channel, 
you should purchase an SSL certificate for your website. 

SSL certificates are used not only for establishing secure communication channels on the 
Internet but also for verifying a website's identity as well. When users visit your secure online 
store, they are notified that your website is really what it claims to be and that all sensitive 
data, such as credit card numbers, will be transferred over a secure channel.  

SSL certificates are issued by specific organizations - SSL certificate providers. However, 
some hosting providers allow customers to purchase SSL certificates directly from Panel.  

Purchasing SSL Certificates 

Depending on your hosting provider, you can have the following ways of purchasing SSL 
certificates: 

Á Order an SSL certificate from Panel. This way is available to you if your provider 
configures the corresponding Panel settings. The links for purchasing SSL certificates 
from Panel may let your purchase certificates either from your provider in their online 
store or from Parallels in the MyPlesk outlet. To learn how to order an SSL certificate 
through Panel, see the section Purchasing SSL Certificates through Panel (on page 162). 

Á Order an SSL certificate from the SSL certificate provider you like. In this case, you 
should create a certificate signing request (CSR) for your website in Panel and submit it 
to an SSL certificate provider. To learn how to create such request and purchase a 
certificate with it, refer to the section Generating Certificate Signing Requests (on page 163). 

Securing Websites 

After you obtain a certificate for your website, you should secure the connection to the 
website with the certificate. The section Securing Websites (on page 164) explains how to do 
this. 

Securing Websites with Shared SSL Certificates 

On Windows systems, you may be able to secure your websites without purchasing your 
own SSL certificates. This feature is available to you if your hosting provider offers shared 
SSL certificates. The section Using Shared SSL Certificates (Windows) (on page 165) explains 
how to secure a website with a shared SSL certificate. 

Next in this section: 

Purchasing SSL Certificates Through Panel ...................................................... 162 
Generating Certificate Signing Requests ........................................................... 163 
Securing Websites ............................................................................................ 164 
Using Shared SSL Certificates (Windows)......................................................... 165 
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Purchasing SSL Certificates Through Panel 

The links for purchasing SSL certificates in Panel let you purchase either certificates from 
your provider if they offer their own certificates, or certificates from Parallels in the MyPlesk 
outlet. These links may also be unavailable to you if your provider decides so. 

ü To purchase an SSL certificate through Panel: 

1. Open the corresponding subscription in the Control Panel 

2. Go to the Websites & Domains and select the website you want to protect with 
an SSL certificate. 

3. Click Secure Your Sites. 

4. Click Add SSL Certificate. 

5. Specify the following certificate parameters: 

Á Certificate name. This will help you identify this certificate in the repository. 

Á Encryption level. Choose the encryption level of your SSL certificate. We recommend 
that you choose a value more than 1024 bit. 

Á Your location and organization name. The values you enter should not exceed the 
length of 64 symbols. 

Á The domain name for which you want to purchase an SSL certificate. This should be a 
fully qualified domain name. Example: your-domain.com. 

Á The website administrator's e-mail address. 

6. Make sure that all the provided information is correct and accurate, as it will 
be used to generate your private key. 

7. Click Buy SSL Certificate. 

8. Complete all steps of an SSL certificate purchase in the online store and you 
will receive your SSL certificate by e-mail.  
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Generating Certificate Signing Requests 

If your hosting provider does not allow purchasing SSL certificates through Panel, you can 
create a certificate signing request and submit it to an SSL certificate provider. The provider 
will generate an SSL certificate for your website basing on this request. 

ü To generate a certificate signing request: 

1. Open the corresponding subscription on the Control Panel 

2. Go to the Websites & Domains and select the website you want to protect with 
an SSL certificate. 

3. Click Secure Your Sites. 

4. Click Add SSL Certificate. 

5. Specify the following certificate parameters: 

Á Certificate name. This will help you identify this certificate in the repository. 

Á Encryption level. Choose the encryption level of your SSL certificate. We recommend 
that you choose a value more than 1024 bit. 

Á Your location and organization name. The values you enter should not exceed the 
length of 64 symbols. 

Á The domain name for which you want to purchase an SSL certificate. This should be a 
fully qualified domain name. Example: your-domain.com. 

Á The website administrator's e-mail address. 

6. Make sure that all the provided information is correct and accurate, as it will 
be used to generate your private key. 

7. Click Request. Panel will generate your private key and certificate signing 
request and add them to your certificates repository (Websites & Domains > 
Secure Your Sites). 

8. In the list of certificates, click the name of the certificate you need. 

9. Locate the CSR section on the page, and copy the text that starts with the line 
-----BEGIN CERTIFICATE REQUEST----- and ends with the line -----END CERTIFICATE 
REQUEST----- to the clipboard. 

10. Visit the website of the certification authority from which you want to 
purchase an SSL certificate, and follow the links on their site to start a 
certificate ordering procedure. When you are prompted to specify CSR text, 
paste the data from the clipboard into the online form and click Continue. The 
certification authority will create an SSL certificate in accordance with the 
information you supplied. 
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Securing Websites 

After you receive an SSL certificate for your website, secure the website with this certificate. 

ü To secure a website with an SSL certificate: 

1. Log in to the Control Panel and select the subscription that contains the 
website you want to secure in the Subscriptions menu at the top of the screen. 

2. Go to the Websites & Domains and select the website you want to protect with 
an SSL certificate. 

3. Click Secure Your Sites. 

Upload the SSL certificate: Click Browse in the middle of the screen and navigate to the 
location of the saved certificate. Select it, and then click Send File. 

This will upload and install the certificate against the corresponding private key. 

1. To install the certificate on a site, return to the Websites & Domains tab, and 
click the domain name of the website that you want to secure. 

2. To switch on SSL protection, select the Enable SSL support checkbox. 

3. From the SSL certificate menu, select your SSL certificate and click OK. 
 



 

 Website Management 165  

Using Shared SSL Certificates (Windows) 

If your hosting service provider offers shared SSL for securing access to sites, then you can 
switch on SSL encryption without purchasing your own SSL certificate. 

ü To secure connections to a site by using an SSL certificate shared by your 
provider: 

1. If you are subscribed to several hosting packages and have access to 
several webspaces associated with your account, in the Subscription menu at 
the top of the screen, select the required webspace.     

2. Go to the Websites & Domains and select the website you want to protect with 

an SSL certificate. 

3. Click Shared SSL. 

4. Select the domain name of the site that you want to secure. 

5. Select the Switch on shared SSL checkbox. 

6. Specify the virtual directory name in the corresponding input field. The virtual 
directory with the supplied name will be created under the domain whose 
SSL certificate is shared (called master SSL domain). This directory will be 
used for accessing your site through SSL. 

For example, let us suppose that you have a domain named mydomain.com, the master 
SSL domain is defined as master_ssl_domain.com, and the virtual directory name you 

supplied is my_virtual_dir . In this case, to access your site through SSL, you need to 

use the following address: https://master_ssl_domain.com/my_virtual_dir.  

Note:  You cannot use your domain name (for example, mydomain.com) to access your 
site via SSL if you are using shared SSL. 

7. Select the directory where protected content is located under your website. 
The documents within the specified directory will be accessible only through 
SSL. 

8. To make your domain accessible via SSL only, select the checkbox Make this 
website accessible only through secure connections. 

9. Click OK. 
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Protecting Sites from Hotlinking (Windows) 

Hotlinking (also called file leeching, remote linking, direct linking, bandwidth stealing or 
bandwidth banditism) is a term used for describing a situation when a web page of one 
domain owner is directly linking to images (or other multimedia files) on the web pages of 
another domain owner, usually using an <IMG> tag. If your domains are hotlinked, you may 
face the problem of excessive bandwidth usage.  

ü To protect a website from hotlinking:  

1. If you are subscribed to several hosting packages and have access to 
several webspaces associated with your account, in the Subscription menu at 
the top of the screen, select the required webspace.     

2. Go to the Websites & Domains tab and click the website's domain name. 

3. Click Hotlink Protection. 

4. Click Switch On to enable the protection from hotlinking.  

5. Specify the extensions of files that you want to protect from hotlinking (for 
example, jpg, bmp, and so on) in the Protected files extensions field. When 
listing several file extensions, separate them with white spaces. 

6. If you want to allow direct linking to your files from certain sites, type the 
website addresses into the Addresses of friendly websites field, and click Add. 

7. Click OK. 

 
 

(Advanced) Extended Website Management 

Panel provides a number of operations on websites and domains for advanced users: 
Working with third-party applications and services, fine tuning of some system services, and 
much more. This section contains the detailed instructions on all these operations. 

Next in this section: 

Working with a Staging Site ............................................................................... 167 
Setting Up Mobile Sites ..................................................................................... 169 
Setting Up Custom Error Pages ........................................................................ 170 
Using Google Services ...................................................................................... 172 
Hosting Personal Web Pages Under Your Domains .......................................... 175 
Limiting Bandwidth and Number of Connections to Websites ............................ 177 
Working with Microsoft FrontPage Websites (Windows) .................................... 178 
Using Virtual Directories (Windows) .................................................................. 183 
Setting Up IIS Application Pool (Windows) ........................................................ 196 
Web Publishing with Web Deploy (Windows) .................................................... 198 
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Working with a Staging Site 

If you have a production website and are planning major site changes, consider setting up a 
staging site ð a separate location on the server where you can conveniently update and test 
a copy of the site before putting it into production. 

We recommend that you work with a staging site in the following way: 

1. Decide where you want to host the development copy and prepare the development 
environment. You can choose to host it in the same webspace, in a separate webspace 
on the same server, or upload it to an FTP account on another server. 

If you choose the same webspace, then you first need to set up a new website by adding 
a domain or a subdomain. 

2. (Optional step.) If you set up your development environment under your account in the 
Panel and your production site has APS applications installed via the Panel (at the 
Applications tab), install the desired site applications in your development environment in 
the same subdirectory as you have on your production site. This step is optional; 
however, it will help you avoid changing manually database connection settings in the 
application scripts.  

3. Make a copy of the website and place it in the staging environment. 

4. Make copies of the databases used by the site and deploy them in the staging 
environment. 

5. Change database connection settings in the scripts to point at the databases in the 
staging environment. 

6. (Optional step.) Complete APS applications setup. Go to the Applications tab for your 
development site, locate the application in the list of installed applications, open its 
Settings screen and re-save the parameters. With this operation, the APS scripts should 
stop pointing at the production database and reconnect the application to the database 
copy. This step is needed if your production site has APS apps installed via the Panel 
and you performed Step 2 of the current instruction.  

7. Make the required changes to the site copy in the staging environment, and test them to 
make sure everything works as intended. 

8. Publish the updated site. This is done by pointing the document root of the production 
site to the staging site location. 

ü To set up a site for staging purposes: 

1. Go to the Websites & Domains tab. 

2. Click either Add New Domain or Add New Subdomain. 

We recommend that you use a subdomain for staging purposes. 

3. Proceed as described in Adding Domains (on page 110) or Adding Subdomains 
(on page 112). 

If you do not want your staging site to be accessible to the Internet users, do not register the 
newly added domain or subdomain name with a domain name registrar, or use an 

.htaccess  file (on Linux hosting) to restrict access to it. 
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ü To make a copy of website files: 

1. Go to the Websites & Domains tab and click the name of the website you want 
to copy. 

2. Click Website Copying. 

3. To copy website files to the document root of an exist ing site: 

a. Select the option Website in the Panel. 

b. Select the destination site from the Site name menu. 

c. Specify what to do with the files that might already be present in the 
destination directory. 

4. To copy website files to an FTP account on this or another server: 

a. Select the option FTP storage. 

b. Specify the server's host name and credentials for connecting to the 
FTP account. 

c. In the FTP connection method field, leave the Active mode option selected. 
If the Panel fails to connect to the external FTP account, select the 
Passive mode option here. 

5. Click OK. 

If the site uses scripts that work with a database, copy the database to the staging 
environment: 

Á If the database is hosted on the same server managed by Panel 10, use the procedure 
below to copy it. 

Á If the database is hosted on a server which is not managed by Panel 10, use the 

mysqldump  utility to export the database, move the resulting data dump file to the 

staging environment and deploy it there. Modify the site's scripts in the staging 
environment so that they connect to the copied database. 

ü To make a copy of a database from the Panel-managed server: 

1. Go to the Websites & Domains tab > Databases. 

2. Click Copy in the databases list for the database you want to copy.  

3. Specify the following: 

Á Destination database server. You can select the same Panel-managed database server, 
or a database server located elsewhere. For an external database server, specify the 
host name or IP address, and access credentials: the username and password of a 
database management system user authorized to create new databases and 
database tables. 

Á Destination database. You can choose to create a new database or copy the data to an 
existing database. 

Á Create a full copy. Leave this option selected to copy the database structure and all 
data. 
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4. Click OK. 

The copy of the database will be deployed on the destination server. 

5. Modify the site's scripts in the staging environment so that they connect to 
the copied database. 

When the site copy in the staging environment is updated and ready to go live, publish it as 
described in the following steps. 

ü To publish the updated site to the production environment: 

1. Go to the Websites & Domains tab. 

2. In the list of domain names, locate the address of your production site and 
click it. 

3. In the Document root box, specify the document root directory of the staging 
site. 

4. Click OK. 

This will make the updated site copy in the staging site location accessible to visitors of your 
production site address. 

Setting Up Mobile Sites 

Your service plan may include the option to create website copies optimized for viewing on 
mobile devices. The copies are hosted with external UNITY Mobile online service. 

Important : In Panel 10.4, if a customer ordered the Unity Express offering from the 
Applications tab, the system could confuse the offering with Unity One. If you faced this 
problem, we recommend that you remove the site created with Unity One and create the 
new one in order to get Unity Express. 

ü To create a copy of your website optimized for viewing on mobile devices, or 
set up a new mobile website: 

1. Go to Websites & Domains tab and click the site's domain name. 

2. Click Mobile Websites. 

3. Click the corresponding Create Mobile Site link. 

4. Specify an address for the mobile site. 

If your site is accessible, for example, by domain name example.c om, you can type a 

prefix like mobile , and then the optimized copy of your website will be accessible by the 

address mobile.example.com .  

5. Click OK. 

6. Click Edit Site Content. A UNITY Mobile site opens in a new browser window or 
tab, and you are logged on under your account. 












































































































































































































































